GUI Designer
The GUI Designer is a WYSIWIG editor that allows you to build the interface for your Wakanda web application. With the GUI Designer, you can
edit your project’s Pages and HTML files. To open an HTML file in the GUI Designer, your code must be valid XHTML5 with all HTML tags properly
closed and have the following tag in the header:

<meta name="generator" content="Wakanda GUIDesigner"/>
Note: To open an HTML file in the Code Editor, the above tag must be deleted.
Open the GUI Designer by clicking on the

button in Wakanda Studio’s toolbar. Your project’s main Page, named “index,” will open in

the Designer Workspace. The GUI Designer also opens automatically when you double‐click on Pages or HTML files (containing the Wakanda tag),
and appears as follows:

The GUI Designer is made up of the following areas:
Toolbar
Designer Workspace
Widgets area (Widgets and Outline tabs)
Model area (Model and Datasources tabs)
Properties area (Properties, Events, and Styles tabs)
Toolbar
With the GUI Designer toolbar, you can easily access many key functions. A few options are available allowing you to customize the toolbar.

The toolbar has the following options:
Save: This option allows you to save all the changes made to the Page open in the current tab.
Run File: Launches the Page opened in the current tab in your default browser. If Wakanda Server is not already running, it will be
launched. If the Page has been modified, it will be saved before it is published to your browser. If you select this option for an Page’s
main script page (the one whose name is the same, i.e., “index.js” is the JavaScript file for “index.html”), the Page will be published to
your browser and not the JavaScript file.
New Datasource: Creates a new datasource of type Datastore Class, Relation Attribute, Variable, Array, or Object. Once you select one of

the options, it will be displayed as the button text.
Vertical/Horizontal Alignments: These menus align the selected widgets vertically or horizontally on your Page.
Distribute Actions: The Distribute Actions menu allows you to distribute them vertically or horizontally.
Movements: This menu allows you to change the stacking order (z‐Index) of the selected widget(s) on your Page. You can also directly
modify the z‐Index property in the Size & Position section of the Styles tab for each widget.
Show/Hide Shapes: Toggles the outlines of all the widgets and their text labels, if they have one, on the Designer Workspace. This is
especially useful for Text and Matrix widgets that have no visible outline. To hide them again, click the

button.

You can modify the display of the GUI Designer toolbar, by modifying the following options in the toolbar's contextual menu:

The options available are the following:
Toolbar Preferences: Sets the display of the toolbar icons with or without text, the size of the icons, and to display or hide the icons.
Toolbar Content: Allows you to select which options you’d like to display in the toolbar as well as reset to the default options.
If all the items in the toolbar cannot be displayed due to lack of space, the
toolbar items appear in a hierarchical menu.

icon appears in the toolbar. When you click on it, the missing

Toggling between Source and Design

By default, a Page opens in the Design view. To view the HTML of your Page, click the

button next to the toolbar. You can also

toggle between the two views by clicking Ctrl‐D (Windows) or Command‐D (Macintosh). You can return to the GUI Designer, by clicking the
button.
Please remember that any HTML code you add to your Pages must be valid XHTML5 with all the HTML tags properly closed. All properties must
have values (for example, <input type="checkbox" name="vehicle" value="Car" checked="checked" /> and not <input type="checkbox"
name="vehicle" value="Car" checked />) and if you include the "&" character, it must be written as "&".
Other Toolbar Buttons

In the toolbar area, there are also other buttons for your convenience. To open the JavaScript file associated to your Page, click on the
button in the toolbar. Once you are in the Code Editor, you can click the
button to return to the GUI Designer.
The left and right panels can be hidden and displayed by clicking the
button in the toolbar to allow you more room for the Designer
Workspace.
Tabs

For each document opened in Wakanda, it will be placed in a tab. For more information about the tabs, please refer to the Solution Manager
chapter.
Designer Workspace
The Designer Workspace is where you customize your Pages. Depending on the file open in the active tab, a different editor appears in this same
area: the GUI Designer for your Pages, the Datastore Model Designer for your project’s model, and the Code Editor for the source of your Pages
as well as all JavaScript, JSON, XML, Text, PHP, and CSS files.
Breadcrumbs

At the bottom of the Designer Workspace are the breadcrumbs, which indicate the position of the selected widget in the Page's DOM node. If it
is located inside of another widget (a child to a parent widget), you will be able to see its hierarchy:

You can also click on the crumb to select that widget in the Designer Workspace.
Widgets Area
This area displays all the widgets that you can add to your Page organized by the following categories: Automatic Controls, Form Controls,
Containers/Placeholders, Misc. Controls, and External. Wakanda is delivered with a few experimental widgets in the External category to
demonstrate a variety of powerful features you can add to your Pages. The widgets allowed for Desktop and mobile (Smartphone and Tablet)
pages differ.
Custom widgets are either in the Custom Widgets category or in a category defined by the custom widget itself.
To create a widget, you can do one of the following:
Select a widget from the list and drag it to an empty space on the Designer Workspace,
Double‐click on it, or
Click on a widget and draw it to the size you’d like on the Designer Workspace.
Selecting a widget

In the Widgets list, you can use your keyboard to select a widget from the list. For example, if you click on "d", Display Error, which is the first
widget in the list beginning with "d", is highlighted:

If you click on "d" again, the next widget beginning with a "d" is selected, which is Dialog:

Note: Only one letter is taken into account when selecting a widget from the list, which is the first letter of the widget's name.
Once the widget is selected in the list, you can hit the Enter or Return key to add it to your Page.
Outline Tab
You access the outline by clicking on the Outline tab in the Widgets area. A list of the widgets currently used on your Page appears. The Page is
listed as “document” and the widget names correspond to their IDs defined in the Properties tab for each widget.

Widgets that are included in a container or matrix are listed below in a hierarchical menu. Clicking on a widget’s name selects it on the Page.
Selecting Multiple Widgets in the Outline

You can select and deselect multiple widgets, which in turn selects them on the Page, by holding down the Command key (Macintosh) or
Control key (Windows). The Outline appears as shown below:

Showing/hiding a widget on the Page

You can show and hide a widget by selecting or deselecting the

icon next to its name. If you uncheck this icon for a container or matrix,

the container along with all the widgets it contains will also be unchecked and hidden. To show all the widgets again, toggle the “document”
checkbox at the top of the list. Hiding widgets in the GUI Designer is applied only to the Designer Workspace; once you publish your web page,
all the widgets are visible.
Deleting a widget

To delete a widget (besides deleting it directly from the Designer Workspace), click on it in the Outline and select Delete widget from the
contextual menu:

Model Area
The Model area of the GUI Designer displays the datastore classes defined in your project’s model. You can expand the datastore class to view
its attributes by clicking on the arrow or double‐click on its name. To collapse it, click on the arrow again or double‐click on its name.

The datastore classes are displayed in alphabetical order. In the Filter area, you can enter the first letter(s) of a datastore class to display those
that correspond to the text entered.

From this area, you can create a Form, Grid, or Auto Form by dragging a datastore class or selected attribute(s) from the same datastore class to
an empty space on the Designer Workspace. Ctrl‐click (Windows) or Command‐click (Macintosh) attributes you want to select. When you drop
the attributes onto the empty space of the Designer Workspace, the Auto Generated Widgets dialog appears:

If you select multiple attributes from the same datastore class, the Auto Generated Widgets dialog appears containing the attributes you
selected:

Once you click on the Create button, the Form, Grid, or Auto Form you selected will be created on your Page. Either a datasource is created
with the same name as your datastore class or an existing datasource with the same name as the datastore class will be used for the widget(s).
Note: The Form, Grid, and Auto Form are discussed in further detail in their respective areas.
Datasources Tab
This area displays all the datasources representing the datastore classes and relation attribute classes in your model along with all their
attributes as well as user‐defined JavaScript variables, arrays, and objects:

Datastore class and relation attribute datasources are automatically created when you generate a Grid, Auto Form, Form, or any other widget
that uses a datastore class or a relation attribute as its datasource. Its name is the same as the datastore class or relation attribute; however,

the first letter is in lowercase if it is in uppercase. For example, if you have a datastore class named “Employee,” the datasource's name will be
“employee.”
Variables are created automatically if you type a source name in the Properties tab for a widget that is not a datastore class, relation attribute,
or existing datasource. It is suggested to start all datasources with a lowercase letter.
Array and object datasources are created when you select the type either from the

button. Array datasources are created

automatically when you enter a source name for a Grid or Auto Form that is not an existing datastore class.
Like the Model, you can create a Form, Grid, or Auto Form by dragging the datasource (a datastore class or one or more attributes from a
datastore class) to an empty space in the Designer Workspace. The Auto Generated Widgets dialog displays the selected attributes or all the
attributes of a datastore class to include in the widget.
To create another copy of a datasource, select Copy the datasource from the datasource’s contextual menu. If you want to delete it, select
Delete the datasource from the datasource’s contextual menu.
If you delete a datasource that is being used in a widget, you will get the following warning:

However, if you delete a widget that uses a datasource, the datasource will not be deleted.
Note: For more information regarding datasources, please refer to the section.
Properties, Events, Skins, and Styles Tabs
In this area, you can define the properties, events, skins, and styles for the Page, widgets, and datasources. The options available on these tabs
differ for each one and are discussed in detail in the Page Properties, Widget Properties, Datastore Class Datasource Properties, Relation
Attribute Datasource Properties, Variable Datasource Properties, Array Datasource Properties, and Object Datasource Properties sections.

GUI Designer ‐ Pages
Page
A Page in Wakanda is made up of the following elements:
one or more HTML files (depending on the platform: Desktop, Smartphone, and Tablet),
a scripts folder (containing the JavaScript files for each HTML file), and
a styles folder (containing the CSS files for each HTML file).
For every Page that you create, regardless of its name, Wakanda creates the following HTML files for the View that you want:
"index.html": Desktop HTML file,
"index‐smartphone.html": the Smartphone HTML file, and
"index‐tablet.html": the Tablet HTML file.
A View allows you to see the HTML file for a specific platform of your Page. Each HTML file (depending on its platform) has its own set of
properties, events, and styles that you can define in the Properties tab.
Wakanda will send the appropriate HTML file for the device that requests the Page. If, for example, a tablet tries to access your web application,
the "index‐tablet.html" file will be sent to the device.
By default, the "index" Page is the project's main page and can be opened by the GUI Designer by clicking on the

button in the

Wakanda Studio toolbar. It is also the home page sent to the browser by default for your project.
You can create other Page Views in Wakanda. For more information, refer to Routing Pages.
For more information about the file structure and architecture for a Page, refer to the Page chapter in the Architecture of Wakanda Applications
manual.
Creating a Page
To create a new Page, select Page from the New menu or click on the

button in the Wakanda Studio toolbar.

Select the platform for which you'd like to create a View in the Create view for combo box. The choices are Desktop, Smartphone, and Tablet.

The corresponding HTML file will be created in the folder whose extension is ".waPage" in the folder you defined in the dialog:

The {index‐view}.package.json file is created. This file defines which other files are necessary for the Page. For more information, refer to
Package file.
Creating a View
If you want to create another View for your Page, you can select one (Desktop, Smartphone, or Tablet) from the following dropdown menu
above the Properties for the Page in the GUI Designer:

If you have not already created the View, it will be created for you automatically along with its corresponding CSS file in the "styles" folder. If
you already created the View, it will be opened in the GUI Designer. In both cases, the view will be opened in a new tab.
Note: The corresponding JavaScript file will be created once you add an event to the HTML file.
Important: The name of of the HTML files (index.html, index‐smartphone.html, and index‐tablet.html) must not be renamed.
Page Properties
When you select the page by either clicking on any empty space in the Designer Workspace or clicking on “document” in the Outline area, the
Properties tab appears as follows for the Desktop View:

For Smartphone and Tablet Views, the Properties panel appears as shown below:

Title

The value you enter in the Title property for the Desktop View of your Page that appears in the browser’s tab and title bar. For the Smartphone
and Tablet Views of your Page, this property is not visible.
Load entire model

The Load entire model property allows you to specify if all the public datstore classes in your model can be retrieved or if only those defined in
the Page's datasources can be retrieved.
If you deselect the Load entire model checkbox (which is the default) only the datastore classes defined in the Page's datastore class and
relation attribute datasources are retrieved. If, for example, you only have one datasource created for your Page, only the description of that
datastore class will be retrieved.
However, if you select the Load entire model checkbox, the description of all the public datastore classes will be retrieved.
If you access a datastore class in the JavaScript code that is called from a Page, you must include that datastore class to the source code of your
Page. For more information, refer to Accessing the Model from the Page.
This option also works in conjunction with the describe permissions. For more information regarding the describe permissions, refer to the
Datastore Class paragraph.
Module

You can configure Remote Procedure Call (RPC) methods to be called from your View by adding a JavaScript file "set as RPC" in the Explorer.
Click on the
icon to include one or more RPC Functions Files in the Module section. Once you have done so, you can specify an RPC
Functions Files and define its namespace.
The "Module" dropdown menu lists all defined RPC Functions Files in the project, so that you can select any module file to be available from
your View.
You can also create a new module by selecting New Module from the dropdown menu:

Once you do so, the following dialog appears:

A "Modules" folder is created at the root of your project (if it hasn't already been created) and your new RPC file is placed inside of it:

The new RPC file is opened in the Code Editor with a sample template.
To delete an RPC Functions File, click on the

icon that appears to the right.

Note: For more information, please refer to the Using JSON‐RPC Services guide.
Viewport

This section, which is available only for the Smartphone and Tablet Views of your Page, allows you to configure the following properties:
Width: The width of the viewport in pixels.
Height: The height of the viewport in pixels.
Initial Scale: The initial scale of the viewport as a multiplier.
Maximum Scale: The maximum scale value of the viewport.
Minimum Scale: The minimum scale value of the viewport.
User Scalable: Determines if the user can zoom in and out.
iOS Meta Tags

This section, which is available only for the Smartphone and Tablet Views of your Page, allows you to configure the following properties:
Web App Capable: Web application runs in full mode if selected.
Format Detection: Automatically detects possible phone numbers if selected.
Status Bar Style: Style of the status bar for a web application (Default, Black, or Black Translucent).
Workspace

This section, which is available only for the Smartphone and Tablet Views of your Page, allows you to configure the following properties:
Device: Modifies the workspace with a device mockup for you to work within.
Orientation: This property can be either “Portrait” or “Landscape.”
Width: Width of the workspace.
Height: Height of the workspace.
Style sheets

By default, two CSS files are automatically referenced in this area:
index{‐viewName‐}css: This CSS file whose name is "index.css" (for Desktop view), "index‐smartphone.css", or "index‐tablet.css"
depending on the view. Wakanda updates this CSS file dynamically each time you modify the styles or placement of any widget on the
Page.
application.css: Wakanda uses this file for all the Widget Roles that you create for a particular type of widget. You can also include any CSS
styles that you want to use throughout your project.
In the Style Sheets area, you can include your own CSS files that you can manage and freely modify.

To add a CSS file, click on the
WebFolder:

icon. A blank area appears and you can click on the

icon to select a CSS file located in your project’s

If the CSS file you choose is not in your project’s WebFolder, it will be copied into the “styles” folder in your project’s WebFolder. If the
“styles” folder does not exist, it will be created.
To remove a CSS file, click the

icon next that appears next to the file you want to delete. To choose another CSS file, click on the

icon

and select one from your computer.
To change the order of the CSS files, drag the

icon above or below one or more of the other CSS files listed.

Note: Wakanda generates CSS classes for the WAF with the prefix “waf‐“ and those for the GUI Designer with the prefix “studio‐“. Therefore,
we suggest that you not use these prefixes for your own CSS classes.

Scripts

By default, Wakanda automatically generates a JavaScript file whose name is "index.js" (for Desktop view), "index‐smartphone.js", or "index‐
tablet.js" depending on the view. This file is automatically placed in a “scripts” folder and is automatically included in the Scripts area.
You can use the Scripts area in the Properties tab to add one or more JavaScript files to the View of your Page:

To add a JavaScript file, click on the

icon. A blank area appears and you can click on the

icon to select a JavaScript file located in your

project’s WebFolder:

If the JavaScript file you choose is not in your project’s WebFolder, it will be copied into the “scripts” folder in your project’s WebFolder. If the
“scripts” folder does not exist, it will be created.
To remove a JavaScript file from a specific View of your Page, click the
another file, you can do so by clicking on the

icon that appears next to the file you want to delete. To choose

icon to look for a JavaScript file on your computer.

To change the order of the JavaScript files, drag the

icon above or below one or more of the other JavaScript files listed.

Creating multiple JS files for a page

When you have multiple JavaScript files for your Page, you can define more widget events using Wakanda's onAfterInit function.
Here is an example of how to create an event in another JavaScript file for your widget:

WAF.onAfterInit = function() {
WAF.addListener("button1", "click", function(event) {
//put code here for your event
});
};
If you have an event for the same widget, they will be called in the order in which the JavaScript file was defined for the Page.
For more information about the parameters for the WAF.addListener function, refer to the addListener( ) function in the Widgets API.
Web Fonts

In this section, you can add Google fonts to the View of your Page so that any of the widgets it contains can use them.
Note: For more information about using Google's free open‐source fonts, please refer to Google Web Fonts.
To begin, you must enter your Google API Key after clicking on Enter your Google API Key in the Google API Key area that appears:

Once you enter a valid Google API Key, the Google Font dropdown (containing all Google’s web fonts) appears in the Web Fonts area:

Once you select a Google Font, a preview of the font appears above the dropdown. To load it for the View of your Page, click the

icon:

The font will then be listed in the Loaded Fonts area. Once you have one or more web fonts loaded to the View of your Page, they will be
available from the Font dropdown as shown below:

The fonts are added to the source of the HTML file as shown below:

<link id="waf-fonts-web-google" rel="stylesheet" type="text/css"
href="http://fonts.googleapis.com/css?family=Alike+Angular|GFS+Didot|Odor+Mean+Chey"/>
To delete any of the loaded fonts, click on the

icon to the right of the font:

Page Events
You can execute code in the following event for the Desktop view of your Page:
On Load: This event occurs when the web page is first loaded by the browser.
You can execute code in the following events for the Smartphone or Tablet views of your Page
On Load: This event occurs when the web page is first loaded by the browser.
On Orientation Change: This event occurs when the orientation of the page has changed.
When you click the
icon, the JavaScript file for the particular View opens in a new tab. It will be generated and automatically placed in your
Page's “scripts” folder if it doesn’t already exist. The JavaScript file will appear in the Code Editor and the cursor will be placed next to a
comment that indicates where to add your JavaScript code.
To open the JavaScript file for the particular View of your Page, click on the

button in the toolbar or the

directly to the code for that event.
To delete the code for a specific event, click on the

icon next to the event.

Page Design
In the Design tab, you can define one or more CSS classes and select a theme for your Page:

icon next to the event to go

In the Theme section, you can also duplicate the currently selected theme. For more information, refer to Duplicating a theme.
CSS Classes

In this property, you can define one or more CSS classes (delimited by a space) that will be included in the <body> tag of your Page.
Theme

In this section, you can select a theme for your Page. This theme will be applied to all of the widgets on your Page.
Each theme is represented graphically to give you an idea of what it looks like. The selected theme is shown with a check mark on it.
If you want to specify default themes for the different views, refer to Default theme for a Page.
Page Styles
This area allows you to define the overall look of the View of your Page. All changes made here will be included in HTML file's corresponding CSS
file.

Note: Any changes you manually make to this CSS file will not be saved. For this reason, if you want to edit your own CSS file, you must create
another file and add it to your Page's View by using the area in the Properties tab.
For more information about the Styles tab, please refer to the Styles section.
Background

For more information about the Background section, please refer to the “Background” paragraph in the “Widget Properties” section.
Using Images from the Media Library
To access the Media Library, click on the Media Library button in the toolbar or select the “Media Library” folder in the Explorer tab and click on
Thumbnails tab. Below is the display of the Media Library images displayed in the Thumbnails tab. Please note that the Solution Explorer must
be visible to see the image files.

You can do one of the following:
Drag and drop an image to your Page or
Drag and drop an image onto a widget.
Dragging and Dropping an Image to your Page

If you drag and drop an image from the Media Library to an empty space on your Page, it will be copied to your project’s “Images” folder. If your
project doesn’t have an “Images” folder yet, Wakanda will create it for you. An Image widget is also created with the copied image from the
Media Library as the Src and the size fit to the image.
Dragging and Dropping an Image onto a Widget

If you drag and drop an image from the Media Library to a widget on your Page, it will be copied to your project’s “Images” folder. If your project
doesn’t have an “Images” folder yet, Wakanda will create it for you. For most widgets, this image will be used as its background and it is also
repeated by default. You can change these settings in the Styles tab for the widget.
However, for a Button widget, the image will be defined as the default images for the four states, which you can view in the Styles tab for the
widget:

Checkbox widgets do not allow background images, so the image will be copied to your project’s “Images” folder, but not assigned to the
background of the widget.
For a Container widget, an Image widget will be created with the Media Library’s image.

Previewing an Image

To preview an image from the Media Library, you can either double‐click on it or select it and then choose Open in New Tab from the contextual
menu.
Previewing a Page
To preview your Page, click the Run File button in the toolbar. The current view (Desktop, Smartphone, or Tablet) is run in your default browser.
Debugging a Page
You can choose to debug your Page, by clicking on the Debug button.
This button opens your Page in your default browser and adds "?debug=1" at the end so that you can debug your Page.
If you have activated the Wakanda Debugger or the Wakanda Remote Debugger, your page is already in "debug" mode even if you click on the
Run button.
When you are using WD2, the files are minified and you cannot easily debug them. For this reason, you can debug your Page by either activating
the debugger or by clicking the Debug button for a Page.

Theme
A theme defines the general look for a Page and all the widgets it contains. You define the theme for your Page in the Design tab:

Duplicating a theme
To duplicate an existing theme, select a theme to duplicate and click the
associated to the theme you are duplicating, they will be duplicated as well.
A dialog appears prompting you to name the new theme:

button in the Design tab. If you have any widget roles

If there is a problem with the theme name, the text appears in red.
Note: In a future version, you will be prompted to enter the theme's display name and its internal one (used in the CSS classes). For the
moment, you can modify the theme's display name in the theme's package.json file.
In the Themes folder, a new folder is created for the theme you just duplicated:

For more information on how a theme is constructed, refer to the Custom Theme chapter in the Architecture of Wakanda Applications manual.
Community Themes
To see what Community themes are available, you can click on the Community Themes menu item in the Themes folder's contextual menu.
Installing a Custom Theme
A custom theme can be installed on the same computer in the following folder:
On Macintosh: /Users/userName/Documents/Wakanda/Themes/
On Windows: diskName:\Users\userName\Documents\Wakanda\Themes\
You can also use the Add‐ons Extension to search for a custom theme and install it directly into Wakanda.
Deploying a Custom Theme
By default, when a custom theme is installed in Wakanda's "THEMES" folder on your local machine, it is automatically ready to be deployed if you
run Wakanda Server off of this same machine. If not, you'll have to copy the "THEMES" folder to the machine where the Wakanda Server will be
running. For information about the exact path, see the paragraph above.
There are also two other alternatives for deployment:
Project‐level or
Solution‐level
Both of these options allow you to deliver the custom theme in the project or solution without having to install it on the machine where the
Wakanda Server is running. Note that these options are only for deployment.
Project‐level deployment

For deployment purposes, you can you can also place the custom theme directly in your project. This feature can be useful especially when
deploying your project in the Cloud.
Here is how you can include a custom theme with your project for deployment:
1. Create a "Themes" folder at the root of your project.
2. Create a "fileSystems.json file" file with the following JSON:

[{
"name": "THEMES_CUSTOM",
"parent": "PROJECT",
"path": "Themes"
}]
3. Copy the custom theme to deploy into your project's "Themes" folder.
In our example below, we included one custom theme with our project for deployment:

Solution‐level deployment

You could also follow the steps above and include a custom theme at the solution level so that all the projects in the solution can benefit. For
more information, refer to fileSystems.json file.

Web Component
A Web Component is a powerful tool that allows you to create a specific section of a Page, an entire Page, or a (modal or non‐modal) dialog. A
Web Component is, in essence, a Page on which you can place one or more widgets.
To create a single‐page Web application, you can have one Component widget on a Page and load different Web Components.
You can also use Web Components as specific portions of a Page (e.g., a Menu Bar and Login widget) and add the Web Component by placing a
Component widget on your Pages. In this way, you only modify the Web Component once to show the changes throughout your web application.
In a multi‐developer project, each developer can work on a different Web Component and integrate it into one or more projects by simply
copying the Web Component folder.
For more information about the file structure and architecture for a Page, refer to the Web Component chapter in the Architecture of Wakanda
Applications manual.
Creating a Web Component
To create a Web Component, make sure a project is active in the Solution Explorer and select Web Component from the New menu. You will be
prompted to enter a filename, which will be the name of your Web Component. In our example, we have named the Web Component,
“myComponent.”
The “myComponent.waComponent” folder appears in your project's WebFolder as shown below:

In the Web Component's folder, four files are created:
{Web Component Name}.html: The HTML file that can be opened in Wakanda Studio on which to place your widgets.
manifest.json: A JSON file that contains a description of the Web Component.

{Web Component Name}.js: A JavaScript file that contains your JavaScript code.
{Web Component Name}.css: A CSS file that contains the CSS code for your HTML file.
You can edit the Web Component’s HTML file (which is a Page) and can include any of Wakanda’s built‐in widgets or your own custom widgets.
The HTML file is the same as a Page with the same Properties, Events, Skins, and Styles tabs.
Properties

The Properties tab for the Web Component contains only the following sections:
Style sheets (CSS files)
Scripts (JavaScript files), and
Web Fonts

All CSS style sheets and JavaScript files must be located in (or in a subfolder of) the Web Component folder.
By default, the Web Component’s CSS and JavaScript files are already attached to the Web Component’s Page properties.
Note: Please refer to the “” and “” paragraphs in the Page section for more information on how to add, delete, and order these files for the
Page.
Events

The Events tab does not contain any events. You can write code in the this.load function of your Web Component's JavaScript file. For more
information, refer to this.load in the Web Component's Constructor.
Design

Similar to the Page's Design tab, you can add one or more CSS classes in the CSS Classes property.
If you select a theme in the Theme section, it will only be visible in Design mode. Once the page is published, the Page's theme (in which you
have placed the Web Component in a Component widget) will be used. For more information, please refer to the Page section of the manual.
Styles

This tab is identical to the Page's Styles tab. For more information, please refer to the Page section of the manual.
Datasource Properties

When you use a datasource (either a datastore class or a relation attribute) in a Web Component that has the same name as a datasource
referenced on the Page with the Web Component, it can either be the same datasource or a unique one.
In the datasource's Properties tab, you can select the Scope for your datasource so that it is either Local (default value) or Global.
If you select Local, Wakanda will create another instance of this datasource for you when the page is published thus allowing another instance of
the Page's datasource. If you select Global and the Page has a datasource with the same ID, the one in your Web Component will be the same
one (with, of course, the same ID).

Testing a Web Component
To test your Web Component, press the Run File button in the GUI Designer toolbar or select the same option from the Run menu. The Page is
published to your browser. The URL generated is:
{URL}/walib/WAF/Component/test/test.html?component=/{Web Component Name}.waComponent
Loading a Web Component
There are two ways to load a Web Component in the Component widget on your Page:
Use the loadComponent( ) function in the Widgets v1 Instance API or
Use the loadComponent function in WAF.
WAF's loadComponent function has the following parameters:
Property
id
path
onSuccess
userData

Type
String
String
Function
Object

Description
Component widget ID
Path to the Web Component in the WebFolder
Function to call when the loading of the component is successful
Data you'd like to pass and retrieve when the Component widget is published

Below is an example of using the loadComponent( ) function to load a different Web Component in the Component widget:

$$('component1').loadComponent("/myComponent.waComponent");
You can also use WAF's loadComponent function to load a different Web Component in the Component widget:

button1.click = function button1_click (event)
{
WAF.loadComponent ( {
id:
'component1',
path:
'/myComponent.waComponent',
onSuccess: function () {
//do something here;
}
} );
};
Removing a Web Component
There are two ways to remove a Web Component from the Component widget on your Page:
Use the removeComponent( ) function in the Widgets v1 Instance API or
Use the removeComponent function in WAF.
If, for example, you have loaded a Web Component to display a modal dialog on your Page in a Component widget, you can remove it afterwards
by calling the removeComponent() function from your Web Component's JavaScript file:

button1.click = function button1_click (event)
{
$comp.removeComponent();
// or $$(id).removeComponent();
};

GUI Designer ‐ Widgets
Widget Properties
The Properties area is broken up into four tabs: Properties, Events, Skins, and Styles:

Properties
This section varies depending on the widget.
ID Property

Every widget has an ID, which is generated automatically by Wakanda. You can, of course, modify it if you’d like. It must begin with a letter and
can contain letters, digits, hyphens, and underscores.
The ID is equivalent to the ID in HTML and can be passed to JavaScript routines, such as getElementById. For more information, please refer to
the “Naming Conventions” section.
Hide widget on load Property

The Hide widget on load property allows you to hide a widget when your page is loaded for the first time. To make the widget visible on the
Page, use the show( ) function in the Widgets v1 Instance API API manual.
Label Property

For widgets that have a value entered in the Label property, an additional widget of type Label is created.
To delete the label, you can either:
Erase the contents of the Label property or
Ctrl‐click on the widget’s label and select Delete from the contextual menu.

Source Properties

For all widgets that have a Source property (Source, Choice Source, and Value Source), only those datastore classes and attributes that have
“Public” chosen as their scope will appear.
Assigning a Datasource to a Widget with Multiple Sources

If a widget, like the Combo Box, Radio Button Group, and Select widgets, has more than one datasource, you will be prompted to select for
which datasource you want to affect the datastore class (or datasource class attribute) or datasource when you drag and drop it onto the widget.
The following dialog appears for you to select the appropriate datasource property to define as the Choice Source or the Value Source:

The Choice Source is the datasource whose values will be displayed by the widget and the Value Source is the datasource in which the selected
value will be assigned.
Format Property

Display formats are “templates” used to represent data visually on your Page. They do not affect the way the data is stored internally. The
display formats defined in the model are automatically used by widgets like Auto Forms, Grids, and Text Inputs. Many widgets have a Format
property in the Properties tab where you can enter a display format.
Formats can be applied to attributes of type String, Number (Long, Long64, and Number), and Date.
You can transform text values by entering one of the following formats:
Format
U
l
C
c

Description
Uppercase (e.g., “WILLIAM JONES”)
Lowercase (e.g., “william jones”)
Capitalize first word (e.g., “William jones”)
Capitalize each word (e.g., “William Jones”)

For strings, like a telephone number, you can include characters that will be used for the data entered. For example, if you have “(###) ###‐
####” for a US telephone number, when the user enters in 4085551212, it will be formatted as “(408) 555‐1212”.
For numbers, each placeholder character has a different effect on the display of leading or trailing zeros. A leading zero is a zero that starts a
number before the decimal point; a trailing zero is a zero that ends a number after the decimal point. Suppose you use the format ##0 to display
three digits. If the user enters nothing in the field, the field displays 0. If the user enters 26, the field displays 26.
The table below explains the effect of each placeholder on leading and trailing zeros:
Placeholder
#
0

Effect for leading or trailing zero
Displays nothing
Displays 0

Note: Wakanda uses the “,” to delimit thousands and “.” as the decimal point for formatting numbers; however, when the value is displayed via
the web browser, it will appear with the thousands separator and decimal point defined by the browser.
For percentages, enter “0%”.
For dates, the following formats are available:
d ‐ day of month (no leading zero)
dd ‐ day of month (two digit)
o ‐ day of the year (no leading zeros)
oo ‐ day of the year (three digit)
D ‐ day name short
DD ‐ day name long
m ‐ month of year (no leading zero)
mm ‐ month of year (two digit)
M ‐ month name short
MM ‐ month name long
y ‐ year (two digit)
yy ‐ year (four digit)
For example, to create a date that appears as “March 1, 2011,” you would enter “MM d, yy” in the date attribute’s format field.
Error ID Property

Certain widgets allow you to handle errors if one occurs. In the Properties tab, you can define how you want to handle errors:
Let Wakanda display the errors in a new window.
Display the errors in your own Text, Container, or Display Error widget.
Manage the errors yourself programmatically.
Automatically Display Standard Error Message

To display Wakanda’s error message, select the Display Errors option in the Error Handling section on the Properties tab (as we show below for
a Grid):

When an error occurs, it appears as shown below:

You can move the window by dragging the grey bar at the top or resize it by dragging the bottom right corner. To close the window, click on the
button.
Automatically Custom Standard Error Message

To display Wakanda’s error message, select the Display Errors option and enter in the widget’s ID (which can be of type Container, Text, or
Display Error) in the Error ID property in the Error Handling section:

The same error as above displayed in a Container appears as shown below:

Manage errors programmatically

If you’d like to manage the errors that occur yourself without displaying the standard or custom error messages, deselect the Display Errors
option and make sure the value in Error ID property is blank.
You can intercept the error in the On Error Handler event shown on the widget's Events tab.

For more information about managing errors from the client side, please refer to the Error Management section.
Events
Each widget has its own events that you can intercept by writing JavaScript code.To learn more about the event object that is returned by the
event, refer to the Event object chapter in the Widgets v1 Instance API manual. For any events that you'd like to add to a widget that you are
unable to add through the GUI Designer, you can use the addListener( ) function.
Note: If you have a widget that is located inside of another widget (e.g., a Button in a Container), the same event for both widgets will be
called. If you have defined a "On Click" event for both the Button and the Container, the Button's "On Click" event will be called and then its
parent, the Container's, "On Click" event will be called. To avoid this standard behavior, you must use functions in the event object like
stopPropagation() or stopImmediatePropagation(). For more information, refer to the event's event object.
Modifying an Existing Event

To open the JavaScript file linked to your Page, click on the

button above the panel or click on the

icon next to the event to go

directly to the event.
Adding an Event

If no code exists for an event, you can click on the
icon to add it. The JavaScript file with the same name as your Page will open up with a
highlighted comment indicating where to add your code.

In the callback, you can use this to refer to the current object. If you want to access the domNode directly, you can write this.domNode.
Deleting an Existing Event

To delete the code for the specific event in the JavaScript file, click on the

icon next to the event.

Design
In the Design tab, you can modify the look of your widget by:
Defining one or more CSS classes and/or
Assigning a predefined role based on the widget type. For more information, refer to Widget Roles.

If a role is defined for the widget type in the same theme, it will appear in the list as shown below:

You can also modify the style settings in the Styles tab and then update the role:

In certain themes, pre‐defined roles for that theme may appear above the "user‐defined" roles:

Currently, if you want to delete a user‐defined role, you can do so by removing the CSS code related to that role in your project's
"application.css" file. If that role was selected for other widgets, you will be notified in this tab; however, it will not be removed from the
widget's properties until you select another one or None.

Widget Roles

A role is composed of the styles that you define for a widget in the Styles tab based on your Page's selected Theme. The widget role contains all
the CSS settings you define for your widget's elements and states. You can create a role for any widget and then apply it to a widget of the same
type throughout your project.
Once you have set the styles in the Styles tab, you can select Create a new role from the widget’s contextual menu to create a role:

The following dialog appears in which you enter a name for the role:

Once you hit the OK button, one or more CSS classes will be created for the widget in your project’s “application.css” CSS file. The name you
entered will be a suffix for the class as in our example for a Text Input widget:

.waf-theme.metal .waf-textField.waf-role-infoTextField
Note: The Page's theme (in our case "metal") is also indicated in the selector, which means that the role you created is only available for that
theme. If you change the Page's theme, the role will not be available. However, if you duplicate a theme, all the roles defined for that theme
will also be duplicated.
To apply the role to another widget, you select it from the Role dropdown in the Design tab.

You can also update a widget role after modifying its style settings in the Styles tab, by clicking the Update current role button in the Role
section of the Design tab.

Styles
The styles available for each widget vary. Some widgets are made up of elements (as well as states for those elements) whose styles you can
customize.
To select an element of the widget, hold down the Alt (Windows) or Option (Macintosh) key and hover that section (like the header, body, cells,
or footer). When it is highlighted, let go of the mouse and that element will be selected in the dropdown list at the top of the Properties panel.
You can also select a widget element by choosing it from the dropdown menu. There might also be “states” for the element that appear in
another dropdown menu. Below is how the states and subelements are displayed for the Combo Box widget:

To revert any changes that you make in the Styles tab, click the
icon to the right of the title of that section or the entire widget. The values
defined by the selected theme or the inherited one will be restored. Only certain sections, like Text, Background, Border, Drop Shadow, Inner
Shadow, Label Text and Label Text Shadow, can be restored. If you select a widget element and/or state, only those values for that specific
element and/or state will be restored.
The Label Text, Label Text Shadow, and Label Size & Position are displayed when you select "Label" from the dropdown menu at the top of the
Styles tab, if the widget has a "Label" specified.

Text

This section allows you to customize the text for the widget.

If you have entered a Google API Key to use Google Fonts for your solution, this section appears as shown below:

If you click on the More fonts button, you will be directed to the Page's properties where you can load one or more Google Web Fonts.
You can define the font family, font size, font color, font style (bold, italic, or underline), left align, centered, right align, or justified.
Moreover, this section allows you to define the letter spacing and the line height.
You can choose from any of the font families listed in the drop‐down menu:

Text Shadow

In this section, you can define the widget's text shadow in the Color, Angle, Distance, Blur, and Size fields:

Here is an example of how the Text Shadow appears when it’s published:

Icon

Specify an icon to be displayed for any of the different states of a widget (e.g., Checkbox and Radio Button Group). You can select an icon for
each of the widget's states: Default, Hover, Active, and Focus.

There are multiple ways to add an image:
Click on the
icon. You select an image from your computer in the dialog that appears. The selected image will be copied into your
Web Folder’s images folder.
Drag an image file from the Explorer area or from anywhere on your computer and drop it on top of the Source property.
Drag and drop an image from the Media Library on the Source property.
In all three cases, the image file will be copied into the “images” folder in your project’s WebFolder. If the “images” folder does not exist, it will
be created automatically.
To delete the reference to the image, click on the

icon next to the image name in this field.

Image

This section allows you to customize the image to be used for the Icon widget.

There are two properties in this section:
Src: The image file (which is in your project's Web Folder).
Type: This property allows you to define if the image in the Src property is treated as Separate images or Sprite.
There are multiple ways to add an image:
Click on the
icon. You select an image from your computer in the dialog that appears.
Drag an image file from anywhere on your computer and drop it on top of the Src property.
Drag and drop an image from the Media Library onto the Src property.
Note: In all three cases, the image file will be copied into the “images” folder in your project’s Web Folder. If the “images” folder does not
exist, it will be created automatically.
To delete the reference to the image, click on the

icon next to the image name in this field.

Sprite

When you select Sprite from the Type property, the image appears in the Preview area so that you can define each segment of the image.

You can modify the width and height of the image to display by either entering the values or dragging the gray box to the size you’d like. The
size of the Icon widget will be altered by the height and width of the sprite that you create from the image you upload in this section. You can
also set the left and top margin.

For each state of the widget, you can move the gray box to the next image in the sprite:

Background

This section allows you to set the background for your widget and Page:

You can select a background color from the Color picker or select an image to place in the background of the Page. If you want the background
of your Page to be transparent, select
from the grid of color swatches.
You can also define the alpha channel, which defines the transparency of the color you select:

In the Color picker above, we entered “66” in the alpha channel field. This alpha channel is a hexadecimal value between “00” and “FF”.
You can attach an image to the background of your widget by clicking the
icon next to the Image field, which presents a dialog from which
to choose an image in your WebFolder’s images folder. You can also drag an image file from the Explorer area or from anywhere on your
computer and drop it on top of the Image field. In this last case, the image will be copied into the “images” folder in your project’s WebFolder.
If the “images” folder does not exist, it will be created automatically.You can also include one of the images from the Media Library by dragging
it and dropping it on top of the widget.
Note: Any image published to the Web must be in your project’s WebFolder.
If you select an image, you can choose to repeat it horizontally (repeat‐x), vertically (repeat‐y), both vertically and horizontally (repeat), or not
repeated (no‐repeat) in the background of the widget in the Repeat field. By default, the image will be repeated both vertically and
horizontally.
To delete the reference to the image, click on the

icon next to the image name in this field.

Create a gradient for the background of your widget in the Gradient area.

To do so, click on the color stop

to select it (

) and choose a color either by double‐clicking on the color stop or by clicking on the

icon. Once you have selected a color from the color picker dialog, the gradient color will be modified and all subsequent color stops will have
that same color by default.
You can either drag the color stop to change its location or define it by selecting a percentage value from the dropdown in the Location area.
You can add another color stop to the gradient, by clicking on the gradient area when the
icon appears. There must always be two color
stops in the gradient area; however, you can add as many as you’d like and delete those you don’t want by selecting the color stop and clicking
the
icon.
Select Horizontal to display the gradient horizontally or Vertical to display it vertically.
Click on the Reverse button to reverse the gradient completely.
Border

In this section, you can define the color, width, and type of each line for the border of a widget in the Color, Style, and Size fields. For some
widgets, the Radius property is available to you so that you can also define the radius for each of the four corners:

You can select each corner individually by clicking on one of the corners in the square. The corner is selected when it is blue, as shown above.

By default, they are all selected. To deselect a corner, just click on it.
You can also select all the corners or all the borders by clicking on the Select corners or the Select borders buttons. To select all, click on the
Select all button and to deselect all, click on the Deselect all button.
Below is an example of a Button widget with rounded corners:

Below is an example of a Container widget with different radiuses for the four corners to create an oval:

Drop Shadow

In this section, you can define the widget's drop shadow in the Color, Angle, Distance, Blur, and Size fields:

Below is an example of a drop shadow for an Image widget:

Inner Shadow

In this section, you can define the widget's inner shadow in the Color, Angle, Distance, Blur, and Size fields:

Below is an example of a Container with an inner shadow:

Size & Position

The fields in this section allow you to define the size, position, and stack order (z‐Index) of the widget. In the Constraints area, you can define
the constraints of a widget by highlighting the grey bar (so it becomes red) of two, three, or four of the following options: top, bottom, left, or
right.
Width: Width of the widget.
Height: Height of the widget.
Constraints: Define which side of the Page/Container to "attach" the widget to. For more information, see the Constraints section below
Top: Top margin between the left side of the Page/Container and the widget.
Bottom: Bottom margin between the left side of the Page/Container and the widget.
Left: Left margin between the left side of the Page/Container and the widget.
Right: Right margin between the left side of the Page/Container and the widget.
z‐Index: The z‐index (defining the stack order) for the widget on the Page or within a Container. This value is defined by default when a
widget is added. This field can be modified either manually through the Arrange menu. Refer to the z‐Index paragraph below.
z‐Index

Besides entering a value in the z‐Index property, you can also change the value by selecting one of the following actions from the Arrange
contextual menu:

The following actions can be performed to a widget. Its z‐Index is modified based on the other widgets on the Page or other widgets in the same
Container:
Bring to front: Bring the widget to the front (update z‐Index to the highest number possible on the Page)
Bring forward: Bring the widget forward (increment the z‐Index by one)
Send backward: Send the widget backward (decrease the z‐Index by one)
Send to back: Send the widget to the back (update z‐Index to the lowest number possible on the Page)
Constraints

In the Constraints section, you can select which side the widget will be "attached" to. The Top, Bottom, Left, and Right fields allow you to
define the distance from that edge of either the page (in the case of a widget on the Page) or the Container (if the widget is inside of it) with
the widget.
If you select two sides, for example top and right, the widget will remain “attached” to the top and right edge with the pixel values
defined in the fields for the top and right corner (of the page or Container widget).
If you select three sides for example top, left, and right, the widget will shrink or grow on the page in width to be "fluid". If you select
top, right, and bottom, the widget will shrink and grow in height. Moreover, the Height property is not be modifiable and only the value is
displayed.
If you select four sides, the widget will be resized to always have the four settings (top, bottom, left, and right) be valid relative to the
Container or Page. In this case, the Width and Height properties are not be modifiable and only the values are displayed.
These settings are for the Grid so it is always 50 pixels from the top,136 pixels from the bottom, 25 pixels from the left, and 483 pixels from the
right.

The settings below are for the Combo Box, which sets it to always be 15 pixels from the top and 84 pixels from the right.

In this way when the page is resized, the Combo Box will move and the Grid will grow.
Note: The four values (top, bottom, left, and right) are automatically adjusted depending on the Wakanda workspace area and the widget you
are modifying the constraints for.
When the page is published, the widgets initially appears as follows in this small browser window:

When the page is resized, the Combo Box moves to the top right corner and the Grid is resized to fit the page:

You can also manually adjust the size and position of the widget directly on the Designer Workspace. Below is an example of the parameters

when you modify the size and position of a widget:

Label Text

This section only appears if there is a label for your widget. You can define the font family, font size, font color, font style (bold, italic, or
underline), letter spacing, left align, centered, right align, or justified, as well as top align, center align, or bottom align for labels displayed on
either side of the widget.

If you have entered a Google API Key to use Google Fonts for your solution, this section appears as shown below:

If you click on the More fonts button, you will be directed to the Page's properties where you can load one or more Google Web Fonts.
You can choose from any of the font families listed in the drop‐down menu:

Label Text Shadow

In this section, you can define the widget's label text shadow in the Color, Angle, Distance, Blur, and Size fields:

Label Size & Position

In this section, you can define the size and position of the widget’s label.

Min Width: Defines the minimum width of the text area allowed for your widget's label.
Max Width: Defines the maximum width of the text area allowed for your widget's label.
The widget's label can be displayed on any of the four sides of the widget by selecting the appropriate radio button.

Adding Widgets
In Wakanda, you can create widgets in the following three ways:
Drag and drop the widget from the Widgets area onto an empty space in the Designer Workspace.
Draw the widget to a specific size on the Designer Workspace.
Double‐click on the widget so that it is automatically created and appears on the Designer Workspace.
To automatically generate Grid and Auto Form widgets, you can also drag and drop either a datastore class or a datasource to an empty space on
the Designer Workspace. When you do so, the Auto Generated Widgets window appears, allowing you to select which attributes to include in
one of the three types of controls:

Note: In this dialog, by default only the first 10 attributes will appear. You can change this in the GUI Designer Preferences.
From here, you can select one of the following:
Form
Grid
Auto Form
Form
The Form option is a selection of widgets available in Wakanda. In the Auto Generated Widgets dialog, you can select the attribute, insert the
widget label, and select a widget for each attribute. The widget type proposed for each attribute is based on its type. The following widgets are
proposed in this dialog:
Calendar: For attributes of type Date.
Checkbox: For attributes of type Boolean.
Combo Box: A Combo Box for all attribute types except Images and relation attributes.
Image: An Image widget for an attribute of type Image.
Radio Button Group: A Radio Button Group widget for all attribute types except Images.
Slider: A Slider widget for a numeric attribute (Long, Long64, and Number).
Text: A static text widget for attributes of type Date, Duration, Long, Long64, Number, String, UUID, and Word.
Text Input: An input area for attributes of type Date, Duration, Long, Long64, Number, String, UUID, and Word.
To add another attribute, click on the
icon at the top of the dialog. A new attribute is automatically added to the end of the list, which you
can modify by selecting an attribute from the Attribute drop‐down menu, entering another label for it, and selecting a widget type.
To change the order of the attributes, drag the
before creating the Form, click on the

icon next to the attribute above or below the other attributes. To delete an attribute

icon that appears to the right of the attribute when you hover over it.

If you select only one attribute, Wakanda will generate the widget selected, but will not create a Container widget around it.
For example, you can create a Form as shown below with a variety of widgets for a specific datasource:

Custom Widgets
You can now create a custom widget in Wakanda Studio. Once created, the custom widget can be accessed directly in the GUI Designer.
Creating a Custom Widget
To create a custom widget in Wakanda Studio:
Select New Custom Widget from the File‐>New menu or
Select New Custom Widget from the Widgets folder's contextual menu.
You will first be prompted to name the custom widget:

Once you click OK, the following folder is created in the Widgets folder:

For more information on the file structure and individual files, refer to Custom Widget.
In the Widgets area, the new widget will appear at the bottom of the list in the "Custom Widget" section:

For more information on how to create a custom widget, refer to Widgets v2 Creating a Widget.
Retrieving a Custom Widget

To see what Community widgets are available, you can click on the Community Widgets menu item in the Widgets folder's contextual menu.

Installing a Custom Widget
A custom widget can be installed on the same computer in the following folder:
On Macintosh: /Users/userName/Documents/Wakanda/Widgets/
On Windows: diskName:\Users\userName\Documents\Wakanda\Widgets\
You can also use the Add‐ons Extension to search for a custom widget and install it directly into Wakanda.
Deploying a Custom Widget
By default, when a custom widget is installed in Wakanda's "WIDGETS" folder on your local machine, it is automatically ready to be deployed if
you run Wakanda Server off of this same machine. If not, you'll have to copy the "WIDGETS" folder to the machine where the Wakanda Server will
be running. For information about the exact path, see the Installing a Custom Widget paragraph above.
There are also two other alternatives for deployment:
Project‐level or
Solution‐level
Both of these options allow you to deliver the custom widget in the project or solution without having to install it on the machine where the
Wakanda Server is running. Note that these options are only for deployment.
Project‐level deployment

For deployment purposes, you can you can also place the custom widget directly in your project. This feature can be useful especially when
deploying your project in the Cloud.
Here is how you can include a custom widget with your project for deployment:
1. Create a "Widgets" folder at the root of your project.
2. Create a "fileSystems.json file" file with the following JSON:

[{
"name": "WIDGETS_CUSTOM",
"parent": "PROJECT",
"path": "Widgets"
}]
3. Copy the custom widget to deploy into your project's "Widgets" folder.
In our example below, we included one custom widget with our project for deployment:

Solution‐level deployment

You could also follow the steps above and include a custom widget at the solution level so that all the projects in the solution can benefit. For
more information, refer to fileSystems.json file.

Manipulating Widgets
In the GUI Designer, you can manipulate widgets while designing your Pages. The GUI Designer allows you to:
select widgets,
resize widgets,
move widgets,
align widgets,
copy/paste widgets,
group/ungroup widgets,
fit widgets onto the Page or in another widget, and
delete widgets on the Page.
Selecting widgets
You can select a widget or a subelement of a widget or even select multiple widgets in the GUI Designer Workspace.
Selecting a widget/subelement of a widget

When you hover a widget with the mouse or when you hover a subelement of a widget (like a cell/row in the Grid widget) by holding down the
Alt/Option key, the element or widget will be highlighted as shown below with a blue dotted line outside of it:

You can select the widget’s subelement or the widget itself by clicking on it. Once it is selected, it will have an orange dashed line inside of it:

This same principle applies to a widget that is composed of multiple widgets, like the Dialog widget. In our example below, we have held down
the Alt/Option key on the Cancel button to select it:

The widget or its subelement is selected in the Styles tab as shown below:

Another way to select a widget is by using the Select option in the contextual menu when you select a widget. As shown below, this option
allows you to select any of the widgets or widget subelements where you have requested the contextual menu:

You can select a widget inside of the selected Container widget by holding down the Shift key and dragging the mouse cursor around the
widget(s) you want to select. When you let go of the mouse button, only the widget(s) you outlined are selected:

Selecting multiple widgets

You can select multiple widgets either by drawing a box around the widgets with the mouse or by pressing Command (Macintosh) or Ctrl
(Windows) on each of the widgets you want to select.
If the selection box touches a widget, it is included in the selection. Therefore, you don't need to completely include it in the selection box for
it to be included in the selection:

If hold down the Alt‐Shift keys to include multiple widgets only those completely in the selection box will be selected:

To select all of the widgets on a page, you can choose Select All from the Edit menu or press Command‐A (Macintosh) or Ctrl‐A (Windows).
At the top of the Properties panel, the number of widgets selected is displayed:

Showing the grid on the Page
When moving widgets on the Page, you can do so in relation to a grid in the background that you can either show or hide. By default, it is
hidden. The grid appears as shown below on the Page:

To show the grid, select Show grid from the Page's contextual menu or select Hide grid, which appears only if the grid is shown on your Page, to
hide it:

For more information about customizing the grid, refer to the section.
Moving widgets
You can move one or more selected widgets by using the arrow keys on your keyboard, dragging it to another location, or by modifying the Top,
Right, Bottom, and Left parameters in the Size & Position section of the Styles tab in the Properties panel.
When moving objects, you can also make use of the GUI Designer's grid and magnetic grid as described below.
For more information about customizing the magnetic grid, refer to the section.
Snapping to the magnetic grid

When you snap a widget to the magnetic grid, you can:
snap to a horizontal and/or vertical side of another widget with or without a margin (which is 10 pixels by default),
snap to the center of another widget, or

snap to the horizontal and vertical borders of the Page with or without a margin (which is 10 pixels by default).
To define which widgets you want to line up your selected widget(s) with, you can hide certain ones by deselecting them in the Outline tab so
that the magnetic grid will not take them into account. Refer to the paragraph for more information.
If you hold down the Command key (Macintosh) or the Control key (Windows) while moving a widget, the magnetic grid appears, allowing you to
line up the widget to a side of another widget, the center of another widget, or the borders of the Page.

If you hold down the Option‐Command keys (Macintosh) or Alt‐Control keys (Windows), the magnetic grid that appears allow you to line up as
described above and also appears by adding an additional margin, which is 10 pixels by default, either around another widget or the Page.

Note: You can change the default margin by setting the left, right, top, and bottom properties, which are 10 by default, in the widget and page
properties. For more information, refer to the section.
Positioning a widget based on other widgets inside of another widget, like a Container widget, can be done using the same two techniques
described above:

Note: You can change this default behavior by setting the "onlySnapToSiblings" property to false as described in the section.
Snapping to the grid

You can also snap to the grid, which may or may not be visible in your Page's background as defined in the paragraph. To do so, select Snap to
grid from the Page's contextual menu.

When you choose the Snap to grid option and then move a widget, it is automatically aligned with the grid's cell:

You can temporarily turn off the grid when moving one or more widgets by holding down the Command key (Macintosh) or the Control key
(Windows).
Note: If you have selected to snap to the grid, the magnetic grid will not be functional at the same time.
Resizing widgets
You can resize widgets either individually or with other widgets.
Resizing a single widget

There are two ways to resize a widget once you've selected it on the Page:
Drag one of the corners or
Modify the Height, Width, Top, Bottom, Left, and Right properties in the Size & Position section of the Styles tab in the Properties panel.

If you hold down the Command key (Macintosh) or Ctrl key (Windows) while resizing the widget, the magnetic grid lines appear and snap to
another widget on the Page along its edges or at its center. If you hold down Option‐Command keys (Macintosh) or Alt‐Ctrl keys (Windows), the
magnetic grid lines appear and snap to another visible widget plus the defined margin (which is 10 pixels by default) around its edges.

If you have multiple widgets on the Page, you can hide certain ones by deselecting them in the Outline tab so that you can choose with which
widgets to align to the magnetic grid.
Resizing multiple widgets

You can resize multiple widgets by selecting them on the Page and pressing Ctrl‐T:

A rectangle appears around the widgets and they are highlighted as shown above. Drag one of the corners to a different location:

When you let go of the mouse, the widgets will each be resized:

If you hold down the Command key (Macintosh) or Ctrl key (Windows) while resizing the widgets, the magnetic grid lines appear and snap to
another widget on the Page along its edges or at its center. If you hold down Alt‐Command keys (Macintosh) or Option‐Ctrl keys (Windows), the
magnetic grid lines appear and snap to another visible widget plus the defined margin (which is 10 pixels by default) around its edges.
If you have multiple widgets on the Page, you can hide certain ones by deselecting them in the Outline tab so that you can choose with which
widgets to align to the magnetic grid.
Aligning widgets
If you want to align one or more widgets on your Page, you can do so either vertically or horizontally.
In the Align Vertically toolbar button, you can select one of the following options:
Align top
Align bottom
Center vertically
In the Align Horizontally toolbar button, you can select one of the following options:
Align left
Align right
Center horizontally
You can also choose to distribute the selected widgets either horizontally or vertically by selecting the Distribute Horizontally or Distribute
Vertically button in the GUI Designer's toolbar.
All of the above options are available in the Page's contextual menu:

Copying and pasting widgets
You can copy and paste one or more widgets on the same Page or from one Page to another. The scripts, CSS, and datasources used by the
widget are also copied to the Page. Remember, however, that you must modify the code in your widget's event if you declare the widget's ID,
e.g., dataGrid1. Otherwise, in the widget's event, you can use the ID that is in the event object (event.target.id).
The Page views must be the same, i.e., if you are copying widgets from a Desktop page you can only paste the widgets to another Desktop page.
You can copy widgets from a mobile Page (tablet or smartphone) to another mobile Page.
Below are a few points to be aware of when copying/pasting to the same or different Page:
Datasources that already exist
Positioning based on parent
Pasting into a Container
Datasources that already exist

If your widget is bound to a datasource that already exists on the Page to which you are pasting it, you will be asked if you want to use the same
datasources or create new ones.

Positioning based on parent

When pasting widget(s), the position is based on the parent (whether it's the actual body of the Page or another widget in which they are
currently located).
If you copy widgets that are inside of a Container widget:

And paste them to the Page, they will appear as shown below:

Pasting into a Container

If you want to paste them directly into a Container widget, you must first select the Container:

When you paste them into the Container widget, they will have the same positioning as in the previous Container or body of the Page:

Grouping widgets
You can group and ungroup multiple widgets together so that you can move them on the Page:

Even grouped, you can still select each widget separately to modify its properties:

To do so, select a few widgets and select Group from the contextual menu:

To ungroup them, select the same widgets and select Ungroup.
Fitting widgets onto the Page or in another widget
You can adjust a widget to fit to a specific side of the Page or parent widget (like a Container or Tab View) or fit it to the entire Page or parent
widget. Below are the available options with their descriptions:
Parent (auto‐fit): adjust the size of the widget so that the four Constraints are set (which means that the widget will be resized with the
Page or “parent” widget) and the Top, Bottom, Left, and Right properties are set to 0.
Parent: adjust the size of the widget so that the Top, Bottom, Left, and Right properties are set to 0. The Constraints are left
untouched.
Top: widget will be resized so that the Top property in the Size & Position section to 0. The left Constraint is set if it isn’t already.
Bottom: widget will be resized so that the Bottom property in the Size & Position section to 0. The bottom Constraint is set if it isn’t
already.
Left: widget will be resized so that the Left property in the Size & Position section to 0. The left Constraint is set if it isn’t already.
Right: widget will be resized so that the Right property in the Size & Position section to 0. The right Constraint is set if it isn’t already.
By default, the Constraints for a widget are set to Top and Left; however, they will be modified depending on the option you choose. None of
the constraints will be removed, only added.
In our example below, we have placed a Grid in a Tab View widget.

We select Parent (auto‐fit), and the Grid now appears as shown below:

If the Tab View widget is resizable, the Grid will also be resizable along with the Tab View so that it is fluid.
Note: For more information about the constraints, please refer to the Size & Position section in the Styles tab.
Deleting widgets
To delete one or more widgets on your Page, you must first select the widget(s) and do one of the following:

Select Delete from the widget’s contextual menu,

Select Delete widget from the contextual menu in the Outline, or

Click on either the keyboard's Backspace or Delete button.

Accordion
The Accordion widget allows you to have expandable sections in which you can place other widgets in a section defined by a header.

Adding an Accordion
You add an Accordion to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it in the Widgets
area, or drawing it to the size you want directly on the Designer Workspace.

Properties tab

The properties for an Accordion widget are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
One section always expanded: When this option is selected, the Accordion will always have one section expanded. Otherwise, you can
uncheck it and have none or multiple sections expanded at the same time.
Duration: The duration of the collapsing/expanding of a section in milliseconds.
Sections

In Sections, you can add and delete sections for your Accordion widget as well as edit the section titles:

By default, three sections are created. To add another section, click on the
icon at the top, right corner of the widget:

icon. You can also add another section by clicking the

To change the order of the sections, drag the
To delete a section, click on the

icon above or below the other sections listed.

icon that appears when you hover over the section.

Events tab

You can write JavaScript code for any of the following Mouse events that occur for an Accordion widget:
On Click: The user clicks on the widget.
On Double Click: The user double‐clicks the widget.
On Mouse Down: The user holds down the mouse button on the widget.
On Mouse Out: The user is no longer hovering over the cursor over the widget.
On Mouse Over: The user places the mouse cursor over the widget.
On Mouse Up: The user releases the mouse button after clicking on the widget.
For more information about how to add, modify, and delete events, refer to the “” paragraph in the “Widget Properties” section.
For more information about the event object for each of the above events, refer to "" in the "Widgets v1 Instance API" manual.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for an Accordion widget can be found in the Styles tab.

You can modify the styles for the following elements:
container (the widget itself): For the expanded and collapsed states of the widget’s container element: Background, Border, and Size &
Position.
title: For the default, expanded, and collapsed states you can modify the Text and Size & Position.
header: For the default, expanded, and collapsed states you can modify the Background, and Border.

content: For the default, expanded, and collapsed states you can modify the Text, Background, and Border.
Note: In the "default" state, you can modify the size and position of the elements in the Size & Position section. When the Accordion is
displayed on the Page, the "default" state is not visible; only the "expanded" and "collapsed" states are visible.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing an Accordion
The sections of the Accordion widget that you expand in the GUI Designer will be expanded by default when the page is run and displayed in
your browser window.
If you have the One section always expanded property checked, the Accordion can be displayed with either no sections expanded or multiple
ones expanded.

Auto Form
The Auto Form is a powerful tool that allows you to view each datastore entity in your datasource’s entity collection one by one. It allows you to
navigate the entity collection by going to the previous and next datastore entity. You can also add a new datastore entity or search in the
datasource as well as save or delete the current datastore entity. Below are the two ways the Auto Form can be displayed on your Page.

Adding an Auto Form
Besides the standard ways of adding a widget to your Page, you can use one of the following two additional methods:
Drag and drop (or draw) the Auto Form widget onto an empty space in the Designer Workspace.
Drag and drop a datastore class or one or more attribute(s) in the same datastore class from the Model or Datasources area onto an empty
area in the Designer Workspace and select Auto Form from the Auto Generated Widgets dialog.
Drag and drop (or Draw) an Auto Form: If you drag and drop, or draw, an Auto Form in the Designer Workspace, an empty Auto Form is created:

To attach a datasource to it, you can either drag and drop a datasource into the Auto Form or go to the Properties tab in the right panel and
enter the name of an existing datasource in Source. If the datasource doesn’t exist, an array datasource will be created automatically with the
name entered.
If you drag and drop a datasource onto the Auto Form, all the attributes of the datasource are added automatically. You can add or remove the
attributes in the Properties tab.

Otherwise you can enter the datasource name in the Source field. The Source field has an auto‐complete feature, which displays the list of the
datasources on your page corresponding to the first letters you typed.

A row for each attribute in the selected datasource appears in the Rows area of the Properties tab:

The Label is the header of the attribute displayed to the left of the data entry area in the Auto Form. The Attribute is the name of the attribute
of your datasource.
To delete an attribute from the Auto Form, click on the

icon that appears to the right of the attribute when you hover over it.

Drag and drop a datastore class (from Model tab) or a datasource (from Datasources tab): If you drag and drop a datasource—a datastore class or
one or more attribute(s) from the same datastore class—onto an open space in the Designer Workspace, the Auto Generated Widgets dialog
appears. To select multiple attributes from the same datastore class before opening the Auto Generated Widgets dialog, Ctrl‐click (Windows) or
Command‐click (Macintosh) each attribute before dragging and dropping them to an empty space in the Designer Workspace.

To create an Auto Form, select the Auto Form radio button at the top.
To add another attribute, click on the
icon at the top of the dialog. A new attribute is automatically added at the end of the list, which you
can modify by selecting an attribute from the Attribute name dropdown menu and entering another label for it.
To change the order of the attributes, drag the
before creating the Auto Form, click on the

icon next to the attribute above or below the other attributes. To delete an attribute
icon that appears to the right of the attribute when you hover over it.

Even after you have created the Auto Form, you can modify the attributes (which ones and their order in the form) in the Properties tab.
By default, the maximum number of attributes to display and create is 10. If you want to change this default value, refer to Defaults for the
Grid, Auto Form, and Auto Generated Widgets.
Properties tab

The Auto Form widget has the following properties:
ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: This is the name of the datasource used. You can either enter a datasource name or assign it automatically by dragging and
dropping the datasource onto the widget.
Draggable: Selecting this checkbox allows for your Auto Form to be draggable on the page when it is published.
Resizable: To allow your users to resize the Auto Form, select this checkbox.
With included widgets: Selected by default, this option transforms the attributes in the Auto Form to individual widgets. Otherwise, they
are displayed in two columns (title and value).
Allow resizing of each widget: When the “With included widgets” option is selected, the individual widgets can be resized when the Page
is published.
Auto fit widgets: If you select this option, the included widgets like Images and other Auto Form widgets (for related attributes) in the
Auto Form will automatically be resized to the size of the widget.
Error Handling

In this section, you can define how errors are handled for the Auto Form:
Display errors: By selecting this option, you signal to Wakanda that you want to display any error that occurs either in Wakanda's
automatic error display window or in the widget whose ID you specify in the following property.
Error ID: The Text, Container, or Display Error widget ID in which the error will be displayed.
Note: For more information, please refer to the “Error ID Property” section in the “Widget Properties” chapter
Rows Area

In the Rows area, you can add, modify, and delete the attribute displayed in the Auto Form.
To add another attribute, click on the
icon at the top of the area. A new attribute is automatically added at the end of the list, which you
can modify by selecting an attribute from the Attribute name dropdown menu and entering another label for it.
To change the order of the attributes, drag the
click on the

icon next to the attribute above or below the other attributes. To delete an attribute,

icon that appears to the right of the attribute when you hover over it.

Events tab

You can write JavaScript code for the following event that occurs for an Auto Form:

On Error Handler: When an error occurs during data entry in the Auto Form.
The Auto Form also has resize events that are triggered when it is resized
On Start Resize: This event is called when you begin resizing the Auto Form.
On Resize: This event occurs while you resize the Auto Form.
On Stop Resize: After you’ve stopped resizing the Auto Form.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The Styles tab allows you to set the style of the entire widget, the header, the body, or the footer of the Auto Form:

You can modify the styles for the widget’s following elements: Container, Header, Body, and Footer.

Container: Modify the Text, Background, Border, Drop Shadow, and Size & Position settings.
Header: Modify the Text, Text Shadow, Background, and Border settings.
Body: Modify the Text, Text Shadow, and Background settings.
Footer: Modify the Text, Text Shadow, and Background settings.
Note: You can also select a to affect the header and footer for all the Auto Forms on the same Page.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing an Auto Form
Many automatic features are available when you publish your Auto Form:
Previous: The left arrow allows you to go to the previous datastore entity in your entity collection.
Next: The right arrow allows you to go to the next datastore entity in your entity collection.
Clear: The
icon allows you to clear the values in the Auto Form without affecting the current datastore entity. To create a new
datastore entity, you must click on this button first before entering values into the Auto Form.
Find: By clicking on the magnifying glass icon, you can search your datasource by attribute.
Save: Save a modified or new datastore entity.
Delete: Delete the current datastore entity displayed in the Auto Form.
Entity collection number/total: The number of the datastore entity in the entity collection as well as the total number of entities in the
entity collection is displayed in the lower right corner.
Draggable: When this option is selected in the Properties tab, users can drag the Auto Form anywhere on the page.
Resizable: If you select this option in the Properties tab, you allow users to resize the Auto Form.
If your Auto Form has a relation attribute in it, you can search for and assign the datastore entity to the relation attribute. For example, in our
Employees Auto Form, we have the “employer” relation attribute:

The included Auto Form has the following functionality:
Clears the current values displayed and creates a new datastore entity by clicking the
Click the
icon to search on one of the attributes to find a datastore entity.

icon.

If we have an Auto Form for the “Company” datastore class with the relation attribute “staff” included, it will appear as shown below:

In this case, you can add a new datastore entity by clicking the

icon or delete a datastore entity by selecting it and clicking the

icon.

For attributes of type Date, the date picker appears automatically for you to select a date:

If you have an attribute of type String and have selected the attribute’s Autocomplete property in the Datastore Model Designer, a list of values
appears that correspond to the letters that you type into this widget will appear.

Button
The Button widget allows you to include buttons on your Pages that can have either links to a URL or Page in your project, automatic actions to
be performed on datasources, or your own JavaScript code.
Adding a Button
You add a Button to the Page by dragging and dropping it onto an empty space on the Designer Workspace, double‐clicking on it, or drawing it to
a specific size directly on the Page.
You can assign a datasource to it and select one of the automatic actions like save, next, and previous) by dragging and dropping it on top of the
widget. If you enter a datasource name that doesn’t exist, a Variable datasource will be created automatically with the same name.
Properties tab

Buttons have the following properties depending on the type of Button you’d like to create. By default, the properties for the Button widget are
shown in the first screenshot. If you include a link for the Button widget, the properties in the second screenshot are available. If you define a
datasource for the Button widget, the properties in the last screenshot are available.

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of a datasource to be used with automatic events like create, save, next, previous, last and first. You can either enter the
name of the datasource or assign it automatically by dragging and dropping the datasource onto the widget.
Action: Automated functions for the button, such as: Create, Simple, Save, Next, Previous, Last, First, and Remove. Select “Simple” when
you want to write your own code. If you select an action, its name will be inserted by default as the label for the widget. This property
only appears if you have specified a Source.
Button title: The title of the button. This value can also be edited by double‐clicking on the Button on the Designer Workspace. If you
select an automatic action for a button, the name of that action will be used as the button’s title (if no text was previously entered in
this field). You can still edit the value in this property.
URL: Defines the URL to go to when included. You can include any type of link into the URL property, e.g., a URL
(“http://www.wakanda.org/”), an email address (“mailto:info@wakanda.org”), or a Page (“/employees/” or "/index/"). You can drag and
drop an Page onto the widget and it will be automatically inserted as the link.
Target: Select “_blank” to open the URL defined in the URL property in a new page or “_self” to remain on the same page.
Tabindex: Defines the tab order of the widget on the Page. When tabbing, you begin with the object with the lowest Tabindex and go to
the highest.
Events tab

You can write JavaScript code for any of the following mouse events that occur for a Button:
On Click: The user clicks on the Button.
On Double Click: The user double‐clicks the Button.
On Mouse Down: The user holds down the mouse button on the Button.
On Mouse Out: The user is no longer hovering over the cursor over the Button.
On Mouse Over: The user places the mouse cursor over the Button.
On Mouse Up: The user releases the mouse button after clicking on the Button.
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “Events” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

You can customize the look of each Button by making changes in the Styles tab for its following four states: Default, Hover, Active, Focus, and
Disabled.

Default: The default state of the Button widget. You can modify its Text, Text Shadow, Background, Border, Drop Shadow, and Size &
Position.
Hover: For the hover state, you can modify: Text, Text Shadow, Background, Border, and Drop Shadow.
Active: For the active state, you can modify: Text, Text Shadow, Background, Border, and Drop Shadow.
Focus: For the focus state, you can modify: Text, Text Shadow, Background, Border, and Drop Shadow.
Disabled: For the disabled state, you can modify: Text, Text Shadow, Background, Border, and Drop Shadow.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Button
The Button widget appears as it does on the Designer Workspace; however, its behavior is dependent on the actions you selected or defined in
the Events and Properties tabs for the Button.

Calendar
The Calendar widget allows you to include a Calendar on your Page so that you can either display or input data. The Calendar widget allows you
to select one day, multiple days, or even a range of days.

When bound to a datasource, the Calendar widget is automatically redrawn to show the dates.
Adding a Calendar Widget
You add a Calendar widget to your Page by first selecting the widget from the Widgets area and then by dragging and dropping it in an empty
space on the Designer Workspace, double‐clicking on it in the Widgets area, or drawing it to the size you want directly on the Designer
Workspace.

Using the arrow on the top right corner, you can switch to one of the three possible views. The default view is the “Day” view.

Properties tab

The properties for a Calendar widget are as follows:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of a datasource of type Date. You can either enter the name of the datasource or assign it automatically by dragging and
dropping the datasource onto the widget.
Label: The label for the Calendar widget.
Views: The number of views to display.

Start on: The day on which to start the Calendar, which can be from Monday to Sunday.
Selection mode: You can either select one or more dates in either Single, Multiple, or Range mode.
Format: The display format for the date. You can retrieve the formatted date with the [#cmd id="700260"/]() Widget API function.
Save automatically: This option is selected by default and saves the contents of the widget to the datasource bound to it once the focus
is no longer on it.
Events tab

You can write JavaScript code for any of the following Calendar and Mouse events that occur for a Calendar widget:
On Change: When the date is changed in the Calendar widget.
On Click: The user clicks on the widget.
On Double Click: The user double‐clicks the widget.
On Mouse Down: The user holds down the mouse button on the widget.
On Mouse Out: The user is no longer hovering over the cursor over the widget.
On Mouse Over: The user places the mouse cursor over the widget.
On Mouse Up: The user releases the mouse button after clicking on the widget.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Calendar widget can be found on the Styles tab.

You can modify the styles for the widget’s following elements:
Container: You can modify the container’s Background, Border, Drop Shadow, Inner Shadow, and Size & Position.
Header: You can modify the Text and Text Shadow styles.
Day name header: You can modify the Text and Text Shadow styles.
Days in month: You can modify the Text and Text Shadow styles.
Days not in month: You can modify the Text and Text Shadow styles.
Week numbers: You can modify the Text and Text Shadow styles.
Selected day(s): You can modify the Text, Text Shadow, and Background styles.
Month: You can modify the Text, Text Shadow, and Background styles.
Year: You can modify the Text, Text Shadow, and Background styles.
Label: You can modify the following settings for the widget’s label: Label Text, Label Text Shadow, and Label Size & Position.
Note: You cannot define the constraints for the Container of a Calendar widget because its size must be fixed when it is published on a Page.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Calendar
When the Calendar widget is published to your Page, you can access its three views (Day, Month, and Year) by clicking on the header (which
contains the month, year, or year range).
The Day view is the standard calendar view in which you can navigate the year by clicking on the left and right arrows to a previous or next
month.

If you click once on the month, the Month view is displayed. This view allows you to select a specific month in the year:

If you click on the year in the header, the Year view appears. This view allows you to select a year.

When you select a specific number (in our case 3) for the Views property, the Calendar widget appears as shown below:

To navigate the calendar, you can click any of the left or right arrows and all the calendars will be updated.

Canvas
The Canvas widget allows you to draw directly on the Page by writing JavaScript code. Our example below is a clock that continually redraws
itself to show the current time.

Adding a Canvas Widget
You add a Canvas widget to your Page by first selecting the widget from the Widgets area and then by dragging and dropping it in an empty space
on the Designer Workspace, double‐clicking on it in the Widgets area, or drawing it to the size you want directly on the Designer Workspace.

Properties tab

The properties for the Canvas widget are as follows:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of a datasource of type Image. You can either enter the name of the datasource or assign it automatically by dragging and
dropping the datasource onto the widget.
Label: The label for the Canvas widget.
Background URL: An image file located in the WebFolder. If you choose an image that is not in your project’s WebFolder, it will be copied
into the “images” folder in the WebFolder.
Events tab

You can write JavaScript code for any of the following mouse events that occur for a Canvas:
On Click: The user clicks on the widget.
On Double Click: The user double‐clicks the widget.
On Mouse Down: The user holds down the mouse button on the widget.
On Mouse Out: The user is no longer hovering over the cursor over the widget.
On Mouse Over: The user places the mouse cursor over the widget.
On Mouse Up: The user releases the mouse button after clicking on the widget.
On Touch Cancel: A touch on the widget has been interrupted.
On Touch End: When the user has removed a finger from the widget.
On Touch Move: When the user's finger moves over the widget.
On Touch Start: When the user places a finger (touches) the widget.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Canvas widget can be found on the Styles tab.

You can modify the styles for the widget’s following elements: Container and Label (if one has been defined for the widget).
Container: You can modify the container’s Background, Border, Drop Shadow, Inner Shadow, and Size & Position.
Label: You can modify the following settings for the widget’s label: Label Text, Label Text Shadow, and Label Size & Position.
Note: You cannot define the constraints for a Canvas widget because its size must be fixed when it is published on a Page.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Canvas
The Canvas widget appears differently depending on the Source or Src properties that you have specified. You can, for example, dynamically
modify the Canvas widget, allow a user to draw in it, or place images in it.
For more information on how to dynamically draw in the Canvas widget, please refer to the “Canvas” chapter in the Widgets API manual as well
as the W3C reference.

Chart
The Chart widget allows you to chart values from a datasource in the form of a Pie Chart, Line Chart, or Bar Chart.

In Line and Bar Charts, you can include multiple attributes to compare them:

Adding a Chart
You add a Chart widget to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or drawing it
to the size you want directly on the Designer Workspace. The Chart widget is created along two other widgets in a container: chart‐title (Text
widget) and chart‐legendary.
When the Chart widget has been created, multiple widgets are created along with it inside of a container: chart‐title, chart, and chart‐
legendary. The first one is a Text widget and the chart‐legendary is a Container.

After you drop a datasource onto the Chart widget, it will appear as follows:

Properties tab

The Chart widget has the following properties for each type of Chart. Below are the properties for the Pie, Line, and Bar Chart:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the datasource. You can either enter the name of an existing datasource or assign it automatically by dragging and
dropping the datasource onto the widget.
Limit Length: Limit the number of entities to display in the chart.
Draggable: Selecting this checkbox allows your Chart to be draggable when it is published.
Type: Define which type of chart to display: Pie Chart, Line Chart, or Bar Chart.
Data Series: This section allows you to add, move, and delete one or more attributes of type Number (Long, Long64, and Number)
to be used for the chart.
To add an attribute, click on the
icon. To change the order of the attributes, drag the
icon above or below the other
attribute(s) listed. To delete an attribute, click on the

icon that appears when you hover over it.

The Data Series section has the following two properties for each attribute:
Label: Label of the attribute to be used in the legendary for Line and Bar Charts.
Attribute: Name of the attribute in the datasource assigned to the chart.
For each attribute, you can also add a display format, by inserting it in the Format area that appears when you click on the
Label or Attribute:

For the Line Chart or Bar Chart, you can also select a color in Data Series section :

Tooltip: This section allows you to specify certain properties with the tooltip.
Display: Select this checkbox to display the tooltip, which are the values in the Data Series section.
Type: For the Bar and Line Charts, you can also define the type of tooltip that appears: tag, flag, blob, popup, and label.
Type
tag

Icon

Description
The tag tooltip can be placed at any angle around the point on the chart.

flag

The flag tooltip can be placed at any angle around the point on the chart.

blob

The blob tooltip, which is the default type, can be placed at any angle around the point on the chart.

popup

The popup tooltip can be placed at one of four directions (see Direction property below) around the point on
the chart.

label

The label tooltip can be placed at any angle around the point on the chart.

Angle: Define at what angle the tooltip should appear. This property is applicable to all types of tooltips except the
“popup” type (see below).
Direction: For the “popup” type, you can select in which direction it is displayed: North, South, East, or West.
Axis: For each of the chart types, there are different values that appear in this section:
For Pie Charts
Axis Labels: Select the attribute whose values will be displayed at the top of the tooltip and in legendary.
For Line Charts
Axis Labels: Select the attribute whose values will be displayed along the x‐axis.
Vertical Step Count: Number of steps on the y‐axis.
Horizontal Step Count: Number of steps on the x‐axis.
For Bar Charts
Line chart type: Select the type of chart: Stacked percentage column, Stacked column, or Basic bar.
Axis Labels: Select the attribute to display in the legendary and at the top of the tooltip.
Label Angle: Define at what angle the tooltip should appear.
Label Anchor: Depending on the angle, the x‐axis label is displayed either at the start, middle, or end.
ymin: Minimum value on the y‐axis.
ymax: Maximum value on the y‐axis.
Steps/Range: Either the number of steps or the range.
Events tab

You can execute code during the following Data Point events for a Chart:
On Click: When a data point is clicked.
On Double Click: When a data point is double‐clicked.
On Mouse Down: If the user holds the mouse down on a data point.
On Mouse Move: When the user moves the mouse while over a data point.
On Mouse Out: Once the user is no longer hovering over a data point.
On Mouse Over: If the user places the mouse over a data point.
On Mouse Up: Once the user lets go of the mouse after clicking on a data point.
You can execute code during the following Touch events for a Chart:
On Touch Cancel: A touch on the widget has been interrupted.
On Touch End: When the user has removed a finger from the widget.
On Touch Move: When the user's finger moves over the widget.
On Touch Start: When the user places a finger (touches) the widget.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Chart widget and its legendary can be found on the Styles tab.

Below are the styles for these two associated widgets:
Container: You can modify the following styles: Background, Border, Drop Shadow, and Size & Position.
Legendary: You can modify the following styles: Background, Border, Drop Shadow, Inner Shadow, and Size & Position.
Note: The Text widget that is created for the chart title can also be modified. Refer to the Text widget for more information.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Chart
When you hover a piece (in the pie chart), a point (on the line chart), or a bar (in the bar chart), the tooltip will be displayed as shown in our
examples at the beginning of this section.
For the Pie Chart, if you click on an item in the legendary, that piece of the pie chart will pop out of the pie as shown below:

If the elements in the legendary surpass the height of the widget, a scrollbar will appear allowing you to navigate the elements:

Checkbox
The Checkbox widget allows you to create a checkbox on your Page.
Adding a Checkbox
You add a Checkbox to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or drawing it to
the size you want directly on the Designer Workspace. You can assign the datasource (for example, an attribute of type Boolean) by dragging and
dropping it on top of the widget. If you enter a datasource name that doesn’t exist, a Variable datasource will be created automatically with the
same name.
Properties tab

Checkboxes have the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of a datasource, like a Boolean attribute. You can either enter the name of the datasource or assign it automatically by
dragging and dropping the datasource onto the widget.
Error ID: When you include the ID of a Display Error widget, a message for an error that occurred with the Checkbox widget will be
displayed in that Display Error widget.

Checked: Defines if the checkbox is checked by default.
Label: The checkbox label.
Tabindex: Defines the tab order of the widget on the Page. When tabbing, you begin with the object with the lowest Tabindex and go to
the highest.
Events tab

You can write JavaScript code for any of the following focus and mouse events that occur for a Checkbox:
On Blur: When the Checkbox loses focus.
On Change: When the value of the Checkbox is changed. In this event, you can test the value of the Checkbox widget.
On Focus: When the Checkbox gets the focus.
On Click: When the Checkbox is clicked.
On Mouse Down: If the user holds the mouse button down on the Checkbox.
On Mouse Out: Once the user is no longer hovering over the Checkbox.
On Mouse Over: If the user places the mouse button over the Checkbox.
On Mouse Up: Once the user lets go of the mouse button after clicking on the Checkbox.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Checkbox can be found on the Styles tab:

The Checkbox widget is made up of three elements: Container, Box, and Label.

Container: The entire Checkbox widget. You can modify its Icon, Background and Size & Position.
Box: The actual checkbox portion of the widget. For this element, you can also customize its different states: default, hover, active,
selected, and disabled. For all these states, you can modify the Background, Border, and Icon.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Icon

For more information about the Icon section, please refer to the “” paragraph in the “Widget Properties” section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Checkbox
The Checkbox widget appears as it does on the Designer Workspace; however, its behavior is dependent on the actions you selected or defined
in the Events and Properties tabs for the Checkbox.
When a Checkbox is bound to a Boolean attribute, its value is automatically saved with the current entity.
To check and uncheck the Checkbox widget, you can click on either the checkbox or the Checkbox widget's title.

Combo Box
The Combo Box widget allows you to display a combo box or a dropdown on your Page that can contain static values or can be bound to a
datasource.
The difference between a combo box and a dropdown menu is that the combo box is enterable and therefore can be used to refine a search
based on the letters typed into it. The dropdown menu is not enterable and a user can only select an option in the widget.
When a value is selected in the Combo Box widget, it will either select the entity in the entity collection or modify the entity collection based
on the value selected (when the datasource is a relation attribute) in another widget as shown in our example below:

Adding a Combo Box
You can add a Combo Box widget to your Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it,
or drawing it to the size you want directly on the Designer Workspace. This widget can be used in two different ways: bound to a datasource
(attribute, datastore class, or array) or defined by a set of options with fixed values. You can assign a datasource (attribute or datastore class) by
dragging and dropping it on top of the widget. When you do so, the name of the datastore class is inserted automatically in the Choice Source
field and its attributes are added in the Attributes area. If the object you dragged was an attribute, the datastore class that it belongs to is
inserted automatically into the Choice Source field with the attribute selected in the Key field.
Binding a Datasource to the Combo Box

In the Properties tab, you can define how to bind a datasource to the Combo Box widget. In our case, we have a relation attribute “staff” that is
the 1‐>N relation attribute in “company” that links it to the “Employee” datastore class. Our Grid uses the datasource “staff,” which displays the
attributes from the “Employee” datastore class. In our Combo Box widget, we use “company” as the Choice Source, the N‐>1 relation attribute
in “employee.employer” as the Value Source, and select “company” as the Key. To automatically update the entity collection of our Grid

widget, we check the Auto Dispatch checkbox. When we select a company, the Grid is updated with the employees who work for that company.

You could also display all the entities from a datastore class in a Combo Box. In our example below, we display the “city” datastore class
containing all the cities in a combo box so that when the user selects one it is saved in an attribute. In our example, we are saving the selected
value from the Combo Box in the “company.city” attribute.

Defining Options for a Combo Box

When you set the options for a Combo Box widget, you set its values in the Options section of the Properties tab without entering anything in
the Choice Source property:

Properties tab

The Combo Box widget has the following properties:
ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Choice source: Name of the datasource (datastore class or array) that will supply the values to display. You can either enter the name of
the datasource or assign it automatically by dragging and dropping the datasource onto the widget.
Value source: Name of the attribute to receive the selected value from the widget. You can either enter the name of the datasource or
assign it automatically by dragging and dropping the datasource onto the widget.
Key: The attribute from the datasource defined in Choice Source to be returned. You can select either an attribute or a datastore entity
by selecting the datastore class name from the list. This property only appears if you have a value in Choice Source.
Format: Display format for the data in the Combo Box widget.
Note: For more information on display formats, please refer to the “Format Property” paragraph in the “Widget Properties” section.
Label: The title of the Combo Box widget.
Auto Dispatch: When checked, Wakanda automatically sends the query to modify the entity collection.
Tabindex: Defines the tab order of the widget on the Page. When tabbing, you begin with the object with the lowest Tabindex and go to
the highest.
Autocomplete: When this option is checked, you can type a few letters directly in the Combo Box during runtime to return values that
correspond to the text entered. If you leave this option unchecked, the Combo Box widget becomes a dropdown menu in which you can
only select values and not retrieve one by typing in the widget.
Display limit: Limit the number of elements to display when the Autocomplete option is checked. By default, this value is set to 20. See
the example in the "Publishing a Combo Box" paragraph below.
Attributes

If you have defined a datasource in the Choice source property, you can add attributes from the source’s datastore class to your Combo Box
widget, by clicking the
icon and selecting an attribute from the dropdown menu in the Attributes section. If you have defined a datasource
(e.g., a datastore class), the attributes you can display are the attributes of the datastore class.

To change the order of the attributes, drag the
To delete an attribute, click on the

icon above or below the other options listed.

icon that appears when you hover over it.

Options

If you have not defined a datasource in the Choice Source field for the Combo Box widget, you can add options to it in the Options section by
clicking the
icon. You must enter both a value and a label for each option.

You can define which of the options will be displayed by default by selecting the Selected radio button to the right.
To change the order of the options, drag the
To delete an option, click on the

icon above or below the other options listed.

icon that appears when you hover over it.

Events tab

For the Combo Box widget, you can execute code during the following focus and mouse events:
On Blur: When the Combo Box widget loses focus.
On Change: When the value of the Combo Box widget has changed.
On Focus: When the Combo Box widget gets the focus.
On Click: Once the Combo Box widget has been clicked.
On Mouse Down: If the user holds the mouse down on the Combo Box widget.
On Mouse Out: Once the user is no longer hovering over the Combo Box widget.
On Mouse Over: If the user places the mouse over the Combo Box widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Combo Box widget.
For more information about how to add, modify, and delete events, please refer to the “Events” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Combo Box widget can be found on the Styles tab. The Styles tab for the "Container" and the "Input" elements of the
Combo Box are shown below:

You can modify the styles for the widget’s following elements: Container, Input, Button, List, and Label.

Container: You can modify the styles for its states (default, hover, active, and disabled) of the container of the widget. You can modify
its Text, Background, Border, Drop Shadow, and Size & Position.
Input: The input element of the Combo Box widget has different states (default, hover, active, and disabled) for which you can modify its
Text, Text Shadow, Background, and Border.
Button: The button element of the Combo Box widget has different states (default, hover, active, and disabled) for which you can modify
its Background and Border.
List: You can modify the following styles for the list element of the Combo Box widget: Text, Text Shadow, Background, and Border.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.

Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Combo Box
When you bind the Combo Box widget with a datasource (and the Auto dispatch property is selected), the entity collection will either change or
an entity collection will be selected based on the value selected from the Combo Box widget.
When “Apple” is selected, the employees for Apple are displayed:

When “4D” is selected, the entity collection is modified:

For a Combo Box widget with a static set of values, it appears as it does on the Designer workspace.
When you select the Autocomplete option for a Combo Box, you can enter one or more letters in the editable area to display only the values
(either entities or options) that begin with those letter(s) in the Combo Box:

If you have entered a value in the Display Limit property, the list is reduced. In our case, we entered 10.

Component
The Component widget allows you to include a Web Component on your Page. You can also use this widget to display a modal (or non‐modal)
dialog by loading and removing a Web Component in the Component widget.
Adding a Component Widget to your Page
To add a Component widget to your Page, you can do one of the following:
Drag the Component widget and drop it in an empty space on your Page (then assign the Web Component to it by specifying it in the Web
component path property),
Double‐click the Component widget and specify the path to your Web Component,
Draw the Component widget on your Page and specify the path to your Web Component, or
Drag a Web Component from your WebFolder and drop it in an empty space on your Page.
When assigning the name of the Web Component to the Component widget, you just need to enter the first letters in the Web component path
property on the Properties tab and Wakanda will find those available to your project.
Once you have a Component widget on your Page, you can open the Web Component’s HTML file in the GUI Designer by selecting Edit from the
contextual menu as shown below:

Properties tab

The Component widget has the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the “Naming Conventions” section.

Hide widget on load: This option allows you to hide the widget when your Page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual. Even if the Component widget is hided, the Web Component
you defined for it will be loaded unless you deselect the Load by Default option.
Web component path: Path to the Web Component in your project, i.e., “/{Component Name}.waComponent”.
Draggable: Selecting this checkbox allows for your Component to be draggable on the page.
Resizable: Select this checkbox for your Component to allow users to resize the Component when it is published. The widgets in the
Component will not be resized along with the component unless you have selected this checkbox for those widgets that can be resized.
Modal: This option allows you to load a Web Component in the Component widget and have it act as a modal dialog. To have the
Component widget appear as a modal dialog, select this option and deselect the Load by Default option. Based on a specific user action,
you can then load the Web Component (using the loadComponent( ) function in the Widget API) so that the Component widget appears as
a modal dialog. To close the dialog, call the removeComponent( ) function.
Load by Default: Load the Web Component defined in Path by default. Otherwise, you can define the Web Component in Web component
path without having it be loaded when the Page is loaded.
Events tab

You can execute code during the following mouse events for a Component widget:
On Click: When the user clicks on a Component.
On Double Click: When the user double‐clicks on a Component.
On Mouse Down: If the user holds the mouse down on the Component.
On Mouse Out: Once the user is no longer hovering over the Component.
On Mouse Over: If the user places the mouse over the Component.
On Mouse Up: Once the user lets go of the mouse after clicking on the Component.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Component widget can be found on the Styles tab. A Component widget is its own entity and the styles you define
here will not be overwritten by those defined for the Page in which the Component widget is located.

The Component widget has the following styles: Background, Border, Drop Shadow, and Size & Position.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Previewing a Web Component on a Page

Once you include a Component widget on your Page, you can preview its content to better situate it.
Below is an example of a login Web Component:

Here is the same Web Component included in a Component widget on an Page:

Loading a Web Component
There are two ways to load a Web Component in the Component widget on your Page:
Use the loadComponent( ) function in the Widgets v1 Instance API or
Use the loadComponent function in WAF.
WAF's loadComponent function has the following parameters:
Property
id
path
onSuccess
userData

Type
String
String
Function
Object

Description
Component widget ID
Path to the Web Component in the WebFolder
Function to call when the loading of the component is successful
Data you'd like to pass and retrieve when the Component widget is published

Below is an example of using the loadComponent( ) function to load a different Web Component in the Component widget:

$$('component1').loadComponent("/myComponent.waComponent");

You can also use WAF's loadComponent function to load a different Web Component in the Component widget:

button1.click = function button1_click (event)
{
WAF.loadComponent ( {
id:
'component1',
path:
'/myComponent.waComponent',
onSuccess: function () {
//do something here;
}
} );
};
Removing a Web Component
There are two ways to remove a Web Component from the Component widget on your Page:
Use the removeComponent( ) function in the Widgets v1 Instance API or
Use the removeComponent function in WAF.
If, for example, you have loaded a Web Component to display a modal dialog on your Page in a Component widget, you can remove it afterwards
by calling the removeComponent() function from your Web Component's JavaScript file:

button1.click = function button1_click (event)
{
$comp.removeComponent();
// or $$(id).removeComponent();
};

Container
The Container widget allows you to place one or more widgets inside of it so that they are grouped together. The Container widget is an HTML
<div> and can therefore be manipulated in your JavaScript code as a single object.
With a Container widget, you can also create horizontal and vertical splitters that allow you to divide the Container into different areas as shown
below:

Adding a Container
You add a Container to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it in the Widgets
area, or drawing it to the size you want directly on the Designer Workspace.
Note: If you select the Container and delete it, all the widgets it contains will also be deleted.
You know when a widget has been included into the container when the Container is highlighted as you hover over it:

Properties tab

The common properties for a Container widget (for the Desktop, Smartphone, and Tablet views) are described below.

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Label: Label for the Container widget.
Container Properties for Desktop

For the Desktop, the Container widget has the following additional properties:

Draggable: Selecting this checkbox allows for your Container to be draggable on the page. This property is not visible for a section of a
split Container widget.
Resizable: To allow your users to resize the Container when it is published, select this checkbox for your Container. This property is not
visible for a section of a split Container widget.
If you have created a splitter (either vertically or horizontally) for the Container widget, the following properties are available in the Splitter
Options section:

Hide splitters: Hide the Container’s splitters by selecting this option. This option is only available if you have created vertical or
horizontal splitters for the Container.
Left splitter button: When you indicate the ID for a Button widget, this button appears when the Left area of a split Container widget is
hidden either programmatically or automatically when the page (mobile or desktop) is resized and the left Container no longer fits. The
left Container is then displayed in a popup window when you click on the Button widget whose ID is indicated.
Container Properties for Mobile Devices

If you have a Container widget on a mobile Page (for Smartphone or Tablet), one additional property is available:

Scrollable: When this option is selected, horizontal and/or vertical scrollbars will appear if the contents of the Container are wider and/or
longer than the actual widget.
Events tab

You can execute code during the following mouse events for a Container widget:
On Click: When the Container widget is clicked.
On Double Click: When the Container widget is double‐clicked.
On Mouse Down: If the user holds the mouse down on the Container widget.
On Mouse Out: Once the user is no longer hovering over the Container widget.
On Mouse Over: If the user places the mouse over the Container widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Container widget.
The Container widget also has resize events that are triggered when the Container widget has been set to be resizable:
On Start Resize: This event is called when you begin resizing the Container widget.
On Resize: This event occurs while you resize the Container widget.
On Stop Resize: After you’ve stopped resizing the Container widget.
The following Touch events are available:
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Move: When the user's finger moves over the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Container widget can be found on the Styles tab:

You can modify the styles for the widget’s following elements: Container and Label (if one has been defined for the widget).
Container: You can modify the container’s Background, Border, Drop Shadow, Inner Shadow, and Size & Position.
Label: You can modify the following settings for the widget’s label: Label Text, Label Text Shadow, and Label Size & Position.
If you insert a Container widget in a Matrix widget, you have two selectors: Default and Selected. The Default state, you can modify all the

styles listed above for the Container widget. For the Selected state, you can modify all the same styles as the Default state except for those in
the Size & Position section.

Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Creating Splitters for a Container
The Container widget allows you to split the Container or a section of a Container (previously split) in half, either horizontally or vertically. To
do so, just select the Container widget and choose either Split‐>Horizontally or Split‐>Vertically from the contextual menu:

You can split a Container widget as many times as you’d like.
You click on each split Container to select it. Each section of the Container that is created is a Container widget; however, you cannot define it
to be Draggable or Resizable in the Properties tab and you cannot modify the Size & Position settings in the Styles tab.

You can also resize the split Containers by dragging the resize icon that appears:

Joining a Split Container

You can join split Containers by Command‐clicking (Mac) or Ctrl‐Clicking (Windows) the horizontal‐split or vertical‐split sections and selecting
Join from the contextual menu:

Note: You can only join sections of the Container that were previously split.
Showing/Hiding Left Split Container

When you split a Container widget vertically, you can set it so that the left splitter area disappears when there is need for more space on the
page. This feature is especially useful on Tablets or Smartphones.
With the following Container split vertically and a Button widget at the top (whose ID we indicated in the Left Splitter Button property):

When the page is published, it appears as follows:

If the page is resized and the left area no longer fits, it will be removed and the Button widget we created appears as shown below:

When you click on the Button widget, the left splitter Container appears in a popup window:

Dialog
The Dialog widget allows you to include another Page or individual widgets that you can display in a dialog box. You can also define if you want it
to be displayed as a modal dialog box.

Adding a Dialog
You add a Dialog to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it in the Widgets
area, or drawing it to the size you want directly on the Designer Workspace.

You can customize any part of the Dialog widget because it is made up of the following widgets:
Header area (Container widget)
Icon in the title bar (Image widget)
Title in the title bar (Text widget)
Minimize button (Button widget)
Maximize button (Button widget)
Close button (Button widget)
Dialog area (Container widget)
Footer area (Container widget)
Cancel button (Button widget)
OK button (Button widget)
To select any of the widgets separately to make any modifications, hold down the Alt (Macintosh) or Option (Windows) key.

By default, the Close and OK buttons have the following line of code that allows you to close the Dialog widget:

$$('dialog1').closeDialog();

Properties tab

The properties for a Dialog are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
HTML file to include: Specify the name of the HTML file in your project to display inside the Dialog. If the widgets are larger than the
Dialog, vertical and/or horizontal scrollbars will appear. You can drag and drop an HTML file from your project to this property. The HTML
file is inserted as “/companies.waPage/index.html”.
Draggable: Selecting this checkbox allows for your Dialog to be draggable on the page. By default, this option is selected.
Resizable: Allow users to resize the Dialog when it is published on the Page.
Modal: This option allows you to define the Dialog widget as being modal. In this case, the rest of the Page is greyed out and only the
modal Dialog widget will be active.
Float on top: This option allows the Dialog widget to float on top like a palette.
Close on outside click: This option, which is only available for Modal dialogs, allows the user to click anywhere on the page to close the
Dialog widget.
Events tab

You can execute code during the following mouse events for a Dialog widget:
On Click: When the Dialog widget is clicked.
On Double Click: When the Dialog widget is double‐clicked.
On Mouse Down: If the user holds the mouse down on the Dialog widget.
On Mouse Out: Once the user is no longer hovering over the Dialog widget.
On Mouse Over: If the user places the mouse over the Dialog widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Dialog widget.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Dialog widget can be found on the Styles tab:

The Dialog widget has the following styles: Border and Size & Position.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Dialog
When you publish a Dialog widget, it appears as shown below with the following three buttons in the title bar:

The Minimize button allows you to reduce the Dialog widget to just its title bar that you can click to restore back to its original size:

The Maximize button resizes the Dialog widget to fit in either the Page or the Container widget in which it is located.
The Close button closes the Dialog widget. The only way to reopen it is by using this widget's displayDialog( ) function.
If you define an HTML file in the HTML file to include property, horizontal and/or vertical scrollbars appear if the content is larger than the area
defined by the Dialog widget:

You can also modify the Dialog widget as shown below and select the Float on top property to create a palette for your Page:

Display Error
The Display Error widget allows you to display any errors returned by Wakanda on your Page for certain widgets, like the Grid, Auto Form, and
Text Input widgets.

Adding a Display Error
You add a Display Error widget to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or
drawing it to the size you want directly on the Designer Workspace. The Display Error’s ID is what you enter in the Display Error or Placeholder
for the error description fields on the Properties tab for certain widgets. By doing so, Wakanda will display in the defined Display Error widget
any errors that occur.
Properties tab

The Display Error widget has the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the “Naming Conventions” section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Events tab

This widget doesn’t have any events.
Skins tab

In the Skins tab, you can define the theme, CSS class, or widget skin for the widget. For more information, please refer to the “” paragraph in
the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

You can define the styles for a Display Error widget in the Styles tab:

The Display Error widget has the following styles: Text, Background, Border, Drop Shadow, and Size & Position.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Display Error
You can place the Display Error widget on the Designer Workspace to show any errors that may occur.

File Upload
The File Upload widget allows you to asynchronously upload one or more files from your Page to the web server (in your project's Data folder) as
a file (which can be of any type) or to Wakanda’s datastore in an attribute of type Image or BLOB. In the latter case, the file must be of type
PNG, JPG, BMP, TIFF, FLE, JIF, RLE, DIB, GIF, EMF, SVG, or PDF.
Important Note: The browser requirements for the File Upload widget are the same as those for Wakanda except for IE, which is IE10.
Adding a File Upload
You add a File Upload widget to your Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or
drawing it to the size you want directly on the Designer Workspace. You can assign a datasource (either an attribute of type Image to save it in
the datastore or an attribute of type Text to store the path of the file uploaded) by dragging and dropping it on top of the widget.
On the Page, it appears as shown below:

This widget is made up of multiple widgets:
Label widget
Cancel button
Number of files button
Upload button
Open File dialog button
File list (or popup)
Properties tab

File Upload widgets have the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of a datasource, like a Text or Image attribute. You can either enter the name of the datasource or assign it automatically
by dragging and dropping the datasource onto the widget.
Label: The label for the File Upload widget.
Text: The text inside the File Upload widget area where the buttons are located.
Display notification: Defines if the display notification will be displayed after a file is uploaded (see the “Publishing a File Upload Widget”
section below).
Display file list as: The file list will be displayed as either a Popup or List.
Maximum files: Number of maximum files to upload at one time. By default, the maximum number of files is set to "unlimited".
Maximum size: Maximum size of the file(s) to upload specified in bytes, KB, or MB. By default, the maximum file size is "unlimited".
Folder: The folder in which the files will be uploaded, which is relative to your project's data folder.

In case of conflict: When saving the physical file in a folder, you can specify whether to ask the user, replace the file, or rename the file if
there is a conflict.
Auto upload: This checkbox allows you to automatically upload the file without having to click on the upload button.
Note: The Maximum files and Maximum size properties can set for all instances of the File Upload widget in the .
When you define a datasource, the following parameter is added:
Save as binary object: When you specify a datasource, you can decide whether to save the file in a folder or as a binary object to be
stored in the datastore. When saving as a binary object, you can use attributes of type BLOB or Image. Remember that if you save as a
binary object, only one file can be selected at a time.
If you select the Save as binary object parameter, the Folder and In case of conflict properties are removed. The following property appears:
Temporary folder: When you decide to save the file as a binary object, you can define the name of the temporary folder into which the
file will be loaded into before being saved to the datastore.
Allowed file types

In the Services section of the Project Settings , you define which file types the File Upload widget accepts. If you specify ".*" as the file type, all
types of files are allowed. Otherwise, specify each extension delimited by a semi‐colon, e.g., "png;jpg;gif".

If a user tries to upload a file type that is not allowed, an alert appears.
Events tab

You can write JavaScript code for any of the following focus and mouse events that occur for a File Upload widget:
On After Upload: After a file is uploaded, this event occurs.
On File Exists: If one or more file exists, this event occurs.
For more information about how to add, modify, and delete events, please refer to the “Events” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

The styles proposed for a File Upload can be found on the Styles tab:

You can modify the styles for the widget’s following elements: Container and Label (if one has been specified for the widget).

Container: You can modify its Text, Text Shadow, Background, Border, Drop Shadow, Inner Shadow, and Size & Position settings for its
three states (Default, Hover, and Active).
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a File Upload Widget
When you publish a File Upload widget on your Page, it appears as shown below:

Below is the definition of each of the areas of the File Upload widget:

You define the text displayed in the File Upload widget area in the Properties tab.
To choose a file to upload, click on the

button. Once you have done so, the widget appears as follows depending on if you have defined

that the file list is displayed as a list or a popup:

If you have chosen to display the File list as a popup, the list will appear only if you hover the Number of files button:

To remove the chosen file, click the
icon in the main area. If you have multiple files in the list, click the
icon next to the file when you
hover it. If you have customized the File Upload to display the file list as a popup, you can also click the
icon next to the file.

Only if you have not defined a datasource can you upload multiple files at one time since they are saved into a folder and not the datastore:

If you have not selected the Auto upload property, you must click on the

button to upload the file(s) selected.

Once a file is uploaded, the following message appears for a few seconds to notify if you have selected the Display notification property:

If there is a conflict (meaning that the file you are uploading already exists) and you have selected "Ask the user" in the In case of conflict
property. The following error message appears:

Frame
The Frame widget allows you to have an inline frame in which you can display an HTML page, a URL, or a PDF (as long as the browser can display
the PDF in an iFrame).

Adding a Frame
You add a Frame widget to the Page by first selecting the widget from the Widgets area and then by dragging and dropping it in an empty space
on the Designer Workspace, double‐clicking on it in the Widgets area, or drawing it to the size you want directly on the Designer Workspace.

Properties tab

The properties for a Frame are as follows:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of a datasource containing either a path to the PDF or HTML file (with the correct relative path) or a URL. You can either
enter the name of the datasource or assign it automatically by dragging and dropping the datasource onto the widget.
Label: The label for the Frame widget.
Source page: Either a URL or an HTML page or PDF file in the project’s WebFolder. For the URL, you must enter the entire URL, i.e.,
“http://www.wakanda.org”. For an HTML page, you write it as “/include.html” and for a PDF, you write “/pdf/Final_Document.pdf”. Both
paths are relative to the WebFolder. You can either drag and drop the HTML or PDF file onto the Source Page property or directly onto the

widget itself.
Events tab

You can write JavaScript code for the On Load event that occurs when the Source Page or Source is loaded into the Frame widget.
For more information about how to add, modify, and delete events, please refer to the “Events” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Frame widget can be found on the Styles tab.

You can modify the styles for the widget’s following elements: Container and Label.
Container: You can modify the container’s Background, Border, and Size & Position.
Label: You can modify the following settings for the Frame’s label: Label Text, Label Text Shadow, and Label Size & Position.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Frame
The Frame appears differently depending on the Source page or Source that you have specified. Below is an HTML page and the second example
is a PDF file. The vertical and horizontal scrollbars appear automatically depending on the browser and if the HTML page included has more
widgets on it that can be viewed.

Note: The features available for a PDF differ depending on the browser you use to view the Page.

Google Maps
The Google Maps widget allows you to create a map (either dynamic or static) with either a full address or with specific latitude and longitude
coordinates.
If you choose to use this widget in Dynamic mode, it appears as shown below:

Otherwise, you can use it in Static mode and it appears as follows:

Adding a Google Maps widget
You add a Google Maps widget to the Page by dragging and dropping the widget in an empty space on the Designer Workspace, double‐clicking on
it, or drawing it to the size you want directly on the Designer Workspace.
The Google Maps widget appears as shown below on the Designer Workspace:

If you drag and drop a datasource (an attribute in your datastore class) on top of the Google Maps widget, the following dialog appears in which
you can define for which property to use the datasource.

Properties tab

The Google Maps widget has the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,

digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the attribute datasource containing a full address or a location's longitude/latitude coordinates. An address can be either
a string expressed as “Empire State Building, New York, NY” or “Empire+State+Building,New+York,NY” or its latitude/longitude value.
Note: Latitudes and longitudes are defined using numerals in a comma‐separated text string that have a precision to 6 decimal places,
e.g., "40.747840,‐73.985463".
Label: Label of the widget.
Type: Select one of the proposed types: Hybrid, Roadmap, Satellite, or Terrain.
Zoom: A value between 1 and 20; however, you can indicate a higher zoom depending on the map type and images provided by Google.
The larger the value, the higher the zoom.
Language: Select the language to use for the map.
Google Map Types

Here are examples of the four types of Google Maps:
Hybrid
Roadmap
Satellite
Terrain
Hybrid
The hybrid map type displays a mixture of normal and satellite views.

Roadmap
This type displays the road map view.

Satellite
The satellite map type displays Google Earth satellite images.

Terrain
The terrain map type displays a physical map based on terrain information.

Static mode

Google Maps in static mode has the following property:
Location: If you do not define a datasource, you can enter an address or a location’s latitude and longitude coordinates.
Note: Latitudes and longitudes are defined using numerals in a comma‐separated text string that have a precision to 6 decimal places,
e.g., "40.747840,‐73.985463".
The address in the form of a string can either be expressed as “Empire State Building, New York, NY” or
“Empire+State+Building,New+York,+NY.”
The static mode for this widget has a Marker section with the following properties:
Color: Define a color for the marker.
Size: Define a size for the marker (tiny, mid, or small).
Label: The marker's label, which can be blank, a letter, or a number.
Dynamic mode

In the Dynamic mode, the widget has the following properties:
Error ID: The Text, Container, or Display Error widget ID in which the error will be displayed.
Google key: The Google key that will allow you to use the API in your Web application.
Auto display bubble: Display the information bubble automatically. Otherwise, you have to click on the marker to see the bubble.
Controls section has the following properties:
Display street view: Display or hide the street view option.
Display zoom: Display or hide the zoom control.
Display pan: Display or hide the pan control.
Display scale: Display or hide the scale control.
Marker section has the following properties:
Tooltip: Name of the attribute (which is in the same datastore class as Source) to display in a tooltip.
Selected icon: Icon for the marker of the selected property.

Icon: Icon for the markers of all the other properties defined on the map (excluding the selected one).
Number of markers: The maximum number of markers to display on the map.
Google Maps Key

To use this widget, you have to include the Google Key. You will see the following alert if you try to publish your page without entering it:

To obtain the Google key, you can go to this page: https://developers.google.com/maps/documentation/javascript/tutorial#Obtaining_Key.
Bubble Information

This section allows you to display attributes with or without a line break in the bubble that appears when you click on the marker.
To define the information in the bubble, you can do so with the following properties:
Attribute: The attribute to display. If you'd like to add HTML tags, you must place the attribute name in the <%%> tags. Therefore, if you
have a companyName attribute and want to add HTML tags, you can write <h3><%companyName%></h3> or <b><%companyName%></b>.
Line break: You can add a line break after each attribute.
By default, the first ten attributes for your datastore class will be created for you automatically; however, you can add as many attributes as
you'd like.

Events tab

You can execute code during the following mouse events for a Google Maps widget:
On Click: When the widget is clicked.
On Double Click: When the widget is double‐clicked.
On Mouse Over: If the user places the mouse over the widget.
On Marker Click: When the user clicks on the marker. (dynamic map only)
On Marker Double Click: When the user double‐clicks on the marker. (dynamic map only)
On Marker Over: If the user places the mouse over the marker. (dynamic map only)
The following Touch events are available:
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Google Maps widget can be found on the Styles tab.

The Google Maps widget has two elements: Container and Label (if you have defined a label for the widget).
Container: You can modify the following styles: Border, Drop Shadow, and Size & Position.
Label: You can modify the following styles: Label Text, Label Text Shadow, and Label Size & Position.
Note: The Constraints in the Size & Position section cannot be set for a Google Maps widget that is in Static mode.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.

Grid
The Grid widget gives you an efficient way to present the data from a datasource, complete with column sorting, ability to add and delete rows
of data, resizable columns, total number of entities in the entity collection displayed at the bottom, and tabbable data entry.

Adding a Grid

Besides the standard ways of adding a widget to the Page, you can use one of the following two methods to add a Grid to your Page:
Drag and drop (or draw) the Grid widget onto an empty space in the Designer Workspace.
Drag and drop a datastore class or one or more attribute(s) in the same datastore class from the Model or Datasources area onto an empty
area in the Designer Workspace and select Grid from the Auto Generated Widgets dialog.
Drag and drop (or Draw) a Grid: If you drag and drop, or draw, a Grid widget in the Designer Workspace, an empty Grid is created:

Dragging a datasource and dropping it onto the Grid automatically adds all the attributes that can be displayed in columns. If you drag a
datastore class from the model, a datasource with the same name as the datastore class is created. However, if it already exists, the datasource
with the same name as the datastore class will be used.

Otherwise, you can enter the name of an existing datasource in the Source field of the Properties tab. The Source field has an auto‐complete
feature, which displays a list of datasources in your Page corresponding to the letter(s) you type. If the datasource whose name you entered
doesn’t exist, an array datasource will be created automatically with that name.

All the attributes whose data can be displayed in columns are added automatically to the Grid. To delete an attribute from the grid, click on the
icon that appears to the right of the attribute name when you hover over it in the Columns area:

The Label defines the header of the column to display for the attribute defined in the Attribute column, which is the name of the datasource
attribute.
Drag and drop an a datastore class (from Model tab) or datasource (from Datasources tab): If you drag and drop a datasource—a datastore class
or selected attribute(s) from the same datastore class—to an empty space on the Designer Workspace, the Auto Generated Widgets dialog
appears. To select multiple attributes from the same datastore class before opening the Auto Generated Widgets dialog, Ctrl‐click (Windows) or
Command‐click (Macintosh) each attribute before dragging and dropping them to an empty space in the Designer Workspace.

In the Auto Generated Widgets dialog, select the Grid radio button at the top, choose which attributes to include, and edit their labels (which
will be the column headers).
From the Auto Generated Widgets dialog, you can add another attribute by clicking on the
icon at the top. A new attribute is automatically
added at the end of the list, which you can modify by selecting an attribute from the Attribute drop‐down menu and by entering another label
for it.
To change the order of the attributes, drag the
from the Grid, click on the

icon next to the attribute above or below the other attributes. To delete an attribute

icon that appears to the right of the attribute when you hover over it.

By default, the maximum number of columns to display and create is 8. If you want to change this default value, refer to [#title id="3851"
anchor="1026345"/].
Properties tab

The Grid widget has the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be passed to JavaScript routines, such as
getElementById. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions
section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the datasource. You can either enter the name of an existing datasource or assign it automatically by dragging and
dropping the datasource onto the widget. If the datasource whose name you entered doesn’t exist, an array datasource will be created
automatically.
Label: Title displayed outside of the Grid. By default, it appears on top, but you can position it in the Styles tab. This property can be left
empty to display the Grid without a title.
Draggable: Selecting this checkbox allows your Grid to be draggable on the page when it is published.
Resizable: Allow your users to resize the Grid when it is published to the Web.
Read only: Defines if the Grid is in read only mode. If you select this checkbox, the
and the
buttons, which allow you to add and
remove attributes from the Grid, in the footer are removed.
Hide header: Specify if you want to hide the Grid’s header or not during runtime.
Hide footer: Specify if you want to hide the Grid’s footer or not during runtime.
Selection mode: Choose between Single (default) selection mode and Multiple. To select multiple rows, you can hold down the Shift key
for a continuous selection or Command (Macintosh)/Ctrl (Windows) key for a discontinuous selection.
Footer count text: The text that appears next to the number of items being displayed in the Grid widget.
Error Handling

In this section, you can define how errors are handled for the Grid:
Display errors: By selecting this option, you signal to Wakanda that you want to display any error that occurs either in Wakanda's
automatic error display window or in the widget whose ID you specify in the following property.
Error ID: The Text, Container, or Display Error widget ID in which the error will be displayed.

Note: For more information, please refer to the “Error ID Property” section in the “Widget Properties” chapter.
Columns Area

In the Columns area, you can add, modify, and delete attributes in the Grid as well as define a display format and width for each column in the
Format and Width fields that appear when you click on a column:

For an attribute of type Boolean, you can display it either as a checkbox or as two radio buttons. To display it as two radio buttons, you can
enter the following:

If you enter two values separated by a semicolon, as shown below, the value displayed will be two radio buttons:

Otherwise, it will appear as only a checkbox. If you enter a text in the Format property, it will be shown next to the checkbox:

Note: For more information on display formats, please refer to the “Format Property” paragraph in the “Widget Properties” section.
The Read only option allows you to make a column read only, which means that you cannot enter data into that column.
To change the order of the columns, drag the

icon above or below one of the other columns listed.

Once the Grid is on your Page, you can also modify the width of the columns manually per column as shown below:

Note: You cannot include a relation attribute directly in the Grid; however, you can include a dynamic alias attribute by including the attribute
as “{Relation Attribute}.{Attribute from other Datastore Class}”. In our example, for the “Employer” column we have inserted
“employer.name” where “employer” is the relation attribute in the “Employee” datastore class and “name” is an attribute in the “Company”
datastore class.
Events tab

In the Events tab, you can customize the following events for the Grid:
On Cell Click: When the user clicks on a cell in the Grid.
On Error Handler: When an error occurs during data entry in the Grid.
On Header Click: When the user clicks on the header of the Grid
On Row Click: When the user clicks on a row in the Grid.
On Row Double Click: When the user double‐clicks on a row in the Grid.
On Row Draw: When a row in the Grid is drawn.
On Row Right Click: When the user right clicks on a row in the Grid.
For more information about how to add, modify, and delete events, please refer to the “Events” paragraph in the “Widget Properties” section.
On Cell Click

For the On Cell Click event, you can retrieve the cell’s value in event.data.cell.value. Here is an example of how to retrieve the cell’s value in
the event:

dataGrid1.onCellClick = function dataGrid1_onCellClick (event)
{
alert("The following value is in this cell: "+event.data.cell.value);
};
On Row Draw

For the On Row Draw event, you can retrieve the value in the cell from event.row.cells[n].value where n is the column number, which begins at
0. To get the cell’s value in the second column, you’d write event.row.cells[1].value.
Skins tab

In the Skins tab, you can define the theme, CSS class, or widget skin for the widget. For more information, please refer to the “” paragraph in
the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

The Styles tab allows you to set the styles of the entire widget as well as its components: header, header / cell, body, row, row / even, row /
odd, cell, and footer as well as the header and body of the individual columns per attribute. You can select the widget or its components in the
pop‐up menu at the top:

Note: The styles selected for the different sections of the widget override the styles chosen for the widget.
You can modify the Grid widget’s following elements: container, cells, header, header / cells, rows / even, rows / odd, rows, body, label, footer,
and label as well as the header and body columns for the attributes.
Container: For the container, you can modify its Text, Background, Border, Drop Shadow, and Size & Position.
Cells: For the cells of the Grid, you can modify: Text, Text Shadow, Background, and Border.
Header: For the header of the Grid, you can modify: Text, Text Shadow, Background, and Border.
Header/Cells: For the header/cells of the Grid, you can modify: Text, Text Shadow, Background, and Border.
Rows/Even: For the focus state, you can modify: Text, Text Shadow, Background, and Border.
Rows/Odd: For the focus state, you can modify: Text, Text Shadow, Background, and Border.
Rows: For the rows of the Grid, you can modify the following styles for the default, hover, active, and selected states: Text, Text
Shadow, Background, and Border.
Body: For the body, you can modify: Text, Text Shadow, Background, and Border.
Footer: For the footer, you can modify: Text, Text Shadow, Background, and Border.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Header columns: For the header columns of each attribute, you can modify: Text and Background.
Body columns: For the header columns of each attribute, you can modify: Text and Background.
Note: You can also select a to affect the header and footer for all the Grids on the same Page.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.

Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Grid
Many automatic features are available when you publish your Grid:
Column sorting: Clicking on the arrow in the column header allows you to sort the data in that column in ascending or descending order
depending on the arrow.
Add: Using the
button at the bottom of the Grid allows you to add a new row (a new datastore entity) to your Grid.This button can be
hidden if you select the Read only property for the Grid.
Delete: The
button allows you to delete the currently selected datastore entity.This button can be hidden if you select the Read only
property for the Grid.
Count total: The number at the bottom of the Grid represents the number of entities or elements (depending on the datasource)
displayed.
Resizing columns: Users can resize the columns in the Grid.
Tabbable data entry: Users can tab to the next cell or Shift‐tab to the previous cell of a Grid. Data is saved automatically when you tab
out of the field.
Draggable: When this option is selected in the Properties tab, users can drag the Grid along with its title (if defined) anywhere on the
page.
Resizable: If you select this option in the Properties tab, you allow users to resize the Grid.
Multiple or Single Selection: If you have selected Multiple from the Selection Mode property, you can select multiple rows by holding
down the Shift key for a continuous selection or Command (Macintosh)/Ctrl (Windows) key for a discontinuous selection.
For attributes of type Date, a button appears to the right allowing you to display the datepicker and select a date:

If you modify the Footer count text, it will appear in place of the standard text:

Icon

The Icon widget allows you to add an icon to your Page. This widget is also included in the Image Button widget.
Adding an Icon
To add an Icon widget to the Page, select the widget from the Widgets area and either drag and drop it in an empty space on the Designer
Workspace, double‐click on it in the Widgets area, or draw it to the size you want directly on the Designer Workspace.
Properties tab

The properties for the Icon widget are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be passed to JavaScript routines, such as
getElementById. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions
section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Label: The label associated to the Icon widget that is displayed if you enter a text value in this field.
Draggable: Selecting this checkbox allows for your Icon widget to be draggable on the page.
Events tab

An Icon widget has the following events:
On Click: When the Icon widget is clicked.
On Double Click: When the Icon widget is double‐clicked.
On Mouse Down: If the user holds the mouse down on the Icon widget.
On Mouse Out: Once the user is no longer hovering over the Icon widget.
On Mouse Over: If the user places the mouse over the Icon widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Icon widget.
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the Events paragraph in the Widget Properties section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for an Icon widget can be found on the Styles tab:

You can modify the styles for the widget’s following elements: Container and Label.

Container: You can modify the container’s Image, Background, Border, and Drop Shadow for the four states (default, hover, active, and
disabled) and Size & Position only for the default state.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Image

For more information about the Image section, please refer to the Image paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.

Publishing an Icon Widget
Publishing an Icon widget on the Web is exactly as it is shown on the Designer Workspace based on the states.

Image
The Image widget allows you to include an image either directly from your WebFolder or from an attribute to publish on your Page.
Adding an Image
To add an Image widget to the Page, select the widget from the Widgets area and either drag and drop it in an empty space on the Designer
Workspace, double‐click on it in the Widgets area, or draw it to the size you want directly on the Designer Workspace. To automatically add the
Image widget to your Page and define the reference (Src) at the same time, drag the image (located in your project’s WebFolder) directly onto
your Page.
You can also assign a datasource (an attribute in a datastore class) by dragging and dropping it on top of the widget.
If you drag and drop the image into Wakanda, the following message appears:

If you do not already have an “images” folder, it will be created and the following message will appear:

You can also include one of the images from the Media Library by dragging it and dropping it to an empty space on the workspace, which not only
copies the image to your “images” folder, but also creates the Image widget.
Properties tab

The properties for an Image are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be passed to JavaScript routines, such as
getElementById. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions
section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the datasource. You can either enter the name of an existing datasource or assign it automatically by dragging and
dropping the datasource onto the widget. If the datasource doesn’t exist, a Variable datasource will be created automatically with the
name entered.
Image URL: In this field, you can set the path to an image in your WebFolder by selecting a file after you click on the
icon. You can
also drag and drop the image (located in your project’s WebFolder from the Solution Explorer) onto the image. If you drag and drop an
image from your computer or from the Media Library, it will be copied into a folder named “images” located in your WebFolder. If the
“images” folder doesn’t exist, Wakanda will create it automatically. To remove the image referenced, click on the
icon.
URL: Defines the URL to go to when included. You can include any type of link into the Link field, e.g., a URL
(“http://www.wakanda.org/”), an email address (“mailto:info@wakanda.org”), or a Page (“/employees/”).
Target: Select “_blank” to open the URL defined in the Link property in a new page or “_self” to remain on the same page.
Label: The label associated to the Image widget that is displayed if you enter a text value in this field.
Fit: This option resizes the image widget to the container (proportionately or not), to the width of the image, to the height of the image,

or the container is resized based on the image.
Events tab

An Image widget has the following events:
On Click: When the Image widget is clicked.
On Double Click: When the Image widget is double‐clicked.
On Mouse Down: If the user holds the mouse down on the Image widget.
On Mouse Move: If the user moves the mouse over the Image widget.
On Mouse Out: Once the user is no longer hovering over the Image widget.
On Mouse Over: If the user places the mouse over the Image widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Image widget.
On Touch Cancel: A touch on the widget has been interrupted.
On Touch End: When the user has removed a finger from the widget.
On Touch Move: When the user's finger moves over the widget.
On Touch Start: When the user places a finger (touches) the widget.
For more information about how to add, modify, and delete events, please refer to the “Events” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

The styles proposed for an Image widget can be found on the Styles tab:

You can modify the styles for the widget’s following elements: Container and Label.

Container: You can modify the container’s Background, Border, Drop Shadow, and Size & Position.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing an Image Widget
Publishing an Image on the Web is exactly as it is shown on the Designer Workspace. If a datasource is defined, the image will change depending
on its value.

Image Button
The Image Button widget allows you to create buttons with images on your Pages. These buttons can have either links to a URL or Page in your
project, automatic actions to be performed on datasources, or your own JavaScript code.

Adding an Image Button
You add an Image Button to the Page by dragging and dropping it onto an empty space on the Designer Workspace, double‐clicking on it, or
drawing it to a specific size directly on the Page.
You can assign a datasource to it and select one of the automatic actions like save, next, and previous) by dragging and dropping it on top of the
widget. If you enter a datasource name that doesn’t exist, a Variable datasource will be created automatically with the same name.
The newly created Image Button widget appears on your Page:

The Image Button widget contains an Icon widget, which allows you to define the image and text to include.
Below are the details for the Image Button widget. To modify the Icon widget, click on either the image or the text inside the Image Button.
Properties tab

Image Buttons have the following properties depending on the type of Image Button you’d like to create. By default, the properties for the
Image Button widget are shown in the first screenshot. If you include a link for the Image Button widget, the properties in the second
screenshot are available. If you define a source for the Image Button widget, the properties in the last screenshot are available.

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of a datasource to be used with automatic events like create, save, next, previous, last and first. You can either enter the
name of the datasource or assign it automatically by dragging and dropping the datasource onto the widget.
Action: Automated functions for the Image Button, such as: Create, Simple, Save, Next, Previous, Last, First, and Remove. Select
“Simple” when you want to write your own code. If you select an action, its name will be inserted by default as the label for the widget.
This property only appears if you have specified a Source.
Text: The title of the Image Button, which is also the Label property for the Icon widget included in the Image Button widget. If you
select an automatic action for the Image Button, the name of that action will be used as the Image Button’s title (if no text was
previously entered in this field). You can still edit the value in this property.
Link: Defines the URL to go to when included. You can include any type of link into the Link property, e.g., a URL
(“http://www.wakanda.org/”), an email address (“mailto:info@wakanda.org”), or a Page (“/employees/”).
Target: Select “_blank” to open the URL defined in the Link property in a new page or “_self” to remain on the same page.
Tabindex: Defines the tab order of the widget on the Page. When tabbing, you begin with the object with the lowest Tabindex and go to
the highest.
Events tab

You can write JavaScript code for any of the following mouse events that occur for an Image Button:
On Click: The user clicks on the Image Button.
On Double Click: The user double‐clicks the Image Button.
On Mouse Down: The user holds down the mouse button on the Image Button.
On Mouse Out: The user is no longer hovering over the cursor over the Image Button.
On Mouse Over: The user places the mouse cursor over the Image Button.
On Mouse Up: The user releases the mouse button after clicking on the Image Button.
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you

just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

You can customize the look of each Image Button by making changes in the Styles tab for its following four states: Default, Hover, Active,
Focus, and Disabled.

Default: The default state of the Image Button widget. You can modify its Background, Border, Drop Shadow, Inner Shadow, and Size &
Position.
Hover: For the hover state, you can modify: Background, Border, Drop Shadow, and Inner Shadow.
Active: For the active state, you can modify: Background, Border, Drop Shadow, and Inner Shadow.
Focus: For the focus state, you can modify: Background, Border, Drop Shadow, and Inner Shadow.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing an Image Button
The Image Button widget appears as it does on the Designer Workspace; however, its behavior is dependent on the actions you selected or
defined in the Events and Properties tabs for it.

List View
The List View widget allows you to create a list view with a predefined set of widgets for a datastore class datasource in a mobile environment.
Normally, you add the List View widget inside a Navigation View widget so that you can go to a next view using the List View widget.
Below you can see the different areas that the List View allows you to customize:

Adding a List View
You add a List View to your Page (only available for Smartphone and Tablet pages) by dragging and dropping it in an empty space on the Page,
double‐clicking on it in the Widgets area, or drawing it to the size you want directly on the Page.

If you drop either a datastore class or relation attribute datasource onto the widget, it will be automatically set up for you with the widgets and
their datasources selected by default as shown below:

The different widgets for each property have certain properties that are not available. Below is the list of properties and the types of widgets
they use:
Side image: An Image widget without the Target and Label properties.

Main text: A Text widget without the Auto‐resize and Scrollbar properties.
Second text: A Text widget without the Auto‐resize and Scrollbar properties.
Numerical value: A Text widget without the Auto‐resize and Scrollbar properties.
Next button: A Button widget without the Source, Button title, and Tabindex properties.
Properties tab

The properties for a List View widget are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the datastore class datasource. Once you enter one, a set of attributes are used to define the different sources for the
widgets that this widget automatically creates.
Label: The label of the List View widget.
Inset with label: If checked, the label will be displayed and the widget will be inset.
Side image: Display the side image (by default, an attribute of type Image will be assigned as its source).
Numerical value: Display a numerical value in the blue circle (by default, an attribute of type Number will be assigned as its source).
Second text: Display another text value below the main Text widget (by default, an attribute of type String will be assigned as its source).
Next button: Display a Button widget to navigate to another page or view in another widget, like the Navigation View widget.
Events tab

You can write JavaScript code for any of the following events that occur for a List View:
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

You can customize the appearance of this widget, its range, and its handle by modifying the parameters in the Styles tab:

You can modify the styles for the widget’s following elements: Container and Label.
Container: You can modify the Border and Size & Position of the widget’s container.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a List View
The way this widget appears in the GUI Designer is how it will appear when you publish it.

Login Dialog
With the Login Dialog widget, you can allow a user to enter his/her username and password to log into your Wakanda application.

Afterwards, the user can see that he/she has logged in successfully and can also log out.

Adding a Login Dialog
You add a Login Dialog to the Page by selecting the widget from the Widgets area and then either drag and drop it in an empty space on the
Designer Workspace, double‐click on it in the Widgets area, or draw it to the size you want directly on the Designer Workspace.

Properties tab

The properties for a Login Dialog are as follows:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
User label: Label for the User field in the Login dialog that appears when the user clicks in the Login dialog.
Password label: Label for the Password field in the Login dialog that appears when the user clicks in the Login dialog.
Login button: Label for the Login button in the Login dialog.
Login dialog title: Label for the title of the Login dialog.
Current user display: The message that appears after a user has logged in successfully. The user’s full name will be added to the end of
the message inserted here.
Not logged in display: The message that is displayed before the user logs in.
Login text: Label for the link that opens the Login dialog.
Logout text: Label for the link that allows the user to log out.
Events tab

You can execute code during the following events for a Login Dialog widget:
On Login: When the Login button in the dialog has been clicked (an attempt to login was made).
On Logout: When the user logs out by clicking the Logout link.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Container widget can be found on the Styles tab:

The Login Dialog widget has four styles: Text, Background, Border, Drop Shadow, Inner Shadow, and Size & Position.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Login Dialog Widget
When you publish the Login Dialog widget on your Page, it appears as shown below:

Click the Login link to display the Login Dialog:

Enter a username and password and either hit the Return key or click on the Login button. You will be logged in and your name will be displayed
along with the Logout link.

Matrix
The Matrix widget allows you to place one or more widgets inside of it. They are automatically duplicated in the space allocated for the Matrix
created on your Page. Each widget, like in the case of a form, displays a datastore entity in the entity collection that goes from left to right and
from top to bottom in the Matrix.

Adding a Matrix
To add a Matrix to your Page, select the widget from the Widgets area and either drag and drop it onto the Designer Workspace, double‐click on
it in the Widgets area, or draw it to the size you want directly on the Designer Workspace. A Matrix accepts only widgets of type Button,
Checkbox, Text, Slider, Text Input, and Container. You can link events to any of the widgets included in the Matrix, and they will be valid for the
current entity in the Matrix, if your datasource is a datastore class.
To include a widget in the matrix, you have to drag it into the Matrix as shown below in our example with a form:

Once you do so, the Matrix decides how many forms it can fit inside of it and duplicates the form as shown in the first screenshot.
If you resize the Matrix, the number of widgets duplicated inside of it will be modified. The larger the Matrix is, the more widgets will fit inside
of it, and the smaller it is, the fewer number of widgets will fit. The number of widgets inside the Matrix depends also on the Margin and the
Auto Fit properties.
Note: If you delete a Matrix that contains another widget, it will also be deleted.
Properties tab

The properties for a Matrix are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be passed to JavaScript routines, such as
getElementById. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions
section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Margin: Define the margin around each widget in the Matrix (as if each instance were a cell in a table).
Auto fit: This option resizes the Matrix according to its contents so that the widget(s) included can be duplicated in its entirety.
Scrolling: You can define how the widget inside the Matrix is scrolling: vertically or horizontally.
Scrollbar: Defines whether the scrollbar for a Matrix is displayed or not. If it’s not displayed, you can use the Matrix’s functions to navigate
through the pages of the Matrix.
Draggable: Selecting this checkbox allows for your Matrix to be draggable on the page.
Resizable: This option, when checked, allows your users to resize the Matrix.
Events tab

You can execute code during the following mouse events for a Matrix widget:
On Click: When the Matrix widget is clicked.
On Double Click: When the Matrix widget is double‐clicked.
On Mouse Down: If the user holds the mouse down on the Matrix widget.
On Mouse Out: Once the user is no longer hovering over the Matrix widget.
On Mouse Over: If the user places the mouse over the Matrix widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Matrix widget.
The Matrix widget has one specific event for the child elements:
On Draw: This event occurs for each element (e.g., a widget bound to a datasource) displayed plus the next two that are temporarily
hidden from view.
The Matrix widget also has resize events that are triggered when the Matrix widget has been set to be resizable:
On Start Resize: This event is called when you begin resizing the Matrix widget.
On Resize: This event occurs while you resize the Matrix widget.
On Stop Resize: After you’ve stopped resizing the Matrix widget.
For more information about how to add, modify, and delete events, refer to the “Events” paragraph in the “Widget Properties” section.
For more information about the event object for each of the above events, refer to "Matrix's event object" in the "Widgets v1 Instance API"
manual.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Matrix widget can be found on the Styles tab:

You can modify the following styles for a Matrix widget: Background, Border, Drop Shadow, Inner Shadow, and Size & Position.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Matrix
When you publish the Matrix on the Web, it appears as it does in the workspace. In the case of a form in the Matrix, each form in the Matrix
shows a datastore entity from the entity collection:

Below is the same entity collection in a Grid to show the order of the entities displayed above in the Matrix:

Menu Bar
The Menu Bar widget allows you to display a menu bar with multiple menu items (as well as hierarchical menu items attached to the menu
items) on your Pages:

Adding a Menu Bar
You add a Menu Bar widget to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or
drawing it to the size you want directly on the Designer Workspace.
When you create a new Menu Bar, it is made up of two distinct widgets:
Menu Bar: The actual menu bar itself.
Menu Item: One widget per menu item in the Menu Bar widget.
You can create a hierarchical menu by adding multiple menu items to either the Menu Bar or the Menu Item widget.
Properties tab

Menu Bar widget has the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.

You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Display: Menu bars can be displayed horizontally (by default) or vertically. Choose “Horizontal” or “Vertical” from this dropdown menu.
Show submenus: If you have defined submenus for your Menu Bar, you can select “on mouse over” to show them when the user hovers
over the menu bar item or “on mouse click” to show them when the user clicks on the menu bar item.
Menu items margin: The left indentation for all menu items except the first one.
Menu Items

In the Menu Items section of the Properties tab, you can add menu items to your Menu Bar widget by clicking on the
icon. You can also add
menu items to a Menu Item (i.e., submenu items) by going to the Properties tab for the Menu Item widget and clicking the
icon in the
Menu items section.

You can also click on the

icon, which is located at the end of the Menu Bar widget, to create new menu items:

To edit the menu item, either click the

icon or double‐click the menu item in the Menu Bar widget.

To change the order of the menu items, drag the
To delete a menu item, click on the

icon above or below the other menu items listed.

icon that appears when you hover over the menu item.You must always have at least one menu item in

a menu bar; you cannot delete all the menu items in a Menu Bar.
Events tab

You can execute code during the following focus and mouse events for the Menu Bar widget:
On Click: Once the Menu Bar widget has been clicked.
On Mouse Down: If the user holds the mouse down on the Menu Bar widget.
On Mouse Out: Once the user is no longer hovering over the Menu Bar widget.
On Mouse Over: If the user places the mouse over the Menu Bar widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Menu Bar widget.
The following Touch events are available:
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the Events paragraph in the Widget Properties section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Menu Bar widget can be found on the Styles tab:

If you want to modify the styles for the actual menu bar, select Container from the Apply styles to popup. In this case, you can modify the
following styles for the menu bar: Background, Border, Drop Shadow, and Size & Position.
In our example below, we modified the background of the Menu Bar:

You can select one of the options from the Apply styles to popup to modify the styles for the menu items. These menu items are separated into
three categories:
All menu items: all the menu items, all the first menu items, or all the last menu items for the main menu and its submenus.
Main menu items: all the menu items, only the first menu item or only the last menu item for the main menu.
Submenu items: all the submenu items, all the first submenu items, and all the last submenu items.
For each of these categories, you can define the Text, Text Shadow, Background, Border, Drop Shadow, Inner Shadow, and Size & Position
styles for the default, hover, active, selected, and disabled actions. The selected action is only visible when you choose On Mouse Click from
the Show Submenus property in the Menu Bar widget’s properties.
The styles for the menu items are described below.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Adding a Menu Item
You add a Menu Item widget in the Menu Items area as described above in Menu Items. You can add a hierarchical menu by adding multiple menu
items to the Menu Bar or Menu Item widget.
Properties tab

Menu Item widget has the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.

You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Text: The text displayed in the Menu Item widget. You can also edit this directly on the Menu Bar widget by double‐clicking the text.
Icon URL: The icon to display with the Menu Item widget. You can add an image by clicking the
icon or dragging and dropping it onto
the Menu Item widget. The image selected will be copied into the “images” folder in your project’s WebFolder if it is not already located
there. If the “images” folder does not exist, it will be created automatically. You can also include an image from the Media Library.
Menu Items

In the Menu Items section of the Properties tab, you can add submenu items to your Menu Item widget by clicking on the
information, please refer to the above.

icon. For more

Events tab

You can execute code during the following focus and mouse events for the Menu Item widget:
On Click: Once the Menu Item widget has been clicked. In this event, you can also open another page in your project by writing
location.href = "index.html", for example.
On Mouse Down: If the user holds the mouse down on the Menu Item widget.
On Mouse Out: Once the user is no longer hovering over the Menu Item widget.
On Mouse Over: If the user places the mouse over the Menu Item widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Menu Item widget.
The following Touch events are available:
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the Events paragraph in the Widget Properties section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Menu Item widget can be found on the Styles tab:

A Menu Item is made up of the following subelements:
Container: For this element, which is the actual menu item, you can define the Text, Text Shadow, Background, Border, Drop Shadow,
Inner Shadow, and Size styles for the default, hover, active, selected, and disabled states.
Submenu bars: you can define the Background, Border, and Drop Shadow styles.
Submenu items: you can define the Text, Text Shadow, Background, Border, Drop Shadow, Inner Shadow, and Size styles for the default,
hover, active, selected, and disabled actions. The selected action is only visible when you choose On Mouse Click from the Show
Submenus property in the Menu Bar widget’s properties.

Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size

If the selected Menu Item’s parent Menu Bar widget is set to display horizontally, you can define its Width. If it is set to display vertically, you
can define its Height.

Navigation View
The Navigation View widget is available for Pages that you create for the Smartphone or Tablet. This widget allows you to have the multiple
views as shown below in the Grid widget on the left and then the detailed form created with other widgets on the right.

Adding a Navigation View Widget
To add a Navigation View to you Page, select the widget from the Widgets area and either drag and drop it onto the Designer Workspace, double‐
click on it in the Widgets area, or draw it to the size you want directly on the Designer Workspace. If you have selected a Page for Smartphone,
the Navigation View widget appears as shown below:

The Navigation View widget becomes set in the background so that you can select widgets that you place on top of it without ever selecting the
Navigation View widget.
Double‐click on the default “View 1” text to modify it. To modify the Back button, you just need to double‐click on it or modify its properties.
Properties tab

The properties for a Navigation View are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be passed to JavaScript routines, such as
getElementById. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions
section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Title: This internal value is only for your use. It will not be displayed anywhere on the Page.
Views

In this section, you create the views that you want for your Navigation View widget.
By default, one is created. You can define the view by inserting a text in the Description property, but this text will not be visible anywhere
else. The Index is an internal number that is displayed only. To add another view, click on the
icon.

To change the order of the views, drag the
To delete a view, click on the

icon above or below the other views listed. The Index property remains the same.

icon that appears when you hover over the view.

You can also select a particular view by going to the Outline of your Page and selecting it:

Events tab

You can execute code during the following mouse events for this widget:
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
On Touch Move: When the user's touch moves over the widget.
On Touch Start: When the user places a finger (touches) the widget.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Navigation View widget can be found on the Styles tab:

The Navigation View widget has the following elements:
Container: You can modify the container’s Text, Background, Border, and Size & Position.
Header: For the Navigation View widget’s header, you can modify the Text, Text Shadow, Background, and Border.
Content: You can modify the following settings for its content: Background.
Header: For the Navigation View widget’s footer, you can modify the Text, Text Shadow, Background, and Border.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Navigation View
When you publish the Navigation View widget to your Smartphone or Tablet, you must use its API to change views. The Back button appears
once you go to another view and will return you to the previous view.
The Back button at the top is active by default when you go to another view in the Navigation View widget.

Popover
The Popover widget can be attached to any Button or Image Button widget on your Page, which you create for either Tablet or Smartphone. It
allows you to display information in this widget as shown below:

Adding a Popover widget
You add a Popover widget to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or
drawing it to the size you want directly on the Designer Workspace.
Properties tab

The Popover widget has the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Show header: Show the header of the Popover widget in which you can add another widget, like a Text or Button widget. If you hide the
header after placing one or more widgets in this area, they will be deleted. You can retrieve them by undoing the action.
Show footer: Show the footer of the Popover widget in which you can add another widget, like a Text or Button widget. If you hide the
footer after placing one or more widgets in this area, they will be deleted. You can retrieve them by undoing the action.
Linked button ID: ID of the Button or Image Button widget to which this Popover widget is linked. A list of proposed Button and Image
Button widgets appears when you tab into this property.
The Popover widget has a Header and Footer that you can display by selecting the corresponding properties. In each of the areas, you can add
any widgets. The widgets you place there, like the Text widget in the header and the Button widget in the footer have styles that are applied to
them by default. The example at the top of this chapter shows the Popover widget without the header and footer. The example below shows

how the Popover widget will appear if you have selected to show them both:

Events tab

You can write JavaScript code for any of the following events that occur for a Popover widget:
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Popover widget can be found on the Styles tab:

You can modify the following styles for the Popover widget: Background, Border, and Size & Position.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Popover
The Popover widget appears where you have positioned it on the Page when a user clicks on the Button or Image Button widget defined in the
Linked button ID property. By default, when the user clicks on the same Button or Image Button widget, the Popover widget will be closed. You
can also use the hide( ) function on the Popover widget to hide it again if you prefer.

Progress Bar
The Progress Bar widget allows you to visually show the progression of a server‐side action.
Adding a Progress Bar
You add a Progress Bar to the Page by selecting the widget from the Widgets area either by dragging and dropping it in an empty space on the
Page, double‐clicking on it in the Widgets area, or drawing it to the size you want directly on the Page.

Properties tab

The properties for a Progress Bar are as follows:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Progress reference: A unique reference that you use in your JavaScript code. If you leave it blank, Wakanda will give a unique reference to
the Progress Bar each time it is called.
Show stop button: Displays a Stop button along with the Progress Bar widget, allowing the user to interrupt the progression. Refer to the
ProgressIndicator( ) to learn more about managing this event.
Hide if inactive: This option keeps the Progress Bar hidden until it is active.
Label: By default, the label is "Progress on {curValue} out of {maxValue}" to indicate the two placeholders for the current value and the
maximum value that will be displayed for the Progress Bar.
Events tab

This widget doesn’t have any events. For any events that you'd like to add to a widget that you are unable to add through the GUI Designer, you
can use the [#cmd id="700010"/] function.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Progress Bar widget can be found on the Styles tab. You can modify the style of the entire widget (including its label)
or the range.

Here is the Styles panel for the Progress Bar widget:

You can modify the styles for the widget’s following elements: Container, Range, and Label.

Container: You can modify the container’s Background, Border, Drop Shadow, and Size & Position.
Range: For the Progress Bar’s range, you can modify the Text and Background.
Label: You can modify the following settings for the Progress Bar's label: Label Text, Label Text Shadow, and Label Size & Position.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Progress Bar
The Progress Bar appears automatically to inform users of the progress of an action that is taking place on the server:

Query Form
The Query Form is an automated form that allows users to search the entity collection of your datasource by the selected attributes.

Adding a Query Form
To add a Query Form to your Page, you can drag and drop the Query Form widget onto an empty space in the Designer Workspace, double‐click
on it, or draw it to a specific size directly on the Designer Workspace. When you do so, an empty Query Form is created:

If you drag and drop a datastore class on top of it, all the attributes are added automatically to the Query Form. You can subsequently add or
remove attributes in the Properties tab. You can also select multiple attributes from the same datastore class by Ctrl‐clicking (Windows) or
Command‐clicking (Macintosh) each attribute before dragging and dropping them onto the Query Form.

To assign a datasource name to the Query Form, you can enter it in the Source field of the Properties tab. The Source field has an auto‐
complete feature, which displays the list of the datasources on your page corresponding to the first letters you typed.

A row for each of the attributes in your datasource appear automatically in the Rows area of the Properties tab:

You define the header of the attribute in the Query form, by specifying its Label. The Attribute field specifies the attribute in your datasource.
You can add a row by clicking the
icon at the top of the Rows area. A new row that you can modify is automatically added to the end of the
list. To delete a row, click on the

icon that appears to the right of the attribute when you hover over it.

To change the order of the rows, drag the

icon above or below one of the other rows.

Even after you have created the Query Form, you can modify the attributes (which ones to display and their order in the form) in the Rows area
of the Properties tab.
Properties tab

The Query Form widget has the following properties:
ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the datasource. You can either enter the name of the datasource or assign it automatically by dragging and dropping the
datasource onto the widget.
Show operators: Select this option to show the standard search operators in a dropdown list.
Draggable: Selecting this checkbox allows for your Query Form to be draggable on the page.
Resizable: To allow your users to resize the Query Form when it is published, check this checkbox.
Events tab

You can write JavaScript code for any of the following events that occur for a Query Form:
On Start Resize: This event is called when you begin resizing the Query Form.
On Resize: This event occurs while you resize the Query Form.
On Stop Resize: After you’ve stopped resizing the Query Form.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The Styles tab allows you to set the styles for the Query Form:

You can modify the styles for the widget’s following elements: Container, Header, Body, and Footer.
Container: You can modify the styles of this widget's container: Text, Background, Border, Drop Shadow, and Size & Position.
Header: For this element you can modify the following styles: Text, Text Shadow, Background, and Border.
Body: For this element you can modify the following styles: Text, Text Shadow, and Background.
Footer: You can modify the following styles for this element: Text, Text Shadow, and Background.
Note: You can also select a to affect the header and footer for all the Query Forms on the same Page.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Query Form
Many automatic features are available when you publish your Query Form:
Auto‐Complete: Once the user types in a few letters of a text field, a menu appears showing possible options for the query.

Operators: Depending on the type of your attribute, a pre‐defined list of operators is displayed to simplify the query process, such as
begins with, equals, not equals, greater than, greater than or equal to, less than, less than or equal to, contains, or contains keyword for
attributes of type String.
Clear: The
icon allows you to clear the values entered in your Query Form.

Find: By clicking on the magnifying glass icon, you can search your datasource by the criteria entered in the Query Form. The results can
be displayed in another widget with the same datasource. The first datastore entity found is shown in the Query Form.
Draggable: When this option is selected in the Properties tab, users can drag the Query Form anywhere on the page.
Resizable: If you select this option in the Properties tab, you allow users to resize the Query Form.
Entity collection number/total: In the lower right corner, the “0/0” will be updated after a query is performed to indicate the number of
entities found as well as the first one displayed directly in the Query Form.

Radio Button Group
The Radio Button Group widget allows you to create a set of one or more radio buttons to display on your Page.

Adding a Radio Button Group
You add a Radio Button Group widget to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on
it, or drawing it to the size you want directly on the Designer Workspace.
This widget can be used in two different ways: bound to a datasource (datastore class or array) or defined by a set of fixed values. You can assign
a datasource (an attribute in a datastore class) by dragging and dropping it on top of the widget. When you do so, the datasource name is
inserted automatically in the label field and its attributes are added to the Radio Button Group widget.
If you enlarge the widget on your Page, the radio buttons in the Radio Button Group widget will be distributed depending on its width and
height:

On a smartphone or tablet, the Radio Button Group widget appears as shown below:

Binding a Datasource to the Radio Button Group

In the Properties tab, you can define how to bind a datasource to the Radio Button Group widget. In our example, we have a datastore class
“department,” which we defined as the Choice Source. For the Value Source, we included an attribute in the “Employee” datastore. We
included “employee.department.” We selected “name” from the “Department” datastore class as the Key. To automatically update the
attribute in the datasource, we select the Auto Dispatch checkbox.

Defining the Values of a Radio Button Group

When you set the values for a Radio Button Group widget, you set its values in the Properties tab without entering anything in the Choice
source field:

In our example, we defined the Value source field so that the value is automatically inserted into the “company.city” attribute.
Properties tab

The Radio Button Group widget has the following properties by default (see screenshots above):
ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Choice source: Name of the datasource (datastore class or array). You can either enter the name of the datasource or assign it
automatically by dragging and dropping the datasource onto the widget.
Value source: Name of the attribute to receive the selected value of the widget. You can either enter the name of the datasource or
assign it automatically by dragging and dropping the datasource onto the widget.
Display: Display the radio buttons in a list (vertical) or one after the other like text (horizontal).
Key: The attribute from the datasource defined in Choice Source to be returned. You can select either an attribute or a datastore entity
by selecting the datastore class name from the list. This property only appears if you have a value in Choice Source.
Format: Display format for the data in the Radio Button Group widget.
Note: For more information on display formats, please refer to the “Format Property” paragraph in the “Widget Properties” section.
Label: The title of the Radio Button Group widget.
Auto Dispatch: When checked, Wakanda automatically sends the query to modify the entity collection.
Tabindex: Defines the tab order of the widget on the Page. When tabbing, you begin with the object with the lowest Tabindex and go to
the highest.
Events tab

You can execute code during the following events for the Radio Button Group widget:
On Blur: When the Radio Button Group widget loses focus.
On Change: When the value of the Radio Button Group widget has changed.
On Focus: When the Radio Button Group widget gets the focus.
On Click: Once the Radio Button Group widget has been clicked.
On Mouse Down: If the user holds the mouse down on the Radio Button Group widget.
On Mouse Out: Once the user is no longer hovering over the Radio Button Group widget.
On Mouse Over: If the user places the mouse over the Radio Button Group widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Radio Button Group widget.
For more information about how to add, modify, and delete events, please refer to the “Events” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Radio Button Group widget can be found on the Styles tab:

You can modify the styles for the widget’s following elements: Container, Radio Button Area, Radio Button Area – First, Radio Button Area –
Last, Radio Button, and Label.

Container: Modify the Background, Border, Drop Shadow, Inner Shadow, and Size & Position settings.
Radio Button Area, Button Area – First, and Radio Button Area – Last: Modify the Text, Text Shadow, Background, and Border settings for
the default, hover, active, and selected states for this widget.
Radio Button: Modify the Icon, Background, and Border settings for the default, hover, active, and selected states for this widget.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
The Radio Button Group widget's subelements are shown below:

Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Icon

For more information about the Icon section, please refer to the “Icon” paragraph in the “Widget Properties” section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.

Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.

Section
The Section widget allows you to create an interface for your Mobile applications in which you can create multiple sections containing one or
more widgets:

Adding a Section
You add a Section to your Page by dragging and dropping it in an empty space on the Page, double‐clicking on it in the Widgets area, or drawing
it to the size you want directly on the Page.
The Section widget appears on your Page as shown below:

To add a section to this widget, click the

button.

You define the section type by selecting it from the dropdown menu.

To change the order of the sections, drag the
To delete a section, click on the

icon above or below the other sections listed.

button that appears when you hover over the section.

Properties tab

The properties for a Section widget are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Label: Label for the Section widget.
Sections

The Section widget allows you to create the following types of sections:
Label
Input
Navigation
Switch
Blank
For each type, there are certain restrictions that have been created. For example, the Size & Position section in the Styles tab as well as certain
properties in the Properties tab have been removed.
If you want to have the standard behavior for a widget, you can create a Blank section and add that widget into the section.
Each section has a fixed height of 40 pixels and therefore it cannot grow in length to fit the screen of the mobile device. You can, however,
allow the Section widget to grow in width if you'd like.
Label Section

For this section type, the label is created by using a Text widget. This widget is limited and only has the following properties available:
ID
Hide widget on load
Source
Format
Text
URL
Click on the Side image property to add an image to the Container for this section:

The Image widget created has a limited set of properties:
ID
Hide widget on load
Source
Image URL
URL
Fit

Switch Section

For this section type, the label is a Text widget and the navigation button is a Switch widget. The Switch widget is limited and only has the
following properties available:
ID
Hide widget on load
Source
On by default
Off text
On text
Click on the Side image property to add an image to the Container for this section. Refer to the Label Section for more information about this
property.
Input Section

For this section type, the label is created by using a Text widget and the input portion is a Text Input widget. The Text Input widget is limited
and only has the following properties available:
ID
Hide widget on load
Source
Error ID
Default value
Format
Read only
Password field
Enable datepicker
Input placeholder
Navigation Section

For this section type, the label is a Text widget and the navigation button is a Button widget. The Button widget is limited and only has the
following properties available:
ID
Hide widget on load
URL
Click on the Side image property to add an image to the Container for this section. Refer to the Label Section for more information about this
property.
Blank Section

In this section type, you can place any widget of your choice. There are no limitations to any of the widgets that you place in this section.
Events tab

You can also trap an event for each section regardless of the widgets inside of it, by creating an event for the Container widget that defines the
section.
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Move: When the user's finger moves over the widget.

On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “Events” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Section widget can be found on the Styles tab:

You can modify the styles for the widget’s following elements: Container and Label (if one has been defined for the widget).
Container: You can modify the container’s Background, Border, Drop Shadow, Inner Shadow, and Size & Position.
Label: You can modify the following settings for the widget’s label: Label Text, Label Text Shadow, and Label Size & Position.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Section
This widget appears as you have designed it in the GUI Designer.

Select
The Select widget allows you to display a select list on your Pages for Smartphone and Tablet. The Select widget can contain static values or
dynamic values when it is bound to a datasource. On a smartphone and tablet, the Select widget appears as shown below when the user clicks on
it and the values in the Grid are updated once a value is selected:

Adding a Select Widget
You add a Select widget to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or drawing
it to the size you want directly on the Designer Workspace. This widget can be used in two different ways: bound to a datasource (attribute,
datastore class, or array) or defined by a set of options with fixed values. You can assign a datasource (attribute or datastore class) by dragging
and dropping it on top of the widget. When you do so, the name of the datastore class is inserted automatically in the Choice Source field and
its attributes are added in the Attributes area. If the object you dragged was an attribute, the datastore class that it belongs to is inserted
automatically into the Choice Source field with the attribute selected in the Key field.
Binding a Datasource to the Select

In the Properties tab, you can define how to bind a datasource to the Select widget. In our case, we have a relation attribute “staff” that is the
1‐>N relation attribute in “company” that links it to the “Employee” datastore class. Our Grid uses the datasource “staff,” which displays the
attributes from the “Employee” datastore class. In our Select widget, we use “company” as the Choice Source, the N‐>1 relation attribute in
“employee.employer” as the Value Source, and select “company” as the Key. To automatically update the entity collection of our Grid widget,
we check the Auto Dispatch checkbox. When we select a company, the Grid is updated with the employees who work for that company.

You could also display all the entities from a datastore class in a Select. In our example below, we display the “city” datastore class containing
all the cities in a select list so that when the user selects one it is saved in an attribute. In our example, we are saving the selected value from
the Select widget in the “company.city” attribute.

Defining Options for a Select

To set the values for a Select widget, you enter them in the Options section while leaving the Choice Source field empty:

Properties tab

The Select widget has the following properties:
ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Choice Source: Name of the datasource (datastore class or array) that will supply the values to display. You can either enter the name of
the datasource or assign it automatically by dragging and dropping the datasource onto the widget.
Value Source: Name of the attribute to receive the selected value from the widget. You can either enter the name of the datasource or
assign it automatically by dragging and dropping the datasource onto the widget.
Key: The attribute from the datasource defined in Choice Source to be returned. You can select either an attribute or a datastore entity
by selecting the datastore class name from the list. This property only appears if you have a value in Choice Source.
Format: Display format for the data in the Select widget.
Note: For more information on display formats, please refer to the Format Property paragraph in the Widget Properties section.
Label: The title of the Select widget.
Auto Dispatch: When checked, Wakanda automatically sends the query to modify the entity collection.
Attributes

If you have defined a datasource in the Choice Source property, you can add attributes from the source’s datastore class to your Select widget,
by clicking the
icon and selecting an attribute from the dropdown menu in the Attributes section. If you have defined a datasource (e.g., a
datastore class), the attributes you can display are the attributes of the datastore class.

To change the order of the attributes, drag the
To delete an attribute, click on the

icon above or below the other options listed.

icon that appears when you hover over it.

Options

If you have not defined a datasource in the Choice Source field for the Select widget, you can add options to it in the Options section by

clicking the

icon. You must enter both a value and a label for each option.

You can define which of the options will be displayed by default by selecting the Selected radio button to the right.
To change the order of the options, drag the
To delete an option, click on the

icon above or below the other options listed.

icon that appears when you hover over it.

Events tab

For the Select widget, you can execute code during the following focus and mouse events:
On Blur: When the Select widget loses focus.
On Change: When the value of the Select widget has changed.
On Focus: When the Select widget gets the focus.
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the Events paragraph in the Widget Properties section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Select widget can be found on the Styles tab:

You can modify the styles for the widget’s following elements:
Container: You can modify the styles for its two states (default and active) of the container of the widget. You can modify its Text,
Background, Border, Drop Shadow, and Size & Position.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.

Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Select
When you bind the Select widget with a datasource (and the Auto dispatch property is selected), the entity collection will either change or an
entity collection will be selected based on the value selected from the Select widget.
When “Apple” is selected, the employees for Apple are displayed:

When “4D” is selected, the entity collection is modified:

For a Select widget with a static set of options, it appears as it does on the Designer workspace.

Slider
The Slider widget allows you to graphically represent a numeric datasource, like a Number attribute in a datastore class or a variable of type
Number.

Adding a Slider
You add a Slider to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or drawing it to the
size you want directly on the Designer Workspace. To assign the datasource, drag and drop it on top of the widget. When you do so, the label
for the Slider will be the name of the datasource by default. If you enter a datasource name that doesn’t exist, a Variable datasource will be
created automatically with the same name.
Properties tab

Sliders have the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.

Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the datasource. You can either enter the name of the datasource or assign it automatically by dragging and dropping the
datasource onto the widget.
Error ID: When you include the ID of a Display Error widget, a message for an error that occurred with the Slider widget will be displayed in
that Display Error widget.
Minimum value: The minimum value of the Slider.
Maximum value: The maximum value of the Slider.
Step: The incremental value for the Slider.
Orientation: You can choose to display the Slider horizontally or vertically.
Range: You can choose to either not display the Slider's range (None) or display it from the minimum value side or from the maximum
value side.
Label: The label of the Slider.
Events tab

You can write JavaScript code for any of the following events that occur for a Slider:
On Create: When the Slider is created.
On Start: When the user begins to slide the Slider.
On Slide: This event occurs when the user moves the Slider's handle. The Slider's value is set after the user releases the handle; therefore,
if you want to get its value, you can do so in the On Change event.
On Change: Once the value of the Slider has changed either when the user moves the Slider's handle or when the value for the Slider's
handle is set via the API.
On Stop: If the user stops moving the Slider.
For more information about how to add, modify, and delete events, refer to the “” paragraph in the “Widget Properties” section.
For more information about the event object for each of the above events, refer to "" in the "Widgets v1 Instance API" manual.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

You can customize the appearance of this widget, its range, and its handle by modifying the parameters in the Styles tab:

You can modify the styles for the widget’s following elements: Container, Range, Handle, and Label.

Container: You can modify the Background, Border, Size & Position of the widget’s container for the default and disabled states.
Range: You can modify the Background for the range of the Slider.
Handle: You can modify the Background for the three states (default, hover, and active) of the Slider’s handle.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position for its default and disabled
states.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.

Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Slider
If you select “Min” for the Range property of your Slider, it appears like the first Slider on the left. If you select “Max,” it will appear like the
one on the right:

If you select “None,” the Slider appears as shown below:

You can also bind the same attribute to a Text widget to display the value selected by the Slider widget.

Split View
The Split View widget is available for Pages that you create for the Smartphone and Tablet. It is mostly useful for Pages for the Tablet. This
widget creates two separate Navigation View widgets as shown below:

When the space is decreased (for example, if you turn the tablet), the Navigation View on the left collapses.

To see the left Navigation View again, you can click the Menu button.

Adding a Split View
To add a Split View to your Page, select the widget from the Widgets area and either drag and drop it onto the Designer Workspace, double‐click
on it in the Widgets area, or draw it to the size you want directly on the Designer Workspace. If you have selected an Page for Tablet, the Split
View widget appears as shown below:

The Split View widget becomes set in the background so that you can select widgets that you place on top of it without ever selecting the Split
View widget.
For more information about how to customize the two Navigation View widgets, refer to the Navigation View chapter in this manual.
Properties tab

The properties for a Navigation View are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be passed to JavaScript routines, such as
getElementById. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions
section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Events tab

This widget doesn’t have any events. For any events that you'd like to add to a widget that you are unable to add through the GUI Designer, you
can use the [#cmd id="700010"/] function.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you

just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Split View widget can be found on the Styles tab:

Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Publishing a Split View
As shown at the beginning, the Split View is made up of two Navigation View widgets and a “Menu” button that will display the left Navigation
View widget in a new window if sufficient room is not available to display it, for example if you change the orientation of the tablet.

Switch
The Switch widget allows you to create a switch on your Page to be used in mobile environments (tablets or smartphones). Below are the two
states of the Switch widget:

Adding a Switch
You add a Switch to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or drawing it to
the size you want directly on the Designer Workspace. You can assign the datasource (for example, an attribute of type Boolean) by dragging and
dropping it on top of the widget. If the datasource is an attribute, the attribute name is automatically inserted into the Label property. If you
enter a datasource name that doesn’t exist, a Variable datasource will be created automatically with the same name.
Properties tab

Switches have the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of a datasource, like a Boolean attribute. You can either enter the name of the datasource or assign it automatically by
dragging and dropping the datasource onto the widget.
Error ID: When you include the ID of a Display Error widget, a message for an error that occurred with the Switch widget will be displayed
in that Display Error widget.
On by default: Defines if the Switch is switched “on” by default.
Label: The Switch label.
Off text: The text inside the Switch for the “off” state.
On text: The text inside the Switch for the “on” state.
Events tab

You can write JavaScript code for any of the following focus and mouse events that occur for a Switch:
On Touch Start: When the user places a finger (touches) the widget.
On Touch Move: When the user's finger moves over the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Switch can be found on the Styles tab:

The Switch widget is made up of the following elements: container, off container, on container, switch, off text, on text, and label (if one was
inserted in the Label property).

Container: The entire Switch widget. You can modify its Background and Size & Position.
Off Container/On Container: The two containers of the Switch. For this element, you can modify the Background and Border.
Switch: For the actual switch in the Switch, you can modify the Background and Border.
Off Text/On Text: For the texts in the Switch, you can modify the Text.
Label: If you have defined a label for the Switch, you can modify the Label Text, Label Text Shadow, and Label Size & Position.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Switch
The Switch widget appears as it does on the Designer Workspace; however, its behavior is dependent on the actions you selected or defined in
the Events and Properties tabs for the Switch.
When a Switch is bound to a Boolean attribute, its value is automatically saved with the current entity.

Tab View
The Tab View widget is a widget with multiple tabs that you can use to include different widgets in each one to better organize data. Here is an
example of a Tab View widget:

Here is the second tab:

Adding a Tab View
To add a Tab View widget to the Page, select the widget from the Widgets area and either drag and drop it onto the Designer Workspace,
double‐clicking on it in the Widgets area, or drawing it to the size you want directly on the Designer Workspace.

Double‐click the text in the tab to modify it or Alt‐click (Windows) or Option‐click (Macintosh) it and modify the text in the Properties tab.

You can include one or more widgets on the tab. Add, remove, or reorder the tabs from the Properties tab.
The Tab View widget is made up of multiple widgets that are linked together: a Menu Bar widget and one Menu Item widget for each tab and a
Container widget for the page. You can switch tabs by Alt‐click (Windows) or Option‐click (Macintosh) the tab at the top. You can also select an
individual widget (like the Container widget) by Alt‐clicking (Windows) or Option‐clicking (Macintosh) it.
Place your widgets inside of the Tab View area:

Properties tab

The properties for the Tab View widget are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be passed to JavaScript routines, such as
getElementById. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions
section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Draggable: Selecting this checkbox allows for your Tab View to be draggable on the page.
Resizable: This option, when checked, allows your users to resize the Tab View.
Padding: Define the padding around the Tab View widget. By default, it is set to 5.
Tab position:Select the position of the tabs: Top Left, Top Right, Bottom Left, Bottom Right, Left Top, Left Bottom, Right Top, and Right
Bottom.
Closable tabs: This option adds a close box on each tab and allows the user to close the tab. Once it is closed, the tab will no longer be
available.

Tabs

By default three tabs are created when you add a Tab View widget to your Page.You can modify the text for the tab directly in this area.
To add another tab, click on the

icon. To delete a tab, click on the

icon that appears when you hover over the tab. You cannot delete

the last tab in a Tab View; there must always be one tab. To reorder the tabs, drag the
tab, click on the

icon above or below another tab. To select the

icon.

Events tab

There are no events for the Tab View widget; however, each tab is a Menu Item whose events you can intercept. Refer to the Menu Bar section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Tab View widget can be found on the Styles tab:

The Tab View widget is made up of one element, container, with the following styles: Background, Border, Drop Shadow, Inner Shadow, and
Size & Position.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.

Publishing a Tab View
When you publish the Tab View widget, it appears as it does in the workspace. When you click on the tab, you activate it.

Text
The Text widget allows you to define a text value (either a static value or a dynamic one based on an attribute, for example) on your Page.
Adding a Text Widget
You add a Text widget to the Page by dragging and dropping it on an empty space in the Designer Workspace, double‐clicking on it, or drawing it
to the size you want directly on the Designer Workspace. You can assign a datasource (an attribute in a datastore class) by dragging and dropping
it on top of the widget. If you enter a datasource name that doesn’t exist, a Variable datasource with the same name will be created
automatically.
Properties tab

Text widgets have the following properties depending on how you use it. The properties displayed in the left screenshot are available when you
use the Text widget to display static text. The properties in the right screenshot are available when you define a source for the Text widget.

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of a datasource. You can either enter the name of the datasource or assign it automatically by dragging and dropping the
datasource onto the widget.
Format: Display format for the text.
Note: For more information on display formats, please refer to the “” paragraph in the “Widget Properties” section.
Auto Resize: Resizes the Text widget automatically based on the text displayed.
Text: The static text to include in the Text widget if Source is not specified. You can also enter a value here by double‐clicking on the
Text widget on the Designer Workspace.
Link: Defines the URL to go to when included. You can include any type of link into the Link property, e.g., a URL
(“http://www.wakanda.org/”), an email address (“mailto:info@wakanda.org”), or a Page (“/employees/” or "/index/").
Target: Select “_blank” to open the URL defined in the Link property in a new page or “_self” to remain on the same Page.
Label: Add a label to the Text widget. This property only appears if you have defined a Source instead of a value in the Text property.
Scrollbar: Define where scrollbars will be displayed when the text overflows the widget's area defined on the Page. The scrollbars will,
when necessary, either be hidden or displayed horizontally, vertically, or both (horizontally and vertically) depending on the option you
choose. For this option to work, the Auto Resize option must be unchecked.
Plain Text: Allows you to display the text as either HTML or plain text. If you have added HTML tags, they will be translated if you have
deselected this checkbox. You cannot directly enter HTML tags in this widget's Text property. You can add HTML tags either manually in a
Text Input widget or by using the WYSIWYG Editor widget for the same String attribute in your datastore class.
Events tab

You can execute code during the following focus and mouse events for a Text widget:
On Click: When the Text widget is clicked.
On Double Click: When the Text widget is double‐clicked.
On Mouse Down: If the user holds the mouse down on the Text widget.
On Mouse Out: Once the user is no longer hovering over the Text widget.
On Mouse Over: If the user places the mouse over the Text widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Text widget.
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Text widget can be found on the Styles tab:

The Text widget is made up of two elements: Container and Label (only if a label has been specified for the widget).

Container: The entire Text widget. You can modify its Text, Text Shadow, Background, Border, Drop Shadow, Inner Shadow, and Size &
Position.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.

Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Text Widget
The Text widget appears as it does on the Designer Workspace unless you assign a datasource (i.e., an attribute) that changes the text displayed
depending on the current datastore entity.
If you uncheck the Plain text property, you can display HTML‐formatted text as shown below:

This text was formatted using the WYSIWYG Editor widget:

Text Input
The Text Input widget is an input field that allows users to enter data into an attribute or variable.

Adding a Text Input
You add a Text Input widget to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it, or
drawing it to the size you want directly on the Designer Workspace. You can assign the datasource by dragging and dropping it on top of the
widget. If you enter a datasource name that doesn’t exist, a Variable datasource will be created automatically with the same name.
Properties tab

The Text Input widget has the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the datasource. You can either enter the name of the datasource or assign it automatically by dragging and dropping the
datasource onto the widget.
Error ID: The ID of the Display Error widget to display any eventual errors.
Default value: The default value for the Text Input widget.
Format: In this field, you can define a display format for the data in the Text Input widget for datasources of type Date, String, and
Number.
Note: For more information on display formats, please refer to the “Format Property” paragraph in the “Widget Properties” section.
Label: The label for the Text Input widget.
Autocomplete: To benefit from an autocomplete feature based on the attribute’s values while entering data in the widget, you must first
select the Autocomplete option in the attribute’s properties in the datastore class (see the “Properties for String Attributes” paragraph
in the “Attributes” chapter). Once you do so, a search will be performed on the server to propose options based on the characters
entered into the field. For example, if you enter “San” for a first name field, all first names beginning with “San” will be displayed.

Multiline: The widget is displayed with scrollbars for better visibility of longer texts.
Read only: If you check this option, the Text Input widget is in read‐only mode. The text can be selected, but it cannot be modified.
Password field: This option changes the type of the Text Input widget to a Password field. When checked, each letter typed into the
widget is displayed as a bullet "•".
Enable datapicker: Automatically display the datepicker when a user tabs into this Text Input widget for an attribute of type Date.
Show datepicker button: If this option is checked, the datepicker appears only if the user clicks on the icon displayed next to the Text
Input widget. The Enable datepicker property must also be checked for this option to work.
Tabindex: Defines the tab order of the widget on the Page. When tabbing, you begin with the object with the lowest Tabindex and go to
the highest.
Input placeholder: Text by default in the Text Input widget that disappears when the user enters a character.

Events tab

You can execute code during the following focus and mouse events for a Text Input widget:
On Blur: When the Text Input widget loses focus.
On Change: When the value of the Text Input widget is changed.
On Focus: When the Text Input widget gets the focus.
On Click: When the Text Input widget is clicked.
On Double Click: When the Text Input widget is double‐clicked.
On Mouse Down: If the user holds the mouse down on the Text Input widget.
On Mouse Out: Once the user is no longer hovering over the Text Input widget.
On Mouse Over: If the user places the mouse over the Text Input widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the Text Input widget.
On Key Down: When the user presses a key down in the Text Input widget.
On Key Up: When the keyboard key is released in the Text Input widget.
On Select: When text is selected in the Text Input widget.
On Touch Start: When the user places a finger (touches) the widget.
On Touch End: When the user has removed a finger from the widget.
On Touch Cancel: A touch on the widget has been interrupted.
For more information about how to add, modify, and delete events, please refer to the “Events” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the Design paragraph in the Widget Properties section.
Styles tab

You can customize the Text Input widget by using the Styles tab:

You can apply styles for the widget’s following elements: Container and Label (if one has been specified for the widget).

Container: You can modify its Text, Text Shadow, Background, Border, Drop Shadow, Inner Shadow, and Size & Position settings for the
following three states: Default, Hover, and Focus.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Text

For more information about the Text section, please refer to the Text paragraph in the Widget Properties section.
Text Shadow

For more information about the Text Shadow section, please refer to the Text Shadow paragraph in the Widget Properties section.
Inner Shadow

For more information about the Inner Shadow section, please refer to the Inner Shadow paragraph in the Widget Properties section.
Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.

Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Text Input
For a datasource of type Date, a datepicker appears when you enter the Text Input widget and have the Enable datepicker property selected:

Once you select a date, the datepicker closes.
If you have selected the Show datepicker button, the same Text Input widget appears as shown below:

If you have selected the Multiline property, the Text Input widget appears as follows:

All other Text Input widgets appear as shown below:

Video
The Video widget allows you to include any video via a URL from YouTube, DailyMotion, Vimeo, or HTML5 videos (mp4, webm, or ogg) as either a
URL or a local file.

Adding a Video Widget
You add a Video widget to the Page by first selecting the widget from the Widgets area and then by dragging and dropping it in an empty space
on the Designer Workspace, double‐clicking on it in the Widgets area, or drawing it to the size you want directly on the Designer Workspace.

Properties tab

The Video widget's properties are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Enter the datasource containing the relative path to a video file or a URL to a video. You can either enter the name of the
datasource or assign it automatically by dragging and dropping it onto the widget. Valid video file types are ogg, mp4, and webm. If you
don't assign a datasource to this widget, you can declare a video (in its different formats) in the Video sources section.
Label: The label for the Frame widget.
Start at: The number of seconds to skip at the beginning of the video.
Autoplay: Automatically begin to play the video after it is loaded on the page.
Loop video: Loop the video instead of just stopping at the end.
Display controls: Display the controls for the video.
Autohide controls: Automatically hide the display controls for the video when it begins to play.
Video sources

In this section, you add a specific source for a video of type YouTube, Daily Motion, Vimeo, or HTML5.

To add a video source, click on the
icon. Its type is entered automatically into the Video‐type property To delete a video, click on the
icon that appears when you hover over the entry.

If you try to include another video type that is not yet supported, the following error appears:

Once you either drag or drop a local video file or enter a URL to a video in the Video‐url property, its type is entered automatically into the
Video‐type property.
Events tab

You can write JavaScript code for any of the following events that occur for the Video widget:
On Player Ready: When the Video widget is ready, this event occurs.
On Load Progress: This event occurs while the loading of the video is in progress.
On Start Playing: While the video starts playing.
On End Playing: When the video ends playing. Even if the video loops, this event will be triggered at the end of the video.
On Pause: When the video is paused.
On Duration Change: When a new duration has been set for a video, e.g., if another video has been loaded.
On Time Update: This event occurs while the video is playing, i.e., the video time is updated.
On Error: When an occur has been generated by the player. An error could occur if the video type is not supported by the user's browser.
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Video widget can be found on the Styles tab.

You can modify the styles for the widget’s following elements: Container and Label.
Container: You can modify the container’s Background, Border, Drop Shadow, and Size & Position.
Label: You can modify the following settings for the widget’s label: Label Text, Label Text Shadow, and Label Size & Position.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.

Drop Shadow

For more information about the Drop Shadow section, please refer to the Drop Shadow paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.

WYSIWYG Editor
The WYSIWYG Editor widget allows you to include an HTML editor on your Page, thus allowing users to enter formatted text.

To view the text formatted by the WYSIWYG Editor widget, you can bind the same datasource (attribute or variable of type String) to a Text
widget with the Plain text property unchecked.

Adding a WYSIWYG Editor
You add a WYSIWYG Editor to the Page by dragging and dropping it in an empty space on the Designer Workspace, double‐clicking on it in the
Widgets area, or drawing it to the size you want directly on the Designer Workspace.

By default, there are already a few elements selected by default in the WYSIWYG Editor as shown above.
Properties tab

The properties for a WYSIWYG Editor are the following:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the datasource of type Text. You can either enter the name of an existing datasource or assign it automatically by
dragging and dropping the datasource onto the widget. If the datasource whose name you entered doesn’t exist, a variable datasource will
be created automatically.
Label: Label of the WYSIWYG Editor.
Toolbar location: The location of the toolbar inside the WYSIWYG Editor: either top or bottom.
Align toolbar: Align the elements in the toolbar to the left or right.
Save automatically: This option is selected by default and saves the contents of the WYSIWYG Editor to the datasource bound to it once
the focus is no longer on the widget.
Draggable: Selecting this checkbox allows for your WYSIWYG Editor to be draggable on the page. By default, this option is selected.
Resizable: Allow users to resize the WYSIWYG Editor when it is published on the Page.
Elements

In this area you can add, delete, and organize the elements for the WYSIWYG Editor’s toolbar.
To change the order of the elements, drag the
To delete an element, click on the
If you click on the

icon above or below the other elements listed.

icon that appears when you hover over the element.

icon, the following dialog appears allowing you to select which elements to add to the toolbar:

Once an icon is selected, you can reorder it to be in the position you'd like in the toolbar.
Events tab

You can execute code during the following mouse events for a WYSIWYG Editor widget:
On Click: When the WYSIWYG Editor widget is clicked.
On Double Click: When this widget is double‐clicked.
On Mouse Down: If the user holds the mouse down on this widget.
On Mouse Out: Once the user is no longer hovering over this widget.
On Key Down: When the user pushes a key down in this widget.
On Key Press: When the user presses a key in this widget.
On Key Up: When the pushed key goes up in this widget.
On Init: When the widget is initialized.
On Activate: When the widget is activated.
On Contextual Menu: When the user uses the widget’s contextual menu.
On Submit: When the user saves the text in this widget.
On Paste: When the user pastes in this widget.
On Before Get Content: Before returning the result from the editor’s .getContent() function.
On Set Content: After calling the editor’s .setContent() function.
Below is an example of how the last two events occur:

var wysiwygEditor = $$('wysiwyg1');
var instWysiwyg = wysiwygEditor.getWysiwygInstance(); // getWysiwygInstance() is in the WYSIWYG Editor API
var content = instWysiwyg.getContent(); // fires the On Before Get Content event
instWysiwyg.setContent('some content'); // fires the On Set Content event
For more information about how to add, modify, and delete events, please refer to the “” paragraph in the “Widget Properties” section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you

just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a WYSIWYG Editor widget can be found on the Styles tab:

You can modify the styles for the widget’s following elements: Container and Label (if one has been specified for the widget).
Container: You can modify its Border and Size & Position settings.
Label: If a label has been specified, you can modify: Label Text, Label Text Shadow, and Label Size & Position.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a WYSIWYG Editor
When you publish this widget, the text appears as it was formatted either in this widget or with HTML tags. The menu bar above the text area
allows you to format the text:

Yahoo! Weather
The Yahoo! Weather widget, which is an experimental widget, allows you to retrieve the current weather conditions along with the forecast for
the current day and next day for a specific U.S. zip code. The image is published to your Page as shown below:

Adding a Yahoo! Weather Widget
You add a Yahoo! Weather widget to the Page by dragging and dropping the widget in an empty space on the Designer Workspace, double‐
clicking on it, or drawing it to the size you want directly on the Designer Workspace.
The Yahoo! Weather widget appears as shown below on your Page’s Designer Workspace:

Properties tab

The Yahoo! Weather widget has the following properties:

ID: Wakanda automatically generates this unique ID; however, you can modify it. It must begin with a letter and can contain letters,
digits, hyphens, and underscores. This ID is equivalent to the ID in HTML and can be used in JavaScript routines, such as getElementById.
You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions section.
Hide widget on load: This option allows you to hide the widget when your page is loaded for the first time. To make the widget visible on
the Page, use the show( ) function in the Widgets v1 Instance API manual.
Source: Name of the datasource. You can either enter the name of an existing datasource or assign it automatically by dragging and
dropping the datasource onto the widget. If the datasource whose name you entered doesn’t exist, a variable datasource will be created
automatically. The datasource should contain a U.S. zip code.
Label: Label of the Yahoo! Weather widget.
Events tab

You can execute code during the following mouse events for a Yahoo! Weather widget:
On Click: When the widget is clicked.
On Double Click: When the widget is double‐clicked.
On Mouse Down: If the user holds the mouse down on the widget.
On Mouse Out: Once the user is no longer hovering over the widget.
On Mouse Over: If the user places the mouse over the widget.
On Mouse Up: Once the user lets go of the mouse after clicking on the widget.
For more information about how to add, modify, and delete events, please refer to the Events paragraph in the Widget Properties section.
Design tab

In the Design tab, you can define one or more CSS classes to the widget in the CSS Classes property. You can also create and update a role in
this tab for the specific widget type based on the Page's theme. To assign it to a widget of the same type on a Page using the same theme, you
just select it from the Role dropdown. For more information, refer to the paragraph in the Widget Properties section.
Styles tab

The styles proposed for a Yahoo! Weather widget can be found on the Styles tab.

The Yahoo! Weather widget has two elements: Container and Label (if you have defined a label for the widget).
Container: You can modify the following styles: Background, Border, and Size & Position.
Label: You can modify the following styles: Label Text, Label Text Shadow, and Label Size & Position.
Background

For more information about the Background section, please refer to the Background paragraph in the Widget Properties section.
Border

For more information about the Border section, please refer to the Border paragraph in the Widget Properties section.
Size & Position

For more information about the Size & Position section, please refer to the Size & Position paragraph in the Widget Properties section.
Label Text

For more information about the Label Text section, please refer to the Label Text paragraph in the Widget Properties section.
Label Text Shadow

For more information about the Label Text Shadow section, please refer to the Label Text Shadow paragraph in the Widget Properties section.
Label Size & Position

For more information about the Label Size & Position section, please refer to the Label Size & Position paragraph in the Widget Properties
section.
Publishing a Yahoo! Weather Widget
Once you have published the Yahoo! Weather widget, the weather for the location specified will be displayed in the temperature scale you
chose in the Properties tab.

GUI Designer ‐ Datasources
A datasource is a Wakanda object that manages data and acts as a dispatcher for events. Its main purpose is to provide data to widgets and to
inform widgets when values are changed. Datasources can also be used apart from widgets when you want to interact with data directly. There
are five types of datasources:
datastore class,
relation attribute,
array,
variable, or
object.
A datasource does not contain data, but is a reference to the data. A datasource references:
A collection of entities, based on a datastore class or relation attribute defined in the model of your project, or
A JavaScript variable, array, or object that you can manipulate programmatically.
In both cases, you can bind a datasource to a widget to manipulate the data (i.e., adding and modify entities). When a widget is bound to a
datasource, information from the datasource is updated automatically in all the widgets having the same datasource. If you modify an attribute
in an Auto Form, it will be automatically updated in the Grid on the same Page if both are bound to the same datasource.
In the case of a Button widget, the datasource you define for it will be the one that automatic actions (create, save, next, remove, previous,
first, and last) are applied to.
Datasources are listed in the Datasources area to the left of the Designer Workspace:

Creating a Datasource

You can create datasources of type datastore class, relation attribute, variable, array, and object by selecting its type either from the
button in the toolbar. You can also create the specific type of datasource by clicking on the

icon next to the title in the

Datasources section. For datasources of type datastore class and relation attribute, you will be prompted to select the datastore class or
relation attribute. For datasources of type variable, array, and object, it will be created automatically.
For a datastore class, a datastore class datasource is automatically created when you drag the datastore class (from the model) either on top of a
widget or into the Designer Workspace to display the Auto Generated Widgets dialog to create a Form, Grid, or Auto Form.
A relation attribute datasource is automatically created for a relation attribute when it is selected to be a part of a Form, Grid, or Auto Form
either by selecting it in the Auto Generated Widgets dialog or by adding it in the Properties tab of the Grid or Auto Form.
Variables are created automatically when you type in a source name in the Properties tab for a widget (i.e., a Button, Checkbox, Text, Text
Input, Slider, or Image) that is not a datastore class, relation attribute, or existing datasource.
To subsequently change the datasource’s name (and reference) displayed in the list, you can do so in the Properties tab by changing its ID.
When a datasource is created, its name is in lower camelCase (e.g., "lineItem").
Duplicating a Datasource

You can duplicate an existing datasource by right‐clicking on it and selecting Duplicate datasource from the contextual menu. A new datasource
with the same name plus a number is added to the list. If, for example, your datasource is named “employee,” the duplicate copy will be named
“employee1.”
Deleting a Datasource

To delete a datasource, click on the datasource and select Delete datasource from the contextual menu. If the datasource is referenced in a
widget, you will get the following warning:

Deleting the datasource will eliminate it from the list of available datasources and remove it from the widget(s) that are using it.

Datastore Class Datasources
Datastore class datasources allow you to automatically bind the contents in a widget to the data in the datastore classes. You can bind the
whole datastore class to a widget or just one or more attributes of the datastore class.
Datastore class datasources are created automatically when you define a datastore class as the source of a widget. You can either use the same
datasource in multiple widgets to ensure that the data for each one is identical or you can duplicate a datasource (of the same datastore class)
to use in another widget with a different view of data from the same source on the same Page.
Creating a Datastore Class Datasource

A datastore class datasource is automatically created when you drag a datastore class from the Model on top of a widget to bind it to it. If a
datastore class datasource, whose name is the same as the datastore class already exists, it will be reused. Otherwise, a new one will be
created.
You can also create a datastore class by selecting Datastore Class either from the

button in the toolbar or by clicking on the

icon next to the datasource type title. When you do so, the following dialog appears allowing you to select an existing datastore class in your
model:

Duplicating a Datastore Class Datasource

You can duplicate an existing datastore class datasource in the list by selecting Duplicate datasource from its contextual menu. A new
datasource with the same name plus a number is added to the list. If your datasource is named “employee,” the duplicate copy will be named
“employee1.” The ID will have this new name, but the source will be the same as the duplicated datasource.
Deleting a Datastore Class Datasource

To delete a datastore class datasource, right‐click on the datasource and select Delete datasource. If the datasource is referenced in a widget,
you will get the following warning:

Deleting the datasource will eliminate it from the list of available datasources and remove it from the widget(s) that are using it.
Datastore Class Datasource Properties
To access the datastore class datasource’s properties, select the datasource in the Datasources tab. The datasource’s properties appear in the
Properties tab:

Properties for datastore class datasources are the following:
ID: Name of the datastore class datasource. Wakanda generates a unique ID for datasources created through the New Datasource menu
item or those that are duplicated; however, you can modify it. The ID must begin with a letter and can contain letters, digits, hyphens,
and underscores. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions
section.
Datastore Class: The name of the datastore class. When typing into this area, dropdown menus appear to assist you in entering the
correct information.
Initial Query: When checked, Wakanda queries the data from the datasource for a widget when it is displayed on a Page. By default, this
checkbox is selected thus returning all the entities in the datastore class.
Initial Query String: The initial query executed for this datasource with the following syntax: {Attribute Name} {Comparator} {Value}, such
as firstName = 'a*' to find all the entities whose attribute firstName starts with “a”. For more information regarding the query syntax,
please refer to “Defining Queries (Client‐side)” in the Dataprovider API.
Initial Order By: Include an Order By statement for your datasource so that the first time the datasource is displayed, the data will be
sorted according to the attribute and order defined in this field. The syntax is {Attribute Name} Sort Order, which can be blank, ASC, or
DESC. You can include more than one attribute, such as “lastName ASC, firstName DESC”. For more information regarding the order by
syntax, please refer to “Defining Queries (Client‐side)” in the Dataprovider API.
Scope: This property only appears for datasources used in a Web Component. If the scope is "local", the datasource will be local to the
Web Component; otherwise, the datasource will be "global" meaning shared between the Web Component and the Page. Refer to the
Component widget for more information.
Datastore Class Datasource Events
You can add code to the following events for your datastore class datasource:
On Before Current Element Change: Before the current element (in this case a datastore entity) changes. You can use this event to get
the current value of an attribute just before it changes.
On Current Element Change: When the current element (in this case a datastore entity) changes.
On Element Saved: When an element (in this case a datastore entity) has been saved on the server.
On Collection Change: When the collection changes.
Note: For more information on datasource events, please refer to the addListener method description in the Datasource doc.
You can also create events on all the attributes, by selecting the attribute from the pop‐up menu and clicking on the

The event added for the attribute is displayed in the Attribute Events section:

icon:

When you click the
icon, the JavaScript file associated to your Page opens up in a new tab above the toolbar, indicating where to add your
code for the specific event in the Code Editor. To delete the code for the specific event in the JavaScript file, click on the
icon next to the
event.

Relation Attribute Datasources
A relation attribute datasource is a datasource based upon a relation attribute in another datasource. It can be created automatically by
dragging a relation attribute in an existing datasource onto a widget.
Relation attribute datasources allow you to create entities that are automatically related to an entity in the parent datastore class. In our
example of companies and employees, we have the relation attribute “staff.” If we have two Grid widgets, one with the “company” datastore
class datasource and another with the “company.staff” relation attribute datasource, on a Page, you can assign employees to a company by
selecting a company in the first Grid and adding new entities to the “company.staff” Grid.
Creating a Relation Attribute Datasource

A relation attribute datasource is automatically created when you drag the relation attribute from the Model on top of a widget (e.g., a Grid,
Auto Form, or Form) to bind it to it. If a relation attribute datasource already exists, it will be reused.
You can also create a relation attribute by selecting Relation Attribute either from the

button in the toolbar or by clicking on

the
icon next to the datasource type title. When you do so, the following dialog appears, containing all the datastore classes and
datasources defined on your Page. You can click on the datastore class or datasource to view its relation attributes and select one to create a
new relation attribute datasource:

Duplicating a Relation Attribute Datasource

You can duplicate an existing relation attribute datasource in the list by selecting Duplicate datasource from its contextual menu. A new
datasource with the same name plus a number is added to the list. If your datasource is named “staff,” the duplicate copy will be named
“staff1.” The ID will have this new name, but the source will be the same as the duplicated datasource.
Deleting a Relation Attribute Datasource

To delete a relation attribute datasource, right‐click on the datasource and select Delete datasource from the contextual menu. If the
datasource is referenced in a widget, you will get the following warning:

Deleting the datasource will eliminate it from the list of available datasources and remove it from the widget(s) that are using it.
Using a Relation Attribute Datasource

Using our structure with two datastore classes, company and employee, you can automatically relate employees to a current company entity. To
do so, you just need one widget whose datasource is the parent datastore class, “company,” and another widget whose datasource is a relation
attribute in the parent datastore class, “company.staff”.

For example, we have two Text widgets on our Page with the same datastore class datasource “company” whose datasources are company.name
and company.url. For each current entity in the “company” datasource, we can add, modify, delete, and display entities in the Grid widget
whose relation attribute datasource is “company.staff”.
When we display our Page, the first entity is displayed and with it the related entities in the “Staff” Grid whose relation attribute datasource is
“company.staff”.

By navigating to the next entity in the “company” datasource, the Grid widget is also updated:

Relation Attribute Datasource Properties
To access the relation attribute datasource’s properties, select the datasource in the Datasources tab. The datasource’s properties appear in
the Properties tab:
Properties for relation attribute datasources are the following depending on the context:

ID: Name of the relation attribute datasource. Wakanda generates a unique ID for datasources created through the New Datasource menu
item or those that are duplicated; however, you can modify it. The ID must begin with a letter and can contain letters, digits, hyphens,
and underscores. You can also include accented and non‐Roman letters. For more information, please refer to the Naming Conventions
section.
Relation Attribute: Name of the relation attribute written as “{Datastore Class Datasource Name}.{Relation Attribute Name}”.
Order By: Include an Order By statement for your datasource so that when the datasource is displayed, the data will be sorted according
to the attribute and order defined in this field. The syntax is {Attribute Name} Sort Order, which can be blank, ASC, or DESC. You can
include more than one attribute, such as “lastName ASC, firstName DESC”.
Scope: This property only appears for datasources used in a Web Component. If the scope is "local", the datasource will be local to the
Web Component; otherwise, the datasource will be "global" meaning shared between the Web Component and the Page. Refer to the
Component widget for more information.
Relation Attribute Datasource Events
You can add code to the following events for your relation attribute datasource:

On Before Current Element Change: Before the current element (in this case a datastore entity) changes. You can use this event to get
the current value of an attribute just before it changes.
On Current Element Change: When the current element (in this case a datastore entity) changes.
On Element Saved: When an element (in this case a datastore entity) has been saved on the server.
On Collection Change: When the collection changes.
You can also create events on all the attributes of the relation attribute, by selecting the attribute from the pop‐up menu in the Attributes area
and clicking on the
icon:

The event added for the attribute is displayed in the Attribute Events section:

When you click the
icon, the JavaScript file associated to your Page opens up in a new tab above the toolbar, indicating where to add your
code for the specific event in the Code Editor. To delete the code for the specific event in the JavaScript file, click on the
icon next to the
event.
Note: For more information on datasource events, please refer to the addListener method description in the Datasource doc.

Variable Datasources
A variable datasource is one that uses as its underlying data a JavaScript variable. Variable datasources are objects whose contents are defined
by a JavaScript variable. Note that when you create and use such a datasource in your interface, you need to manage the synchronization
between the datasource and the JavaScript variable through your code.
Creating a Variable Datasource

Variables are automatically created when you insert a source name that is different from any already existing datasource (of any type) in the
Source field for most widgets: button, checkbox, text, text input, slider, or image. For example, when you insert a name like “myVariable” into
the Source field of a widget, the variable “myVariable” is automatically created.
You can also create a variable by selecting Variable either from the

button in the toolbar or by clicking on the

icon next to

the datasource type title.
When you create a Variable datasource, Wakanda dynamically generates the JavaScript variable for you and initializes it depending on its type:
Variable Type
String
Number
Boolean
Object
Date

Initialized Value
""
0
False
{}
01/01/1900

Duplicating a Variable Datasource

You can duplicate an existing variable datasource in the list by selecting Duplicate datasource from its contextual menu. A new datasource with
the same name plus a number is added to the list. If your datasource is named “myVariable,” the duplicate copy will be named “myVariable1.”
The ID will have this new name, but the source will be the same as the duplicated datasource.
Deleting a Variable Datasource

To remove a variable datasource, right‐click on the datasource and select Delete datasource. If the datasource is referenced in a widget, you
will get the following warning:

Deleting this datasource will eliminate it from the list of available datasources and remove it from the widget(s) that are using it.
Variable Datasource Properties
To access the variable datasource’s properties, select the datasource in the Datasources tab. The datasource’s properties appear in the
Properties tab:

Properties for variable datasources are the following:
ID & Variable Name: Wakanda generates a unique ID and JavaScript variable name for the datasource; however, you can modify it. The ID
must begin with a letter and can contain letters, digits, hyphens, and underscores.You can also include accented and non‐Roman letters.
For more information, please refer to the Naming Conventions section.
Variable Type: The variable type can be String, Number, Boolean, Object, or Date.
Variable Datasource Event
You can add code to the following event for your variable datasource:
On Change: When the value in the variable changes.
When you click the

icon, the JavaScript file associated to your Page opens up in a new tab above the toolbar, indicating where to add your

code for the specific event in the Code Editor. To delete the code for the specific event in the JavaScript file, click on the
event.

icon next to the

Note: For more information on datasource events, please refer to the addListener method description in the Datasource doc.

Array Datasources
Array datasources are objects whose contents are defined by a JavaScript array. Note that when you create and use such a datasource in your
interface, you need to manage the relationship between the datasource and the JavaScript array through your code.
You can define an array datasource to be the source for Grid or Auto Form widgets. An array datasource is automatically created if you enter a
source name for either the Grid or Auto Form that doesn’t already exist.
The attributes of an array datasource can be bound to widgets that are usually bound to an attribute, like an Input Text widget. In this case, the
source would be as follows: {Array Name}.{Attribute Name}.
Note: An array used as a datasource is an array of objects: each element of the array is an object. All the objects in the array have the same
attributes. For example, here, we have an array of objects that have two attributes, name and salary:

[{name: ’John Doe’, salary:12345}, … {name:’Jean Dupont’, salary:34567}]
Creating an Array Datasource

You can create an array by selecting Array either from the

button in the toolbar or by clicking on the

icon next to the

datasource type title.
When you create an Array datasource, Wakanda dynamically generates the JavaScript variable for you and initializes it to [].
Duplicating an Array Datasource

You can duplicate an existing array datasource in the list by selecting Duplicate datasource from its contextual menu. A new datasource with the

same name plus a number is added to the list. If your datasource is named “myArray,” the duplicate copy will be named “myArray1.” The ID will
have this new name, but the source will be the same as the duplicated datasource.
Deleting an Array Datasource

To delete an array datasource, right‐click on the datasource and select Delete datasource. If the datasource is referenced in a widget, you will
get the following warning:

Deleting this datasource will delete it from the list of available datasources and remove it from the widget(s) that are using it.
Array Datasource Properties
To access the array datasource’s properties, select the datasource in the Datasources tab. The datasource’s properties appear in the Properties
tab:

Properties for array datasources are the following:
ID & Variable Name: Wakanda generates a unique ID and JavaScript variable name for the datasource; however, you can modify it. The ID
must begin with a letter and can contain letters, digits, hyphens, and underscores.You can also include accented and non‐Roman letters.
For more information, please refer to the Naming Conventions section.
Attributes

You can add attributes to your array, by clicking Add an Attribute in the Attributes area in the Properties tab. The attributes defined correspond
to the attributes in the array.
Here are the properties that you can define for each attribute:

Name: Insert the name of your attribute.
Property: Select the attribute's property: String, Number, Boolean, Object, or Date.
Primary: Define if the attribute (which can be of either type String or Number) will be used as the Primary Key.
The Primary property is used in conjunction with getKey( ) and selectByKey( ).
To change the order of the attributes, drag the
click on the

icon next to the attribute above or below the other attributes. To delete an attribute,

icon that appears when you hover over the attribute.

Array Datasource Events
You can add code to the following events for your array datasource:
On Before Current Element Change: Before the current element changes. You can use this event to get the current value of an attribute
just before it changes.
On Current Element Change: When the current element changes.
On Collection Change: When the collection changes.
Note: For more information on datasource events, please refer to the addListener method description in the Datasource documentation.

Object Datasources
Object datasources are objects whose contents are defined by a JavaScript object. Note that when you create and use such a datasource in your
interface, you need to manage the relationship between the datasource and the JavaScript object through your code.
Object datasources can be the source for Grid or Auto Form widgets. Its attributes can be bound to widgets that are usually bound to an
attribute, like an Input Text widget. In this case, the source would be as follows: {Object Name}.{Attribute Name}.
Note: An object used as a datasource is similar to an array; however, the object must be defined by curly brackets, “{…}” instead of brackets,
“[…].”
Creating an Object Datasource

You can create an object by selecting Object either from the

button in the toolbar or by clicking on the

icon next to the

datasource type title.
When you create an Object datasource, Wakanda dynamically generates the JavaScript variable for you and initializes it to {}.
Duplicating an Object Datasource

You can duplicate an existing object datasource in the list by selecting Duplicate datasource from its contextual menu. A new datasource with
the same name plus a number is added to the list. If your datasource is named “myObject,” the duplicate copy will be named “myObject1.” The
ID will have this new name, but the source will be the same as the duplicated datasource.
Deleting an Object Datasource

To delete an object datasource, right‐click on the datasource and select Delete datasource. If the datasource is referenced in a widget, you will
get the following warning:

Deleting this datasource will eliminate it from the list of available datasources and remove it from the widget(s) that are using it.
Object Datasource Properties
To access the object datasource’s properties, select the datasource in the Datasources tab. The datasource’s properties appear in the
Properties tab:

Properties for object datasources are the following:
ID & Variable Name: Wakanda generates a unique ID and JavaScript variable name for the datasource; however, you can modify it. The ID
must begin with a letter and can contain letters, digits, hyphens, and underscores.You can also include accented and non‐Roman letters.
For more information, please refer to the Naming Conventions section.
Attributes

You can add attributes to your object, by clicking Add an Attribute in the Attributes area in the Properties tab.
In the Name and Property fields, you insert the name of your attribute and its property (String, Number, Boolean, Object, or Date).

To change the order of the attributes, drag the
click on the

icon next to the attribute above or below the other attributes. To delete an attribute,

icon that appears when you hover over the attribute.

Object Datasource Events
You can add code to the following events for your object datasource:
On Before Current Element Change: Before the current element changes. You can use this event to get the current value of an element
just before it changes.
On Current Element Change: When the current element changes.
On Collection Change: When the collection changes.
Note: For more information on datasource events, please refer to the addListener method description in the Datasource doc.

GUI Designer Preferences
In this manual, we describe the GUI Designer preferences file in which you can define the defaults for the following features:
Grid/Magnetic Grid,
Themes for Pages (different views),
WD2 migration,
the maximum number of columns/attributes to create/display for a Grid and Auto Form, and
the maximum number of attributes to display for the Auto Generated Widgets dialog.
The "preferences.json" file must be placed in your Wakanda Studio's preferences folder:
On Macintosh: Library/Application Support/Wakanda Studio/
On Windows: C:\Users\userName\AppData\Roaming\Wakanda Studio\
Defaults for the grid and magnetic grid
The grid and magnetic grid have internal defaults that you can customize. To do so, create a JSON file, named "preferences.json", in which you
only specify the preferences that you want to set. Do not include the entire JSON object with all its properties in your JSON file.
The JSON object for the grid and magnetic grid is as follows:

{
"gui":{
snapping : {
magneticGrid : {
automaticallyActive : false,
onlySnapToSiblings : true,
color : "red",
margins : {
widget : {
left : 10,
right : 10,
top : 10,
bottom : 10
},
page : {
left : 10,
right : 10,
top : 10,
bottom : 10
}
}
},
grid : {
horizontalStep : 20,
verticalStep : 20,
activeByDefault : false,
showByDefault : false,
color : "black"
}
}
}
}
The snapping object has two main properties: magneticGrid and grid, which are described below.
magneticGrid object

The magneticGrid object has the following properties:
Property
automaticallyActive
onlySnapToSiblings
color
margins

Description
true/false = Define if the magnetic grid is automatically active
true/false = When a widget is in another widget (like a Container), the magnetic grid will appear in relation to the other
widgets inside the same widget.
Define the color as a string, e.g., "red", "#FF0000", or "rgb (255,0,0)"
An object with two properties: widget and page so that you can define the left, right, top, and bottom margins

Note: By default, the color property has an opacity that is applied to it. If the background color of your Page is black and you define the color
property as white, the opacity is removed.
grid object

The grid object has the following properties:
Property

Description

horizontalStep
verticalStep
activeByDefault
showByDefault
color

Define the horizontal step for the grid
Define the vertical step for the grid
true/false = Snap to the grid by default
true/false = Show the grid by default
Define the color as a string, e.g., "red", "#FF0000", or "rgb (255,0,0)"

Default theme for a Page
A default theme is specified for the three types of Page: desktop, smartphone, and tablet. Every new Page (of the same type) you create will
have that theme selected by default. The theme you define for desktop is the same one selected by default for a Web Component.
The JSON object for the grid and magnetic grid is as follows:

{
"gui":{
themes : {
desktop: "default",
smartphone: "cupertino",
tablet: "cupertinoIpad"
}
}
}
In this object, you can define the three properties with the classes shown below:
desktop: default, metal, light, or softGray
smartphone: cupertino or cupertinoIpad
tablet: cupertino or cupertinoIpad
If you create a Page View as defined in Routing Pages, you use the suffix property as the property name in the themes object above.
WD2 Migration
By default, the migration of existing Pages is set to false so that your Pages are left intact. All new pages created in Wakanda 6 will use the WD2
service.
In the "wd2" object, there are two properties:
migrate: Automatic migration of existing Pages (default = false).
create: New Pages use the WD2 service (default = true).
To override these values, you'll need to add the following JSON object:

{
"gui":{
"wd2": {
"migrate": true,
"create": true
}
}
}
Defaults for the Grid, Auto Form, and Auto Generated Widgets
By default, the maximum number of columns created when you bind a datasource to the Grid is 10 and the maximum number of columns you can
display by default for the Grid is also 10. By default, the maximum number of attributes created when you bind a datasource to the Auto Form is
10 and the maximum number of attributes you can display by default for the Auto Form is also 10.
For the Auto Generated Widgets dialog that appears when you drag a datasource to a Page, the maximum number or attributes it'll display is 10.
You can change this default in the preferences.
To override these default values, you'll need to add the following JSON object:

{
"gui":{
"dataGrid": {
"maxColumnDisplay": 10,
"maxColumnCreate": 10
},
"autoForm": {
"maxAttributeDisplay": 10,
"maxAttributeCreate": 10
},
"formGenerator": {
"maxAttribute": 10
}
}
}

Here are the two properties for the dataGrid property:
Property
maxColumnDisplay
maxColumnCreate

Description
Maximum number of columns to display for the Grid (in runtime)
Maximum number of columns to create for the Grid

Here are the two properties for the autoForm property:
Property
maxAttributeDisplay
maxAttributeCreate

Description
Maximum number of attributes to display for the Auto Form (in runtime)
Maximum number of attributes to create for the Auto Form

Here is the property for the formGenerator property:
Property
maxColumn

Description
Maximum number of attributes to display in the Auto Generated Widgets dialog

